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PlantPAx Distributed Control System Configuration and Implementation User Manual

Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this equipment before 
you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation and wiring instructions in addition to 
requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried out by suitably 
trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this 
equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with 
any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

These labels may also be on or inside the equipment to provide specific precautions.

The following icon may appear in the text of this document.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).

Identifies information that is useful and can help to make a process easier to do or easier to understand.
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Preface

About This Publication This manual helps you implement process control where controllers, HMI, and I/O are located 
in different areas of the plant. The PlantPAx® system offers flexibility, using the latest 
technology and scalability to build only what you need to help reduce development time, 
downtime, and operational cost.

Download Firmware, AOP, 
EDS, and Other Files 

Download firmware, associated files (such as AOP, EDS, and DTM), and access product release 
notes from the Product Compatibility and Download Center at rok.auto/pcdc.

Summary of Changes This publication contains the following new or updated information. This list includes 
substantive updates only and is not intended to reflect all changes.

Additional Resources These documents contain additional information concerning related products from Rockwell 
Automation. You can view or download publications at rok.auto/literature.

Topic Page
Removed support for Studio 5000 View Designer Throughout
Updated Antivirus section and changed to Endpoint Protection 21
Changed screen captures and text for FactoryTalk Optix to reflect the new Process Library 
release Appendix E

Resource Description

Selection Guide, publication PROCES-SG001 Helps you understand the elements of the PlantPAx system to make sure that you buy the 
proper components.

Template User Manual, publication 9528-UM001 Provides direction on how to install and deploy PlantPAx virtual templates.

Configuration and Implementation User Manual, publication PROCES-UM100 Provides system guidelines and instructions to assist with the development of your PlantPAx 
system.

PlantPAx Display and Library Guidelines, publication PROCES-RM200 Describes the PlantPAx graphic framework, Add-On Instructions, and associated
faceplates that are available to develop applications.

Rockwell Automation Sequencer Object, Publication PROCES-RM202 Provides an overview of how to use the Rockwell Automation Sequencer Object. The manual 
includes a Sequencer programming demonstration, example, and configuration instructions.

PlantPAx Faceplates for Process Controller Instructions, publication
PROCES-RM203

Describes the PlantPAx Process instructions, and associated faceplates that are available to 
develop applications.

PlantPAx Process Control Instructions, publication PROCES-RM215 This manual provides a programmer with details about the available Process instruction set 
for a Logix-based Process controller. 

Process Object parameters Spreadsheet, publication, PROCES-RD200 Describes the PlantPAx Process object parameters.
PlantPAx Visualization Files, publication, PROCES-RD201 Describes the visualization files that are required for the Library of Process Objects.

FactoryTalk Optix Solutions, publication OPTIX-AT001
Provides an overview of the system, application examples, and ordering guidelines to help 
you choose exactly what you need. It also guides you through the basics of creating and 
deploying your own application.

FactoryTalk Security Application Technique, publication SECURE-AT002 Provides essential concepts and practical steps for safeguarding your FactoryTalk® system.

EtherNet/IP Network Devices User Manual, publication ENET-UM006 Describes how to configure and use EtherNet/IP™ devices to communicate on the EtherNet/
IP network.

Ethernet Reference Manual, publication ENET-RM002 Describes basic Ethernet concepts, infrastructure components, and infrastructure features.

System Security Design Guidelines Reference Manual, publication SECURE-
RM001

Provides guidance on how to conduct security assessments, implement Rockwell 
Automation products in a secure system, harden the control system, manage user access, 
and dispose of equipment. 

UL Standards Listing for Industrial Control Products, 
publication CMPNTS-SR002

Assists original equipment manufacturers (OEMs) with construction of panels, to help ensure 
that they conform to the requirements of Underwriters Laboratories.

American Standards, Configurations, and Ratings: Introduction to
Motor Circuit Design, publication IC-AT001

Provides an overview of American motor circuit design based on methods that are outlined 
in the NEC.

Industrial Components Preventive Maintenance, Enclosures, and Contact 
Ratings Specifications, publication IC-TD002

Provides a quick reference tool for Allen-Bradley® industrial automation controls and 
assemblies.

Safety Guidelines for the Application, Installation, and Maintenance of 
Solid-state Control, publication SGI-1.1

Designed to harmonize with NEMA Standards Publication No. ICS 1.1-1987 and provides 
general guidelines for the application, installation, and maintenance of solid-state control in 
the form of individual devices or packaged assemblies incorporating solid-state 
components.

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1 Provides general guidelines for installing a Rockwell Automation industrial system.

https://rok.auto/pcdc
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at002_-en-p.pdf
https://rok.auto/literature
http://literature.rockwellautomation.com/idc/groups/literature/documents/sg/proces-sg001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/9528-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/proces-um100_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm202_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm203_-en-p.pdf

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm215_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rd/proces-rd200_-en-p.xlsx
https://literature.rockwellautomation.com/idc/groups/literature/documents/rd/proces-rd201_-en-p.xlsx
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/enet-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/enet-rm002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/enet-rm002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/sr/cmpnts-sr002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/ic-at001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/ic-td002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/optix-at001_-en-p.pdf
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Preface          

You can view or download publications at rok.auto/literature.

Software and Firmware 
Updates

When you update software or firmware revisions, we recommend that you verify the impact on 
performance and memory utilization before implementing the upgrade on the production 
system. For FactoryTalk® View or ControlLogix® platforms, we recommend that you review the 
release notes and verify the impact of the upgrade on performance and memory utilization.

You can also verify the compatibility of an upgrade with the other software and operating 
systems in use in your PlantPAx system. See the
Product Compatibility and Download Center.

Rockwell Automation 
Services and Support

System Support offers technical assistance that is tailored for control systems. Some of the 
features include the following:

• Highly experienced team of engineers with training and
systems experience

• Process support at a systems-level that is provided by process engineers
• Use of online remote diagnostic tools

• Access to otherwise restricted TechConnectSM Knowledgebase content
• 24-hour, 7 days per week, 365 days per year of phone-support coverage upgrade option

For more information, contact your local distributor or Rockwell Automation representative or 
see http://www.rockwellautomation.com/support.

ProposalWorks™ configuration software, rok.auto/systemtools Helps configure complete, valid catalog numbers and build complete quotes based on 
detailed product information.

Rockwell Automation Global SCCR tool, rok.auto/sccr Provides coordinated high-fault branch circuit solutions for motor starters, soft starters, 
and component drives.

Product Certifications website, rok.auto/certifications Provides declarations of conformity, certificates, and other certification details.

Resource Description

www.rockwellautomation.com/literature
https://compatibility.rockwellautomation.com/Pages/home.aspx
http://support.rockwellautomation.com
https://rok.auto/systemtools
https://rok.auto/sccr
https://rok.auto/certifications
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Chapter 1

System Workflow
The PlantPAx® distributed control system is an integrated control and information solution 
that helps manufacturers achieve Plant-wide Optimization in a wide range of industries. This 
single platform can run your entire plant and integrates all HMI, controls, optimization, 
engineering, information, and inputs/outputs into one common system architecture.

The following workflow shows the steps for how to size, design, and implement a scalable 
PlantPAx system. Click the links for the information that is related to each step.

1. Use the PlantPAx System Estimator (part of the Integrated 
Architecture® Builder tool) to size your application. Size Your System

Smaller System 
(< 2000 I/O)

Larger System 
(PASS + Application 

Servers)

PASS-C
PASS

3. Configure the Process Automation System Server (PASS).

2. Manage servers and security policies.
• Smaller systems = Work Group
• Larger systems = Domain Controllers
See Process Controller Features on page 101 Chapter for security 
configurations 

Work Group
Domain

(continued)

4. Design the Network Infrastructure
• Select network topologies
• Configure switches

Core, Distribution, and Access Switches
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Example PlantPAx System

Engineering Workstation (EWS)5. Develop the Process Applications. See Chapter 5, Chapter 6, and Chapter 7.
• HMI displays (based on the PlantPAx graphic framework guidelines)
• Controller logic (control strategies using the embedded PlantPAx instructions 

and Add-On Instruction)
• Alarms

7. Deploy your application to clients.

For more information, see Rockwell Automation Library of Process Objects 
Reference Manual, PROCES-RM200

(previous)

Logix 5000 Process Controller

Operator Workstations (OWS)

6. Add additional servers for application-specific needs.
• Smaller systems = application servers co-located on a PASS-C
• Larger systems = each application server is separate

Application Servers
• Asset management
• Historical Data
• Batch management

Application Servers (AppServ)

Operator Workstations (OWS)
Engineering Workstations (EWS)

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
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Size Your System Rockwell Automation includes the PlantPAx System Estimator (PSE) tool as part of the 
Integrated Architecture® Builder software. The PSE Estimator tool helps define your PlantPAx 
system and verifies that your architecture and system elements are sized properly. The PSE 
includes online help that can assist you as you use the tool.

The PSE employs sizing guidelines that are based on the rules and recommendations from 
PlantPAx system characterization to achieve known performance and reliability. The PSE 
focuses on the critical system attributes of a PlantPAx system so you can verify that your 
system does not exceed system recommendations.

Before you run the PSE, you must plan the scope of your project so that you know the I/O 
requirements. This could be an equipment list or project database of devices. For more 
information, see Chapter 5, Process Applications.

Make sure that your PSE project has no errors. As much as possible, the project should 
accurately represent the physical layout of the system, such as the controllers, I/O, HMI, and 
data servers. The I/O locations and control rooms must align with your system architecture 
drawings.

• If you size based on I/O counts, the PSE makes assumptions as to the devices that I/O is 
connected to and assigns the I/O to control strategies. 

• If you know the devices, the PSE results are more accurate if you size based on control 
strategies.

• Make sure that the logic execution rates accurately represent the requirements of the 
process.

• Reserve memory and CPU utilization in the controller for auxiliary logic (such as logic 
for batch applications). 

• Accurately account for the process and device networks that are defined in the PSE. 
Also account for any networks not defined in the PSE.

• Select the execution periods in the PSE appropriate for your control strategies to verify 
the controller sizing meets the needs of the system.

The final PSE project only accounts for devices, not the programming that automates the 
devices. Extra programming can include batch, recipe control, or sequencing of any other 
logic used in the system. Make sure to consider any extra programming so that the system 
does not overload the controller.

Select the Process 
Automation System Server

Use the sizing results from the PSE, the number of I/O points, and the overall size of the 
process to determine the Process Automation System Server (PASS) that best suits your 
PlantPAx system.

The PASS is the main component for PlantPAx computing. A PASS supports an HMI server, 
displays, alarms, and data connections to controllers. A PASS contains the following:

• FactoryTalk® Directory and Activation server
• FactoryTalk® View SE HMI server
• FactoryTalk® Alarms and Events server
• FactoryTalk® Linx Data server
• FactoryTalk® Historian node interface

A PASS is scalable from a single standalone server to multiple distributed servers. You can 
deploy a PASS directly to a host computer or run as a virtual guest on a host server.

The sizing recommendations help determine how to best deploy the software for your 
PlantPAx system:

IMPORTANT The PSE, along with the IAB, gives you a high-level Bill of 
Materials. You must complete a panel design to house, mount, 
and power the equipment for your environmental needs.
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• Smaller systems (typically less that 2000 I/O points) place all system software on a 
consolidated Process Automation System Server (PASS-C) with multiple operator 
workstations 

Examples include skid, station, and distributed architectures where a single PASS-C 
supports the system.

• Larger systems use a Process Automation System Server (PASS), in addition to 
individual application servers (AppServ), engineering workstations (EWS), and operator 
workstations (OWS).

Larger systems are typically distributed architectures with multiple PASS servers.

Consolidated Process Automation System Server (PASS-C)

The consolidated Process Automation System Server (PASS-C) supports smaller systems, such 
as skids or stations, where the system software runs on only a few computers. The PASS-C 
offers reduced complexity and cost.

Figure 1 illustrates a small PlantPAx system with a PASS-C that runs all FactoryTalk software 
and an OWS that provides a client interface.

Figure 1 - Smaller PlantPAx Systems with Single PASS-C Server

Process Automation System Server (PASS)

The Process Automation System Server (PASS) supports larger, distributed systems or 
customer-defined, critical processes. Whenever possible, use virtualization to provide greater 
computing efficiency, enhanced backup and recovery capability, and to offer high availability 
with server redundancy.

Figure 2 illustrates a larger PlantPAx system, with two PASS computers and supporting 
application servers, in a network distributed architecture.

• PASS_01 server contains the FactoryTalk Network Directory, Security configuration and 
often hosts FactoryTalk® Activation licenses.

• PASS_02 server contains FactoryTalk® View SE (HMI server, data server, and alarms 
server).

• An optional PASS_03 server could be a secondary (HMI, data, and alarms server) that 
would switch over if PASS_02 was unreachable. 

• AppServ_Info server contains a Factory Historian SE server and a local Historian 
database.

• An optional AppServ_Info2 server could be a redundant FactoryTalk® Historian SE 
server, as part of a collective. In this configuration, the Historian database would be 
hosted on a separate computer that both could access.

• AppServ_Asset server contains FactoryTalk® AssetCentre for system tracking and 
verification.

PASS-C 
• FactoryTalk Directory
• FactoryTalk Activation server
• FactoryTalk Security
• HMI server
• Data server
• Alarm and Event server
• SQL server
• FactoryTalk Historian server
• FactoryTalk AssetCentre server

OWS (optional)
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• AppServ_Batch server contains FactoryTalk® Batch software to handle large batching 
processes.

Figure 2 - Large PlantPAx Systems with Multiple Servers

Next Steps Once you have sized your system and decided on whether to use a PASS-C or PASS, you are 
now ready to install and configure the system. 

Complete the following:
1. Manage Servers and Security Policies

A Domain Controller is recommended for most PlantPAx systems, however, in smaller 
systems a Workgroup can be sufficient.

For more information, see Chapter 2, Domain or Workgroup
2. Configure the Process Automation System Server 

For more information, Chapter 3, Process Automation System Server
3. Design Network Topologies and Configure Switches

The PlantPAx system supports several network topologies to meet various system 
requirements. Each topology is based on system characterization tests to help deliver 
system performance.

For more information, see Chapter 4, Network Infrastructure
4. Develop Process Applications

Process applications implement control strategies that encompass control logic and 
HMI displays.

Execute control logic on Logix 5000® process controllers. The process controller comes 
with a default task model and embedded PlantPAx instructions that improve design and 
deployment efforts. The process controller is also conformal-coated for protection 

PASS_01:
• FactoryTalk Directory
• FactoryTalk Activation server
• FactoryTalk Security

PASS_02:
• HMI server
• Data server
• Alarms server
• FactoryTalk Live Data server

AppServ_Info:
• SQL server
• FactoryTalk Historian server

AppServ_Asset:
• FactoryTalk AssetCentre server

AppServ_Batch:
• FactoryTalk Batch server

PASS_03
Redundant

IMPORTANT Please see KnowledgeBase article, PlantPAx System v5.40 Installation 
Notes for installation steps that follow PlantPAx System Guidelines.

https://support.rockwellautomation.com/app/answers/answer_view/a_id/1156808
https://support.rockwellautomation.com/app/answers/answer_view/a_id/1156808
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from dust and corrosive pollutants.

Deploy HMI displays for operators and maintenance personnel so they can monitor and 
maintain the system.

For more information, see Chapter 5 - Process Controller Features, Chapter 6 - Use ACM 
to Create an Application, and Chapter 7 - Modifying an Existing PlantPAx System.

5. Add Application Servers

PlantPAx application servers (AppServ) manage system software that is required for 
your application. There can be multiple servers depending on the size and structure of 
your application.

Guidelines for Servers and Workstations

Follow these guidelines to align with PlantPAx configurations.
• Install the latest software patches for all Rockwell Automation software.

The Patch File Validator utility verifies software versions on your system and installs 
a patch roll-up. To download, see the Knowledgebase Technote Patch File Validator 
Utility.

• Disable power-saving for the Network Interface Card (NIC).
The NIC card connects a workstation to other devices on the network. The power-
saving feature turns off the network card when not in use, which can interfere with 
network throughput.

• Disable power-saving for the Windows operating system.
The power-saving feature turns off Windows features when not in use, which can 
interfere with network throughput.

• Enable Remote Desktop Server (RDS) functionality on application servers that need 
remote access, such as the AppServ-EWS or AppServ-OWS.

RDS enables multiple instances of the OWS and EWS as thin clients from one server. 
Thin clients can run applications and process data on a remote computer to 
minimize the amount of information on a network.

Enable Adjust for Best Performance so that Windows features that are not is use are 
turned off, which yields more memory and performance for the system.

• Make sure that the user is never notified by the User Account Control.
• Disable automatic Windows updates. This helps prevent updates that haven’t been 

qualified by Rockwell Automation from being installed on the workstation or server.
The only exception is if your organization has a controlled patching process to verify 
updates on a non-production system, or when a facility is non-active, to reduce the 
chance of any unexpected results or side effects.

Table 1 - System Server Descriptions

AppServ Elements Description

AppServ-Asset

The asset management server acts as a centralized tool for managing 
automation-related asset information (both Rockwell Automation and third-
party assets). The asset management application server includes capabilities 
for source control, audits, change notifications, reporting, security, and 
backup/restore.
For more information, see Chapter 8, Asset Management.

AppServ-Info (Historian, SQL)
Data management storage can include a Historian or SQL server. These two 
servers depend on the function that is being provided: FactoryTalk Historian 
software or a SQL server.
For more information, see Chapter 9, Historical Data.

AppServ-Batch

The batch application server provides comprehensive batch management, 
including unit supervision, recipe management, process management, and 
material management. The batch application server can be linked with 
visualization elements on the OWS and configuration clients on the EWS.
For more information, see Chapter 10, Batch Management.

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/30393/loc/en_US#__highlight
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/30393/loc/en_US#__highlight
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Endpoint Protection

It is recommended to install endpoint protection solutions on servers and workstations 
running industrial automation software. Although FactoryTalk software is expected to be 
compatible with all endpoint protection solutions on the market, PlantPAx has been tested with 
specific configurations of Windows Defender AV and CrowdStrike EDR endpoint solutions. 
Additional recommendations:

• Proper configuration, management, and updating of endpoint protection solutions
• Test/Audit endpoint detection and response in detection mode, while tuning in an 

environment
• Avoid overly restrictive configuration settings in firewalls, network and/or host 

protection tools, and access controls as they can negatively affect system operations
• Monitor endpoints centrally for rapid alert responses 

PlantPAx System ID The PlantPAx system ID is a unique identifier that helps simplify the management of your 
system over its lifecycle. The System ID creates a record of the installed products in your 
system and provides a dashboard that shows the hardware lifecycle status, notifications of 
updates and patches, and compatibility information. Use this information to:

• Plan spare and replacement parts to better size inventory
• Define the boundaries of the system
• Plan when and where to implement system upgrades 

The system ID is only available if you purchase a PlantPAx catalog number for the software for 
the first PASS in your system. The catalog number determines an activation string for the 
software products on the bundle. This activation string (serial number) is the system ID.

The system integrator uses an Asset Inventory Agent in a FactoryTalk AssetCentre project to 
generate an inventory file (.raai file). The System ID is gathered via the license number of 
FactoryTalk AssetCentre via FactoryTalk Activation Manager. The System Integrator registers 
your System ID with Rockwell Automation and provides you directions on how to access your 
MyEquipment portal.
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System Verification A critical system attribute is a visible performance indicator of a system-wide characteristic. 
Critical system attributes do the following:

• Determine system limits
• Establish system rules
• Establish system recommendations
• Measure system element and system infrastructure performance

The following Critical System Attributes (CSA) are used to verify PlantPAx system 
characterization.

Systems deployed according to the Appendix C guidelines and pass the verification tool 
typically achieve performance characteristics matching those demonstrated in the 
Characterization lab.

For a complete system verification, use the guidelines in Appendix C, PlantPAx Deployment 
Recommendations and Verification Tool.

Table 2 - CSA Performance Indicators

Critical System Attribute(1)

(1) CSA performance indicators are a nominal performance number. The actual system performance can intermittently deviate 
from the documented CSA due to system disturbances that can introduce variability in the network or operating system 
performance.

Performance

Display callup (paint time) A noncached operating display(2) is called up by the operator and ready for 
operator use within 2 seconds.

(2) Operating displays are defined as those intended for use by the operator to control the process. Displays intended for use by 
technical staff, such as those used for troubleshooting, configuration, or maintenance, including aspects of the Library of 
Process Objects, are excluded (as they are not required for routine operation, are used less frequently, and often contain a 
high volume of tags or detailed engineering content that is not relevant to day-to-day operator tasks).

Display update The display updates control information within 1 second.

Steady state alarm time Steady state alarms occurring at 20 per second are timestamped within 1 
second.

Alarm burst time All alarms in a burst of 2000 alarms are timestamped within 3 seconds.

Recovery A system element returns to full operation within 5 minutes of the 
restoration after a failure or loss.

Operator-initiated control Operator-initiated actions are loaded into the controller and the feedback 
for the operator action is within 2 seconds.

Batch server: operator action time An operator batch command has been acted on by the controller in 1 second.
Batch server: server action time A server batch command has been acted on by the controller in 1 second.
Batch server: controller action time Batch status events display on the operator workstation within 1 second.
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Domain or Workgroup
PlantPAx® systems require computer management, from either a domain controller or 
workgroup configuration, for secure interaction.

• A Windows® domain is a collection of computers that share rules and procedures. 
These computers comprise a central directory database, which is the Active Directory. 
The sharing of network objects creates a unified base to manage users, groups, and 
security settings

• A Windows workgroup computer is independently configured. Workgroups are only 
suitable in smaller systems with 10 or fewer computers.

Prerequisites Following the System Workflow, configure a domain controller or a workgroup, depending on 
the size of your system.

The PlantPAx architecture assumes that there’s a Microsoft Windows forest in place to host a 
supervisory and/or control domain network.

• You need at least one domain controller per each parent/root/child domain.
• The domain controllers are separate computers.
• You need at least two domain controllers for fault tolerance.
• Do not load any application software on a domain controller.
• The domain controllers must be local (within the firewall) to the PlantPAx system.

We recommend that PlantPAx servers and workstations be members of a Windows domain. 
However, workgroups are supported for systems with 10 or fewer workstations and servers.

Workgroup Domain

Configuration Details

Workgroup - decentralized administration
(allowed if 10 or fewer computers)

Workgroup advantages:
• No domain controller (Windows Server OS) to purchase or maintain.
• Recommended for small PlantPAx applications only where user 

accounts do not change often
Workgroup rules:
• All workstation and server system elements in a single PlantPAx 

system must be members of the same workgroup
• All users participating in the workgroup must be members of the 

Administrators group
• Create the same set of user accounts and passwords on every 

computer in a FactoryTalk® View application

Domain - centralized administration
(recommended)

Domain advantages:
• Centralized administration of users, policies, and security
• High availability, when both primary and secondary domain 

controllers are used.
• Recommended for larger systems to provide the best system 

performance. 
Domain rules:
• All workstation and server system elements in a single PlantPAx 

system must be members of the same domain
• PlantPAx server system elements must not be used as domain 

controllers.
• Required for systems with more than 10 computers
• The domain controller must be its own independent computer with 

no other application software.
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For more information, see this additional resource.

Primary Domain Controller The domain controller manages:
• IP address scheme for the computer network
• DNS and reverse lookup zone
• DHCP server
• Assigned roles, areas, and users
• Group policies

In larger systems, create a dedicated domain controller for the PlantPAx system. If your 
control system contains an existing domain controller, add the configuration that is 
recommended for a PlantPAx system. 

If your company has an existing domain infrastructure, in which the PlantPAx system interacts 
with, please consult with your local IT resources before continuing.

Domain controller components include:
• Microsoft Windows Server operation system
• Active Directory Domain Services, DHCP, and DNS Server Roles
• Parent and child domains
• Reverse DNS Lookup Zone
• Configure DHCP server options and authorize server

Windows Workgroups are available for small systems that do not require complex security 
controls. Considerations when using a workgroup include:

• There are typically no more than 10 computers.
• All computers must be on the same local network or subnet.
• All computers are peers; no computer has control over another computer.
• Each computer has a set of user accounts. To sign in to any computer in the workgroup, 

you must have an account on that computer.
• A workgroup isn’t protected by a centrally managed password.

For more information, see Windows Workgroup.

Create the Primary Domain Controller

Starting with a new installation of Windows Server 2022 operating system, sign in as local 
administrator. The computer is initially assigned a random 15-character computer name, 
which looks something like this: WIN-VPLC4SD9KWG.

1. Change the computer name to comply with your company naming guidelines. Or, in this 
example, to reflect it as being a process automation domain controller (PADCA, PADCB, 
and so forth).

2. Next assign the Windows server a fixed IP address (TCP/IPv4), within the subnet 
designated for the given network architecture. 

For example: 172.18.1.10

Resource Description

 Windows Operating System and 
domain references

Microsoft® online libraries, for example Microsoft Learn, provide detailed 
guidelines for all aspects of the Windows and Windows domains. Examples of 
detailed guidelines are design, deployment, maintenance, security, disaster 
recovery, and so on. PlantPAx documentation provides best practice critique to 
certain Windows roles, features, and such where a typical PlantPAx DCS is 
hosted.
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Install Active Directory Services, DHCP, and DNS Roles

Before a Windows server can function as a domain controller, additional roles and features 
must be installed.

1. Launch the Server Manager.

2. From the Dashboard, click the second option to 'Add roles and features'. Use the 
following table to complete the configuration.

Promote the Primary Domain Controller

On the Server Manager management console, complete these steps for the active domain 
computer.

Table 3 - 

Roles and Features Wizard Configure
Before You Begin Read and click next
Installation Type Check 'Role-based or feature-based installation.'

Server Selection Select a server from the server pool.
Select the local computer PADCA in the Server Pool list 

Server Roles

In the Roles dialog, select the following:
• Active Directory Domain Services 
• DHCP Server
• DNS Server

Pop up dialog. Add features that are required for 
Active Directory Domain Services. 

Check the option to Include management tools (if applicable) 
and then select Add Features.

Features
Select the available .NET Framework features to be installed 
on the domain controller.
Check 'Group Policy Management.'

AD DS Active Directory Domain Services requires a DNS server. If 
selected for the Server Role, click Next.

Confirmation Check 'Restart the destination server automatically if 
necessary', and select Install.

Results Once the installation process completes, close the wizard 
and restart the server if necessary.
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1. Select the Alert flag on the header.

2. Select 'Promote this server to a domain controller'. 
3. Using the Active Directory Domain Services Configuration Wizard, use the following for 

guidance on your deployment.

IMPORTANT Take careful consideration when specifying a new root domain 
name.
• Understand domain naming conventions so they make sense 

given your system, owner, or location.
• Do not use any reserved words or characters, and use caution if 

adding a period, which must not be used in later versions of 
Windows.

• See Microsoft Support for more information on naming 
conventions in Active Directory for computers, domains, sites, 
and organizational units.

Topic Configure

Deployment Configuration

Select to 'Add a new forest'.
Specify the domain information for this operation.
Enter a Root Domain Name.

Examples:
• PlantPAx.Company.Local 
• DCS.PlantPAxMfg.com
• PlantPAx.RockwellAutomation.com

Domain Controller Options

Select Windows Server 2022 as the Forest functional level.
Select Windows Server 2022 as the Domain functional level.
Check 'Domain Name System (DNS).'
Check 'Global Catalog (GC).'
Enter a Directory Services Restore Mode password

IMPORTANT: You use this password when you configure a redundant 
domain controller and for any subsequent DC recovery efforts. Record 
this password in a safe/secure place.

DNS Options Do not specify 'DNS Delegation options.'

Additional Options Make sure that the domain name is used for the NetBIOS Domain Name. 
Accept defaults for the remaining options.

Paths Use the default folder locations.
Review Options Review your selection options.
Prerequisites Check Validate all prerequisites and Install if no errors. The server restarts.
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Additional Domain 
Controller

If needed, create a redundant domain controller for high availability. Considerations for the 
redundant domain controller include:

• The redundant domain controller has a unique name and IPv4 address.
• Install the Active Directory Domain Services role and promote to domain controller.
• Add the Directory Services Restore Mode (DSRM) password.

Create an Additional Domain Controller

To reduce disruptions during unplanned and planned downtime, add another Domain 
controller for backup and scalability later.

1. Change the computer name to comply with your company naming guidelines. Or, in this 
example, to reflect it as being a process automation domain controller (PADCB, and so 
forth).

2. Next assign the Windows Server a fixed IP address (TCP/IPv4), within the subnet 
designated for the given network architecture. For example, 172.20.1.11, and supply the 
DNS address from the initial domain controller: 172.20.1.10

3. Repeat Create the Primary Domain Controller steps. Name, address, and install Active 
Directory roles for the additional domain controller.

4. Install the ‘Active Directory Domain Services’ role.

Install Active Directory Services, DHCP, and DNS Roles

Just like creating the primary domain controller, repeat these steps.
1. Install Active Directory, DHCP, and DNS roles used on creating the primary domain 

controller. 
2. Install the 'Active Directory Domain Services' role.

See the primary domain controller instructions if you need help with using the roles wizard.

Promote the Additional Domain Controller

On the Server Manager management console, complete these steps for the standby domain 
computer.

1. Select the Alert flag on the header.

2. Select 'Promote this server to a domain controller'.

IMPORTANT For each additional domain controller, you must have a fresh 
installation of Windows Server 2022 operating system before 
repeating the ‘Create the Primary Domain Controller’ procedure.
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3. Using the Active Directory Domain Services Configuration Wizard, use the following for 
guidance on your deployment.

Configure Domain 
Controllers

On the primary and additional domain controller, now you can implement and configure the 
new features and roles that were added, such as: Active Directory, DHCP, and DNS.

Server Manager Tools Menu

The Windows ‘Server Manager’ contains a Tools menu that provides quick access to many of 
the management consoles required for the following configurations.

Create a Reverse DNS Lookup Zone

Reverse lookup zones are used to resolve IP addresses to host names, rather than host names 
to IP addresses, as is the case with forward lookup zones. You must program a special domain 
namespace (in-addr.arpa) as a reverse lookup zone.

On your initial domain controller, use the Server Manager to access the DNS Manager console 
window.

AD DS Configuration Wizard Configure

Deployment Configuration
Select to 'Add a domain controller to an existing domain.'
Select the Domain:
Select the forest:

Domain Controller Options

Select Windows Server 2022 as the Forest functional level. Select 
Windows Server 2022 as the Domain functional level. Check 'Domain 
Name System (DNS).'
Check 'Global Catalog (GC).'
Enter a Directory Services Restore Mode password.

IMPORTANT: You use this password when you configure a redundant 
domain controller and for any subsequent DC recovery efforts. Record 
this password in a safe/secure place.

DNS Options Do not specify 'DNS Delegation options.'
Additional Options Replicate from: ‘your domain name’
Paths Use the default folder locations.
Review Options Review your selection options.
Prerequisites Check Validate all prerequisites and Install if no errors. The server restarts.
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1. To access the DNS Manager, right-click Reverse Lookup Zone 
New Zone.

2. Configure the New Zone wizard as shown in the following table.

A successful configuration displays details of the lookup zone.

Map the Host Name to the IP Address

Create a pointer (PTR) record that associates the DNS name to the IP address. During a search, 
the IP address is reversed to find the associated DNS name.

From the Server Manager, use the DNS Manager to create the New
Pointer (PTR).

1. Go to Tools > DNS > Reverse Lookup Zone > Zone > New Pointer

Basic Step Configure
Zone Type Select ‘Primary zone.’

Active Directory Zone 
Replication Scope

Check ‘To all DNS servers running on domain controllers in this domain <your 
target domain>'.
For example: PlantPAx.MyCompany.Local.

Reverse Lookup Zone Name Check ‘IPv4 Reverse Lookup Zone.’

Network ID Enter the network ID portion of the IP address of the domain controller (omit the 
last number). For example, enter 172.20.1.

Dynamic Update Check ‘Allow only secure dynamic updates (recommended for
Active Directory).’
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2. Enter the IP address of the domain controller and browse for the
host name.

Successful configuration shows pointers for both a primary and
secondary domain controller.

Add DHCP Features

A DHCP server is a network server that automatically provides and assigns IP addresses, 
default gateways, and other network parameters to client devices that request the 
information.

On the Server Manager management console, complete these steps to add a DHCP server.
1. Select the Alert flag on the header.

2. Click to ‘Complete DHCP configuration’
3. Open the DHCP management console and right click IPv4 > New Scope and configure 

the following for the control network.

Basic Step Configure

Scope Name Enter a name (such as Control Network) and a description (such as PlantPAx 
Control Network).

IP Address Range

Enter the start and end of the IP address range.
Example: 
Start IP Address: 172.20.1.128
End IP Address: 172.20.1.254
Length: 24
Subnet Mask: 255.255.255.0

Add Exclusions and Delay
Optional: Exclusions are addresses or a range of addresses that aren’t distributed 
by the server. A delay is the time duration by which the server delays the 
transmission of a DHCPOFFER message.

Lease Duration The lease specifies how long a client can use and IP address from this scope.
Default values: Days: 8 Hours: 0 Minutes: 0 

Configure DHCP Options
You have to configure the most common DHCP options before clients can use the 
scope.
Select: 'Yes, I want to configure these options now'.

Router (Default Gateway) Enter the gateway IP address. Example: 172.20.1.1

Domain name and DNS servers Parent Domain: 'your domain name'
Server IP addresses. Example: 172.20.1.10 and 172.20.1.11

WINS Optional: Computers running Windows can use WINS servers to convert NetBIOS 
computer names to IP addresses.

Activate Scope Select 'Yes, I want to activate this scope now'.
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Configure Failover

This DHCP option provides high availability by synchronizing IP address information between 
two DHCP servers.

1. Go to Tools > DHCP > primary domain > IPv4 > Configure Failover and configure the 
following.

2. Repeat step 1 to configure a second DHCP server.
A successful configuration displays details of the failover configuration.

Create Roles, Areas, and 
Users

There are required roles for a PlantPAx system. Areas and users depend on your application. 
Assign users to Roles and Areas.

Name areas based on access, for example:
• Area01_Advanced (engineering access)
• Area01_Basic (non-engineering access)

Replace ‘Area01’ with the name of your process area.

From operators and maintenance personnel to engineers, the domain controller manages 
groups in the Active Directory. Use the Server Manager to configure the roles, areas, and users.

1. Use the Windows Server Manager Tools menu to launch the ‘Active Directory Users and 
Computers’ console.

2. From your domain, right-click, select New> Organizational Unit and type the name 
PlantPAx.

Basic Step Configure
Configure Failover Click Add Server and locate the secondary domain controller. Example: PADCB

Create New Failover 
Relationship

Select 'Hot standby' for mode.

You can also choose to require authentication (a shared secret password) to 
secure communications between failover partners.

Enter a 'Shared Secret', which can be passwords, pass phrases,
or random numbers.

See FactoryTalk Security Application Technique, publication SECURE-AT002, 
for more information.

https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at002_-en-p.pdf
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3. Under the PlantPAx group, right-click and select New > Organization Unit to create 
folders for Users, Areas, and Roles.

Add Groups for Role-Based Security

Roles define different security access for areas of a plant. We recommend the following roles:
• PlantPAx Operators
• PlantPAx Operating Supervisor
• PlantPAx Maintenance
• PlantPAx Maintenance Supervisor
• PlantPAx Manager
• PlantPAx Engineering
• PlantPAx Administrator
• PlantPAx View Only
• HMI Approver

Add Groups for Area Based Security

We recommend the following areas that are based on a group:
• Basic – Allows access to non-engineer functions, such as Maintenance, Operator, on 

process library faceplates.
• Advanced – Allows access to engineering modifications on process

library faceplates.

IMPORTANT Even though the examples show generic area names, such as 
Area01, we recommend that you use more specific names, such 
as Packaging, or Molding. And create two types for each area — 
Basic and Advanced—for each area.



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 33

Chapter 2          Domain or Workgroup

Name areas based on access, for example:
• Area01_Advanced (engineering access)
• Area01_Basic (non-engineering access)

Create as many areas as needed for the system.

Assign Users

Users are unique to each system.
1. Create users and assign them to the Member tab on the Properties for the associated 

Role.

2. Once the user name and password are created, configure the following properties as 
shown in the table for each user.

On This Page Configure
Properties Select the domain on the ‘Member of’ tab
Select Groups Type Area as the object name and select the appropriate Area
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The successful configuration of a user shows both their domain
and area.

Configure Group Policy 
Management

Group policies help reduce the maintenance and complexity when you add new users and 
computers into the PlantPAx system. The group policies determine what users can and can’t 
do, such as password maintenance or to restrict folder access. The same approach applies for 
how to define server maintenance.

The settings that are outlined are baseline recommendations. Individual business, IT, and 
security requirements could require additional policies.

Configure the Windows NTP Client

The domain is responsible to propagate and enforce the clock time to the domain computers. 
Use the Server Manager to configure the Windows NTP client so that the domain controller is in 
sync with the Windows NTP server.

1. Go to Tools > Group Policy Management.
2. Select the Default Domain Controllers Policy to edit.
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3. In the Group Policy Management Editor, select Policies > System > 
Windows Time Service.

4. Go to Time Providers > Configure Windows NTP Client.

5. Select 'Enable' and configure the 'Options' with your NtpServer: IP address and use Type: 
NTP. 
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6. Go to Time Providers > Enable Windows NTP Client and
check ‘Enabled.’

Configure Windows Time Service

Enable the NTP server to initiate automatically upon startup.
1. In the Group Policy Management Editor, go to Policies > Windows Settings > Name 

Resolution Policy > System Services >Windows Time.

2. In the Windows Time Properties, select the following:
• Check ‘Define this policy setting.’
• Check ‘Automatic’ for service startup mode.

Enforcing the Domain Controller Policy

Policy enforces the domain controllers to use the NTP server settings.
1. In the Group Policy Management Editor, select the Default Domain Controllers Policy and 

remove ‘Authenticated Users’ from
Security Filtering.
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2. Add Domain Controllers from the PlantPAx domain to
Security Filtering.

3. Right-click Domain Controllers and select Enforced.

Configure Group Policies These group policies are recommended:
• Password strength
• Account lockout
• Kerberos
• Interactive login

Use the specifications for your PlantPAx system to set the values for these policies. If you 
configure any of these policies, you must enforce the policies on the domain controller for 
them to take effect.

Configure the Password Strength Policy

This policy makes sure that security settings are enforced to help protect the system from 
unauthorized users upon entering the system.
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1. In the Group Policy Management Editor, select the Default Domain Policy to edit and 
select Password Policy.

Configure the Account Lockout Policy

This policy configures the number of password attempts and how an administrator resolves a 
user lockout situation.

1. In the Group Policy Management Editor, select the Default Domain Policy to edit and 
select Account Lockout Policy.

Configure the Kerberos Policy

This policy helps administer network authentication.
1. In the Group Policy Management Editor, select the Default Domain Policy to edit and 

select Kerberos Policy.
2. Enable the default options or modify if desired.
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Configure the Interactive Logon Policy

This policy configures a warning message to users of the consequences for misusing 
company information.

1. In the Group Policy Management Editor, select the Default Domain Policy to edit and 
select Interactive Logon Policy.

2. In the tree configuration of the Group Policy Management Editor dialog box, Go to 
Computer Configuration > Policies > Windows Settings > Security Settings > Local 
Policies.

3. Select the Security Options folder and select the Interactive login: Message Title option. 
Enter the name of the group that receives the interactive message.

4. Select the Interactive Logon: Message text option. Enter the message that appears to 
users during login.

PlantPAx Users Policy 
Object

You can create a PlantPAx Users Policy to restrict privileges and site access. Recommended 
policies include access for the following:

• USB drive
• Portable device
• Software

Use the specifications for your PlantPAx system to set the values for these policies. If you 
configure any of these policies, you must enforce the policies on the domain controller for 
them to take effect.

For how to configure the recommended FactoryTalk® Security settings, see Configure System 
Security Features User Manual, publication SECURE-UM001 and Appendix G - Security Policies.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
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Create the PlantPAx Users Policy Object

You can select a group and set restrictions. For example, a group of users can’t use USB drives 
as a layer of system security.

1. In the Group Policy Management Editor, select the PlantPAx Domain and select ‘Create a 
GPO in this domain and link it here...’

Configure the USB Drive Policy

A group of users can be restricted from using a USB drive.
1. In the Group Policy Management Editor, select the PlantPAx Users Policy Object to edit 

and select Removable Storage Access.

2. Go to Computer Configuration >User Configuration > Policies > Administrative 
Templates > System.

3. Select Removable Storage Access and choose All Removable Storage classes: Deny all 
access.
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4. Select Enabled.

Configure the Portable Device Enumeration Policy

This policy enforces Group Policy Objects for connected mass storage devices.
1. In the Group Policy Management Editor, select the PlantPAx Users Policy Object to edit 

and select Portable Device Enumeration Policy.

Configure the Software Access Policy

This policy helps protect against the use of non-approved system software.
1. In the Group Policy Management Editor, select the PlantPAx Users Policy Object to edit 

and select Software Access Policy.
2. Go to Computer Configuration > User Configuration > Policies > Administrative 

Templates.
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3. In the System folder, select ‘Don’t run specified Windows applications.’ 

4. Select Enabled, Show, and then type any application software to create an access 
restriction. Example: Regedit.exe

Windows Workgroup For small PlantPAx systems, you can use a Windows Workgroup where complexity and security 
controls are kept to a minimum. An example might be a PASS-C server for a self-contained 
process unit or packaged equipment that is built by an Original Equipment Manufacturer (OEM); 
commonly called a process skid.
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Assign Static IP Addresses

Without a domain controller, there’s no DCHP server to assign IP addresses. The workgroup 
requires all workstations and servers to contain manually set (static) IP address assignments.

1. On each workstation, access the Network Adapter TCP/IPv4 properties and assign a 
unique IP address.

Map Computer IP Addresses

Without a domain controller, there’s no DNS server to provide name resolution, meaning the 
computers can only communicate by IP address. To communicate by using a computer host 
name, mapping is required. All Windows computers contain a HOSTS plaintext file that maps IP 
addresses to host names.

1. Locate the HOSTS file in C:\Windows\System32\Drivers\etc directory and specify to 
open with Notepad.

IMPORTANT Stratix® managed switches can be set to operate as a DHCP 
server and provide DHCP persistence. See the switch user 
manual if using DHCP for workgroup computers.
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2. Create a list of your workgroup computers, starting with each IP address followed by 
the corresponding computer name. Use a tab to delimit space between each mapping.

3. Copy the HOSTS file to all other computers in the workgroup.

Test Communication by Host Name

You can verify that each workgroup computer responds to a PING command from another 
workgroup computer, referencing the remote computers
host name.

1. Open a Command Prompt and type PING followed by a host name.
For example: CMD: PING PASS01

2. Verify that a reply from the remote computer is returned with the correct
IP address.

Create Local Users

While not required, increased security is achieved when using local user accounts of varying 
privilege.

IMPORTANT Anytime a change or new computer is added, all workgroup 
computers must receive the updated HOSTS file.
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Use the most restrictive account to help protect from security threats that could otherwise 
use elevated privileges to exploit the operating system. Only sign in an administrative account 
as needed. 

1. Open Computer Management. (Run > compmgmt.msc)
2. Select Local Users and Groups in the left window pane.
3. Right-click the Users folder and select New User.
4. Enter a user name, password, and select ‘password never expires’.
5. After the user is created, right-click user and select Properties.
6. Go to the Member Of tab and Add the local group as desired.

Create Local Security Policies

While not required, if you have various levels of local users you can set local security policies 
that the more restricted accounts will not be able to modify. 

1. Login to the highest privilege local account with administrator access.
2. Open the Local Group Policy Editor (Run > gpedit.msc).
3. Expand Computer Configuration and go to Windows Settings > Security Settings.

4. Expand Computer Configuration and go to Windows Settings > Security Settings > 
Account Policies.

You can configure a lockout policy for several failed login attempts of unauthorized 
users.

5. Expand Computer Configuration and go to Windows Settings > Security Settings > Local 
Policies.

You can configure User Rights Assignment and Security Options. You can limit 
actions such as who can shut down the computer, change the system time, access 
the computer from a network, and so on.

Local Users and Groups Example

User Name Local Group
PlantPAx Engineering Administrators
PlantPAx Operators Power users

IMPORTANT Local user accounts must be duplicated on all workstations with 
shared credentials for seamless access.

IMPORTANT Local Policies must be duplicated on all workstations for 
seamless operation. This can be tedious and is why a domain 
controller with the ability to push domain policies is 
recommended over a workgroup.
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FactoryTalk DeskLock Utility (Optional)

DeskLock is a FactoryTalk® View tool for the Windows operating system. DeskLock provides 
control options for smaller systems that do not use policy or domain management.

Use the DeskLock tool to:
• Choose setting so that an operator using FactoryTalk View can’t gain access to 

functionality not expressly configured by the system administrator.
• Hide items on the Windows Explorer desktop, including the Taskbar and Start menu.
• Disable key combinations that are used to perform specific Windows actions, such as 

accessing the Task Manager.

Launch the DeskLock tool on computers with FactoryTalk View SE, FactoryTalk® Studio, server, 
or client components.

1. Go to Rockwell Software > FactoryTalk View > Tools > DeskLock
2. Select Set Up DeskLock.

3. Explore each of the four tabs (Logon, Desktop, Password, Behavior).

4. Use the Help button for information on how to configure and use the DeskLock utility.
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The Process Automation System Server (PASS) can be configured after joining an active 
domain or workgroup. The configuration steps described here cover larger system 
implementations.

This is the recommended workflow to configure a Process Automation System Server. For 
experienced users, each step outlines requirements. For more detailed information, follow the 
referenced links.

Prerequisites Following the System Workflow, configure a PASS or PASS-C, depending on the size of your 
system. Your results from the PSE determine the size of the system.

• The PASS server or servers must be deployed before doing the procedures in this 
section.

• PASS servers can be configured as redundant for HMI servers, data servers, and/or 
alarm servers.

FactoryTalk Components The PASS hosts the FactoryTalk® Services Platform that provides a set of common services 
(such as diagnostic messages, health monitoring services, and access to real-time data). 
FactoryTalk software products and applications depend on these services in a PlantPAx® 
system.

FactoryTalk Service Platform components for the PASS include:

PASS-C PASS

Component Description

FactoryTalk Administration Console

FactoryTalk Administration Console is a standalone tool for developing, managing, and securing multiple FactoryTalk View 
applications.
On the Administration Console, delete old computer names from the FactoryTalk Directory. By deleting old computer names, the 
FactoryTalk Directory contains current computer names only. Deletions also make sure that applications do not attempt to 
communicate with computers that are no longer in the FactoryTalk Directory.

Required: Yes; a prerequisite on every PlantPAx® computer containing FactoryTalk software. 

FactoryTalk Directory

FactoryTalk Directory provides a central lookup service for a PlantPAx system so all definitions do not have to exist in a single 
physical project file. References that are saved by FactoryTalk Directory are used by FactoryTalk-enabled products and FactoryTalk 
services to locate definitions when they’re needed. 
It allows clients to locate key configuration information such as system organization, server locations, and policy information. 
FactoryTalk Directory provides a common address or phone book of factory resources that are shared among FactoryTalk-enabled 
applications in a distributed system.

Required: Yes

FactoryTalk Activation

FactoryTalk Activation services provide a secure, software-based system for activating Rockwell Software® products and managing 
software activation files.

Required: Yes; a prerequisite on every PlantPAx computer containing FactoryTalk software. Activation file access is required for 
continuous use of FactoryTalk software otherwise a 7-day grace period is started.

Placement: A PASS is recommended location to bind and place the license files. Other servers and workstations can refer to the PASS 
location for floating or time borrowed activations. For more robust applications, activate each server locally to remove the dependency of 
remote license access.
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System SQL Server 
Deployment

Before configuring the PASS server, confirm that the SQL Server deployment has been 
completed and is accessible via the PASS server. This is required to ensure that Alarms and 
Events can be recorded in the SQL Database. Additionally, Batch server and Asset Management 
server will also create a DB in the SQL Server. PlantPAx requires the following SQL features to 
be enabled to ensure that data recording is possible.

Instance Features
• Database Engine Services
• SQL Server Replication
• Full Text and Semantic Extractions for Search
• Data Quality Service
• Analysis Services

Shared Features
• Data Quality Client
• Client Tools Connectivity
• Integration Services
• Client Tools Backwards Compatibility
• Client Tools SDK
• Documentation Components
• SQL Client Connectivity SDK

FactoryTalk® Security

FactoryTalk Security centralizes user authentication and authorization at the FactoryTalk Directory.
The users and groups are similar in their management to Active Directory and can be linked to the Active Directory. This centralized 
authentication and access control allows for a ‘single user sign in’ experience when using FactoryTalk enabled products.

Required: Yes

Placement: Same server that is hosting the FactoryTalk Directory.

FactoryTalk® Diagnostics

FactoryTalk Diagnostics collects and provides access to activity, status, warning, and error messages generated throughout a 
FactoryTalk system.

Required: Yes

Placement: Yes; a prerequisite on every PlantPAx computer containing FactoryTalk software.

FactoryTalk Alarms and Events

FactoryTalk Alarms and Events provides system-wide alarm monitoring and control centralized at the FactoryTalk Directory.

Required: Yes

Placement: Alarm and Events Server on the PASS

Component Description
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Configure the PASS Configure the PASS for standalone or distributed connectivity.
• Specify the location of the FactoryTalk Directory
• Configure the FactoryTalk Directory
• Run the Windows® Firewall Configuration Utility
• Configure FactoryTalk Activation servers

Specify FactoryTalk Directory Location

Every computer must know whether to use its own local directory or to use a network 
directory on a remote computer. Do the following for each computer in the system.

1. Go to Rockwell Software > FactoryTalk Tools > FactoryTalk Directory Server Location 
Utility and specify the location.
• For a PASS-C, specify the LOCAL directory and for each OWS client 

specify the PASS-C directory.
• For a distributed system, specify the server that will host the directory. 

Repeat for all other servers and workstations in the distributed system.
2. Restart each computer after specifying its directory location.

Configure the FactoryTalk Directory

Once you specify the FactoryTalk Directory location and restart the computer, configure the 
FactoryTalk Network Directory or Local Directory on each computer.

1. Go to Rockwell Software > FactoryTalk Tools > FactoryTalk Directory Configuration and 
select Network or Local or both, depending upon the perspective of the computer being 
configured.

2. Enter the Windows Administrative account user name and password.
3. In the Summary, verify that the configuration was successful.

Run Firewall Configuration Utility

The FactoryTalk Services Platform includes a Windows Firewall Configuration Utility (WFCU) to 
provide firewall port exceptions to incoming and outgoing processes that require remote 
access. Run this utility on every computer that has installed FactoryTalk software.
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1. Go to Rockwell Software > FactoryTalk Tools > Windows Firewall Configuration Utility.
And process-related exceptions are displayed at the bottom.

2. If needed, save a list of exceptions for future reference and the WFCU activity is logged 
to C:\ProgramData\WFCU\WFCULog.txt

3. If no exceptions are needed, click Exit.

Configure FactoryTalk Activation Servers

The FactoryTalk Activation Manager (FTAM) software is a prerequisite that is automatically 
installed on every PlantPAx computer that contains FactoryTalk software. 

For a PlantPAx system, the computer that hosts the FactoryTalk Directory, such as the PASS, 
hosts the license files. 

1. Go to Rockwell Software > FactoryTalk Activation > FactoryTalk Activation Manager and 
select new activations, as needed.

2. After all new activations are generated, go to the Advanced Tab and click ‘Refresh 
Server’.

Configure all other computers to reference the PASS location.
1. Go to Rockwell Software > FactoryTalk Activation > FactoryTalk Activation Manager and 

select Update Activation Search Path.

2. Select Add a server and enter the name or IP address of the license server (PASS01).

It’s recommended to enable Windows Defender Firewall notifications to 
inform you of any additional applications that would be blocked.
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3. If there are no local activations, move PASS01 to the top as the first location to search 
for activations.

4. Update the search path on all computers that require an activation.



52 Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025

Chapter 3          Process Automation System Server

Configure Servers on the 
PASS

A FactoryTalk View SE application is required to create the three major server components 
that run on the PASS.

• HMI server – Stores HMI project components, such as graphic displays, and provides 
these components to Operator Workstations (OWS) upon request.

• Data server – Accesses information from the process controllers and provides 
information to servers and workstations in the PlantPAx system.

•  Tag Alarm and Event server – Provides alarm information from the controllers and 
servers to each OWS upon request.

The number of servers and how they’re configured can impact the speed of system 
communication. Servers can be simplex or redundant.

• A single HMI server is sufficient for most PlantPAx systems. 
• Multiple data servers are common. By locating each in separate areas, tag lookup 

performance is improved as an HMI server knows specifically which data server to 
browse and can ignore others.

The following steps provide basic server creation on a single PASS. Large distributed systems 
can require multiple servers running remotely in a more elaborate architecture.

Create a New HMI Project

This section provides a method to create your own project and then import the components 
from the PlantPAx Graphic Framework.

1. Go to FactoryTalk® View Studio software > New and select an application type of View 
Site Edition.

The application types are Local Station, Network Station, or Network Distributed.

You now have a default application.

PlantPAx systems are Network Distributed applications, even when server 
components are consolidated on a standalone computer (PASS-C). The 
exception is a process skid, where a Local Station application provides 
sufficient functionality.
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Define Areas

Areas organize and subdivide applications in a network directory into logical and physical 
divisions. Areas can be created for different processes within a manufacturing facility or to 
group each server type. This name hierarchy can be visible externally, such as in the historian 
or alarm database.

Server assignment helps optimize performance. To help prevent unpredictable search results, 
do not insert a server into the application root path. Each server must be in its own area.

Use the Explorer window in FactoryTalk View Studio to add areas.
1. Go to the application and select New Area.

2. Create three Areas, one for each of the three main server types (DATA, FTAE, and HMI).

IMPORTANT Once you create an area, you can’t change the name. You must delete 
and recreate if you need to modify the name. 
Do not use spaces in the Area name to achieve proper HMI functionality.
Do not put multiple servers in the root location of an area.

• Alarm area folder stores the Alarm and Event server.
• Data area folder contains the data server.
• HMI area folder stores FactoryTalk® View tags and 

displays.
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Add an HMI Server

All PlantPAx systems require an HMI server.
1. Go to the HMI area and select Add New Server> HMI Server. Each area can only contain 

one HMI server.

Starting with FactoryTalk View SE 13.0, developers have the ability to add all process 
library components to a new or existing HMI server.

2. Enter a name, startup type, and specify the computer that hosts the service (for 
example, PASS01).

3. (optional) Click the Redundancy tab to specify a secondary PASS.
4. Select startup items on the Components tab, such as data logging, derived tags, events, 

and macros.

5. Click OK.
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Add a FactoryTalk ViewPoint Server

PlantPAx supports FactoryTalk Viewpoint for ISA-101 Level 1 through 3 displays. Level 4 displays 
represent the Library of Process Objects faceplates which are not supported in FactoryTalk 
ViewPoint. PlantPAx recommends that any FactoryTalk ViewPoint applications be designed as 
Read-Only for displays that are Level 1 through 3 per the ISA-101 standard. If there are more 
than 10 ViewPoint clients in a PlantPAx system, then a dedicated FactoryTalk ViewPoint server 
is recommended. An Operator Workstation Application Server can support up to 10 ViewPoint 
clients. The total number of visualization clients on a single Operator Workstation Application 
Server should not exceed 10. For example, a single server could include 5 Viewpoint clients and 
5 FactoryTalk View SE clients for a total of 10 visualization clients.

FactoryTalk ViewPoint is included as part of the installation of FactoryTalk View. Review the 
FactoryTalk ViewPoint Quick Start Guide FTVP-QS002 for more information.

Add the Alarms and Events Database

The data servers and the alarms and events servers can log alarm and event history to a SQL 
database. You must create this database before you can enable logging to the servers.

1. Use either FactoryTalk View SE Studio or the FactoryTalk Administrative Console to add 
a database connection.

2. Configure the database connection properties.
• Type: FactoryTalk Alarm & Events History Database 
• Definition name: (new or existing)
• Server that hosts your SQL database: (local or remote)
•  SQL database authentication

https://literature.rockwellautomation.com/idc/groups/literature/documents/qs/ftvp-qs002_-en-e.pdf
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• Database name (new or existing) 

If the database does not exist, you get a prompt when you click OK. Click YES to 
create the database.
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Add a Data Server (FactoryTalk Linx)

A FactoryTalk Linx data server is required to communicate to controllers. 
1. Go to the Data area and select Add New Server > Rockwell Automation Device server 

(FactoryTalk® Linx).

2. Enter a name, startup type, and specify the computer that hosts the service (for 
example, PASS01).

3. Create a first or second instance Data server (FactoryTalk Linx), each in its own area.
4. Enter a name, startup type, and specify the computer that hosts the service (for 

example, PASS01).
5. (optional) Click the Redundancy tab to specify a secondary PASS.
6. On the Alarm and Events tab, enable alarm and event support and enable history.
7. Enable server-assigned priorities and configure as required.
8. Enable history to configure alarm and event logging.

For information on verifying the data server, see Appendix C, PlantPAx Deployment 
Recommendations and Verification Tool.

IMPORTANT FactoryTalk Linx Instance02 is an independent service on the 
Windows operating system that is designed to allow applications 
to increase tag, data, and client capacities without impacting the 
performance of the first instance (also an independent service). 
Instance02 is not supported on FactoryTalk View SE local station 
and is limited to an Ethernet driver.
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Once the data server is created, configure device shortcuts to controllers and subscribe to the 
data server. Select All Alarms & Events Notification Messages to support Logix tag-based 
alarms and automatic diagnostic messages.

Add a Data Server (OPC UA)

An OPC UA data server is required to communicate with OPC UA devices. This server type 
supports OPC UA data and OPC UA Alarms and Conditions.

1. Use the Explorer window in FactoryTalk View Studio to add a new area for the OPC UA 
server.

2. Go to the new area and select Add New Server > OPC UA Server.
3. (optional) Click the Help button for more information about configuring the OPC UA 

server.
4. Enter a name and specify the computer that hosts the service. It’s a best practice to 

host the OPC UA server on a dedicated computer with no other FactoryTalk servers.
5. (optional) Enable option to keep configuration when service is uninstalled.
6. (optional) Enable redundancy option if using a secondary server. Click the Redundancy 

tab and specify a secondary server.
7. Click the OPC UA Servers tab.
8. Enter a name for the OPC UA server. Specify an Endpoint URL for the server.
9. (optional) If Redundancy is enabled and using a different standby URL, click the 

(Secondary) tab and specify a standby URL. Otherwise, enable the option to utilize the 
same URL as primary.

10. Specify Security settings for the OPC UA server.
11. Specify Authentication Settings for the OPC UA server.
12. Specify Data Access settings for the OPC UA server.
13. (optional) Enable alarm support and History in the Alarms Settings.
14. Specify Diagnostic Logging settings for the OPC UA server.
15. (optional) Click Add and repeat previous steps for any additional OPC UA servers.
16. (optional) Click the Certificate Management tab to manage access and certificates for 

the OPC UA servers.
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For information on verifying the data server (OPC UA), see Appendix C.

Add an Alarm and Events Server

An alarms and events server is required for server tag-based alarms.
1. Go to the FTAE area and select Add New Server > Tag Alarm and Event Server.

2. Enter a name, startup type, and specify the computer that hosts the service (for 
example, PASS01).

3. (optional) Click the Redundancy tab to specify a secondary PASS.
4. Click the Priorities and History tab and enable server-assigned priorities.
5. Enable history to configure alarm and event logging.

Add a Resource and Status Server

The FactoryTalk Resource and Status Server provides diagnostics and statistics for 
Application Servers and Workstations. No more than 20 Resource and Status servers should be 
configured in a single PlantPAx application.
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1. Each Resource and Status Server should have its own area. Once the area is created, 
select Add New Server > Resource and Status Server.

2. Enter a name and specify the computer.

3. Click the Help button for more information on all the configuration options.
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Configure DataLogPro

DataLogPro is optional and can be used for historical data and trending. DataLogPro also 
supports remote InfluxDB databases that have been configured in the FactoryTalk Directory. If 
using FactoryTalk Historian, See Configure Historian Data Collection on page 207.

1. Open FactoryTalk View Studio and open a new or existing application. If an HMI server 
does not already exist in the application, then add an HMI server by following the 
procedure from the “Add an HMI Server” section.

2. Double-click the DataLogPro option under the HMI server.

The DataLogPro editor will open.

3. New log groups can be added on the left. Select the log group to configure the trigger 
properties to log data. The options are Periodic, On Change, and On Demand. Periodic 
trigger will log data based on the defined interval. On Change trigger will log data only 
when the value has changed according to the deadband configuration. On Demand 
trigger will log data only when the FactoryTalk View command DataLogSnapshot is 
issued. For trending, it is recommended to use periodic trigger.
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4. Tag values can be added to a log group on the right. Use the filter to search. Tags can 
be dragged and dropped into a log group.

5. Click the save icon to save the DataLogPro configuration. The DataLogPro configuration 
can be exported or imported.
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6. For more information, click the help icon in the upper right corner.

Now that your servers are organized into areas, you’re ready to start developing your 
HMI application. 

For details on building an HMI template, see the Rockwell Automation Library of Process 
Objects Reference Manual, publication PROCES-RM200.

Redundant Server 
Considerations

Redundant HMI, Data, and Alarm servers provide higher availability on a network distributed 
architecture. Primary and secondary servers are hosted on different PASS servers where 
control can be switched between them.

When implementing a primary and secondary server (PASS02A and PASS02B), we recommend 
that you use a single PASS01 (non-redundant) to host the FactoryTalk Network Directory and 
FactoryTalk Activations. By using the PASS01, these common components are still accessible 
in case one of the redundant servers is unreachable.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
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Access the Redundancy tab of each servers' properties to enable redundancy and specify the 
secondary server.

Configure Runtime Security Runtime security can be configured for three different capabilities or a blending of those 
capabilities when deploying the HMI content provided in the Process Library.

• User role (that is, Operator, Engineer, and so on)
• Area
• Line-of-sight

Security by user role restricts users to the actions their role allows. The addition of area 
security can further restrict those allowed actions to specific areas of the plant. Finally, with 
the addition of line-of-sight security, the user can be further restricted from performing 
identified actions to the specific computer they are using. Not all these capabilities are 
required, you can deploy each security option individually or in any combination.

Refer to Security Example with Concurrent Implementation of all Three Security Methods on 
page 81 for an example implementation.

Role-Based Security

See Appendix G for the security policies.

Runtime security must be configured to provide each account or user group with the correct 
FactoryTalk View security codes. The security codes verify that operators, maintenance 
personnel, and engineers have permission to run secured commands, open secured graphic 
displays, or write to secured tags at runtime.

The images in this section depict a single application with both FactoryTalk 
User Groups and Domain User Groups together. However, it isn’t 
recommended to use both types of user groups in a single application.
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1. On the PASS, go to Rockwell Software > FactoryTalk View > Tools > Tag Import and 
Export Wizard.

To set security permissions to groups on the workstation, complete these steps.
1. Open the HMI application with FactoryTalk View Studio software.
2. Verify that the security tags have been imported by expanding the HMI Area and viewing 

HMI Tags folders. (Const, RALibrary, and Security)

3. Select Runtime Security from the Explorer window or top menu bar under Settings.
4. Within Runtime Security, click the Security Accounts button.
5. From the Security Settings dialog box, select 'All Users' and

click Remove.
6. Click Add.
7. From the Select Users and Computer dialog box, select a PlantPAx group and click OK.

Page Action

Tag Import and Export Wizard
Operations field

From the Operation pull-down menu, select Import FactoryTalk View tag CSV files and click Next.
From the pull-down menu, select Site Edition and click Browse (ellipsis '…').
Select the path of SE > HMI Projects > HMI Server.
Select HMI Server.sed and click Open.
Click Next and Browse (ellipsis '…') for the FTViewSE_ProcessLibrary_Tags_5_00_xx.CSV file; where xx = the 
service release number.
This file is distributed with the PlantPAx Library of Process Objects Library.
Click Open, click Next twice, and then Finish.
The import results appear on the Database Import window.
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For FactoryTalk user groups:

For Domain user groups:

8. Repeat adding users until all PlantPAx groups are selected. 
9. You can assign security to each PlantPAx group based on letters (A…G, P).
10. If you’re using e-signature with approval, add the group HMI_Approver. A-P codes aren’t 

required for HMI_Approver.
11. Select a group from the Users list.

The default is that all FactoryTalk View Security Codes are
checked Allow.

12. Click the Allow box beside each FactoryTalk View Security Code that you want to allow 
permission for the selected account.
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For example, allow security of 'A' for an Operator.

For FactoryTalk user groups:

For Domain user groups:

13. Repeat the steps for each user or group account that you want to configure with 
runtime security.

Table 4 - Recommended Group Security Codes

Group Security Code
Operators A
Operating Supervisor B
Maintenance C
Maintenance Supervisor D
Engineering E
Manager F
Administrator G
View Only P
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For the View Only user group, it is recommended to “Deny” certain security privileges 
for the application. Right-click your application, select “Security…”. Add the View 
Only user group and select “Deny” for applicable permissions. 
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Area-Based Security

Complete these steps to create area FactoryTalk user groups for each secure area of a 
production facility.

1. From the FactoryTalk Administration Console, click ‘+’ to expand System and then click 
‘+’ to expand Users and Groups.

2. Right-click User Groups and choose New>User Group.
On the New User Group dialog box, you must add two groups: ‘area01_Advanced,’ 
‘area01_Basic’. These groups define which Area01 Users have basic functions on the 
faceplate or advanced functions (engineering, maintenance).

3. To add groups, type the name (example, AREA01_ADVANCED) and
click Add.

The instructions default to Area01. You may modify the area name in the 
instruction and group names to meet your needs.
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4. Select Authenticated Users and use the default ‘Show groups only’ and click OK.

5. Click OK again.
Your two groups for AREA01 look like the example.

6. Repeat step 3 and step 4 to add groups for additional areas.

Complete these steps to import area Domain user groups for each secure area of a production 
facility.

1. From the FactoryTalk Administration Console, click ‘+’ to expand System and then click 
‘+’ to expand Users and Groups.

2. Right-click User Groups and choose New>Windows-Linked Group.
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3. Select Add.

4. Select Locations.

5. Browse to your domain directory where you created areas. For this example 
System.PlantPAx.Local\PlantPAx\Areas
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6. Select Find Now.

7. Select all areas from the search results that you want to import. 
For this example Area01_Basic, Area01_Advanced, Area02_Basic, Area02_Advanced. 
Click OK.

8. Select OK on the next two displays.
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The domain areas are added to User Groups and look as follows:

Configure an Area

For each object instance in controller code, it’s required to configure an area using the 
instruction dialog box (PlantPAx instructions) or extended tag property area (Add-On 
Instructions). Configuring each instruction with the specified area name will grant or deny 
permissions on the faceplates for these objects. The following displays use the default value 
“Area01”.

For FactoryTalk user groups:

Figure 3 - PlantPAx Instruction Dialog Box

To grant permission on faceplates, the Area name in the controller must 
match the area that is created within the HMI application (without _Basic \ 
_Advanced).
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Figure 4 - Add-On Instruction Extended Tag Property

For Domain user groups:

Figure 5 - PlantPAx Instruction Dialog Box

Figure 6 - Add-On Instruction Extended Tag Property

Adding Users to Groups

Assign each user to the appropriate user group. Only FactoryTalk users need to be added to 
Users. Windows-Linked Users are automatically added when Windows-Linked User Groups are 
added.

With multiple process areas defined (example Area01, Area02), note that each user needs to be 
assigned not only to the HMI_{group} (example HMI_Operator) but also the “area” group. 
Operators are assigned to the HMI_Operator group and then also to the Area01_Basic group. 
This limits operator access to only the faceplate operator controls for devices that are 
assigned to Area01. Engineers are assigned to the HMI_Engineering group and also to the 
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Area01_Advanced and Area01_Basic groups. This allows the engineer access to also the 
advanced engineering features on the faceplates for devices that are assigned to Area_01.

1. Open the HMI application with FactoryTalk View Studio software.
2. Select Users from the menu.

3. Right-click on a user to select that user’s properties.
4. Select the Group Membership tab and select Add.

IMPORTANT Users assigned to “Advanced” groups must also be assigned to 
the corresponding “Basic” groups
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5. Select the groups to assign to the user. (Multiple groups can be selected by holding 
down the Ctrl key.)

6. Once added, the groups appear assigned to the user.

Line of Sight Based Security

The procedures for this functionality require a distributed system. This section describes how 
to add a desired computer to a group (‘Computer Group’) and to an area of the plant.

It’s recommended that users that belong to the HMI_Engineer and 
HMI_Maintenance_Supervisor group also be added to both the area01_Basic 
and area01_Advanced groups.

IMPORTANT The macro ‘NavToDisplay with line of sight’ must be added to the 
project and renamed ‘NavToDisplay’ to replace the existing 
‘NavToDisplay’. 
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1. From the FactoryTalk View Distributed application, click ‘+’ to expand System and then 
click ‘+’ to expand Computers and Groups.

2. Right-click Computer Groups and choose New Computer Group.
3. Enter the area name and click Add.

The area name is the same name as the area name configured in the controller. The 
computer area name does not have the ‘Basic’ or ‘Advanced’ suffix.

4. On the Select Computer window, select Create New and
choose Computer.
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5. Enter a desired computer name.

6. Select the name of the desired computer.
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7. To add the computer group to the area, click OK.

Figure 7 - Security Example with Concurrent Implementation of all Three Security Methods

MXR_WORKSTATION
[OWS]

Bob 
[Engineer]

Area Based Security

Role Based Security

Line of Sight Security

Logix Instruction
@Area = Mixer  1

PlantPAx_Engineering
Security code = E

Computer Group
Mixer

MXR_WORKSTATION

User Group 2
Mixer_Advanced

Bob

User Group 2
Mixer_Basic

Bob

User Group 3
Bob

1. When using Domain controller
(named ‘System’) 
Instruction @Area = System\Mixer
Note: Domain name does not apply to Line-
of-Sight security since computer groups 
are FactoryTalk constructs and aren’t used 
in Windows.

2. When using Domain controller 
(named ‘System’) 
Create User Groups = System\Mixer…

3. When using Domain controller 
(named ‘System’) 
Import user groups = System\PlantPAx…
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Remote Desktop Services This optional section describes how to use Remote Desktop Services (RDS) to access 
FactoryTalk applications, such as thin clients.

Use Default Terminal Client

You have two server options to specify how each remote terminal identifies itself to 
FactoryTalk Security: terminal client or server computer; terminal being the default.

1. Navigate to Rockwell Software>FactoryTalk Administration Console.
2. Under System>Policies>System Policies, double-click Security Policy.
3. On the Policy Settings dialog box under Computer Policy Settings, leave terminal client 

as the default for remote desktop services to be available and select OK.

Audit Security Actions

You can enable an audit to track configurations and security.
1. Navigate to Rockwell Software>FactoryTalk Administration Console.
2. Under System>Policies>System Policies, double-click Audit Policy.
3. Under Audit Policy Settings, select Enabled from the Audit security access failures 

dropdown menu and select OK.

Select Server computer from the pull-down menu and click OK if you want external 
client computers to be able to log in to the FTD without any pre-configuration. This 
option, however, does not let you track specific actions from the terminal client.
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The PlantPAx® Distributed Control System supports several network topologies to meet 
specific needs. The following sections summarize the recommended network topology 
designs with more detail available by following the referenced links to the details provided 
later in this chapter.

You need to know which of the following are in your system:
• Domain controller or workgroup
• PASS or PASS-C

Before you design and implement a PlantPAx network infrastructure, you should:
• Have experience with VLAN and IP schemes.
• Have a network design that defines the requirements for the supervisory and control 

networks in the PlantPAx system.
• Be familiar with how to use the Express Setup and Device Manager utilities to configure 

and configure Stratix® switches.
• Be familiar with the Cisco IOS® command-line interface (CLI). 
• Verify that no fixed IP is assigned to the workstation that is being used to configure the 

switch. You want the switch to manage the IP address configuration in your computer.

For more information, see these additional resources.

Network Configuration 
Preparation

Smart devices on PlantPAx system architectures communicate on the EtherNet/IP network via 
Stratix and Cisco switches. These managed switches provide a secure switching 
infrastructure for harsh environments. You can connect the switches to network devices such 
as servers, routers, and other switches. In industrial environments, you can connect Ethernet-
enabled industrial communication devices, including controllers, human machine interfaces 
(HMIs), drives, sensors, and I/O.

Resource Description

Network Device Library, Publication DEVICE-RM400 Device Object Libraries enable you to easily interface with Rockwell Automation® intelligent devices like drives, 
motion, network switches, sensors, IO and more.

Stratix Managed Switches User Manual,
publication 1783-UM007 Describes how to build, configure, and troubleshoot Stratix switches. 

Stratix 5200 and Stratix 5800 Managed Switches, 
publication 1783-UM012

Describes how to configure, manage, and troubleshoot Stratix® 5200 and Stratix 5800 managed Ethernet 
switches and expansion modules.

Converged Plantwide Ethernet (CPwE) Design and 
Implementation Guide, publication ENET-TD001

Describes tested and validated industrial network architectures, recommendations and best practices, including 
network resiliency and security.

EtherNet I/P Parallel Redundancy Protocol Application 
Technique, publication ENET-AT006 Describes how you can configure a PRP network with a compatible device or switch.

EtherNet I/P Device Level Ring Application Technique, 
publication ENET-AT007 Describes DLR network operation, topologies, configuration considerations, and diagnostic methods. 

Deploying a Resilient Converged Plantwide Ethernet 
Architecture, Publication ENET-TD010 Describes how to design and deploy a resilient plant-wide or site-wide LAN architectures for IACS applications.

Deploying Device Level Ring within a CPwE 
Architecture, publication ENET-TD015

Describes how to design and deploy DLR technology with IACS device-level, switch-level, and mixed device/
switch-level ring topologies across OEM and plant-wide or site-wide IACS applications.

Scalable Time Distribution within a Converged 
Plantwide Ethernet Architecture, publication ENET-
TD016

Describes how to design and deploy Scalable Time Distribution technology throughout a plant-wide Industrial 
Automation and Control System (IACS) network infrastructure.

Deploying Parallel Redundancy Protocol within a CPwE 
Architecture, publication ENET-TD021

Describes how to design and deploy PRP technology with redundant network infrastructure across plant-wide or 
site-wide IACS applications.

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1783-um007_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td010_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td015_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td016_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td016_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td021_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/device-rm400_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1783-um012_-en-p.pdf
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The Ethernet network provides the communication backbone for the supervisory network for 
the workstations, servers, and the controllers:

• Configure all communication interfaces to operate at the fastest speed possible for 
your hardware configuration, full-duplex for 100/1000 network adapters. See Important 
for autonegotiate settings.

• Select the cable type based on environmental conditions.

Follow these guidelines for devices on the EtherNet/IP network:
• Make sure that an I/O module RPI is two times faster than the periodic task that you’re 

using.
• The number of devices can affect the CIP™/TCP count differently. Never use more than 

80% of the available connections for the communication modules.
• Consider packets per second for performance if you use many devices.

- I/O packets per second (pps) describes an implicit message rate (Class 1). An I/O 
communication use approaching or above 80% can necessitate an adjustment to 
the RPI.

- HMI packets per second (pps) describes an explicit message rate (Class 3). 
FactoryTalk Linx® connections and message instructions generate CIP traffic. HMI 
traffic is TCP-based, not UDP-based.

- The combination of implicit and explicit messaging provides the total use for a 
device. If you add implicit messaging (I/O), it takes bandwidth from the HMI because 
it has higher priority than HMI messaging. The combination of CIP implicit (highest 
priority) and CIP explicit (second priority) can’t exceed 100% use.

• Use compatible keying on communication modules. Where required, such as in 
validated industries, you can use an exact match for keying.

Recommended VLANs

Subnets segment the devices in a network into smaller groups. The IP address and associated 
subnet mask are unique identifiers for the switch in a network.

The following table of recommended VLANs segments the system and recommends IP address 
ranges. Use these recommendations with the topology worksheet to segment your system.

IMPORTANT Use of autonegotiate settings is recommended to reduce chance 
of mis-configuration and failures. However, it’s desirable to 
operate at the fastest speed possible at full-duplex. We 
recommend verifying your switch settings during commissioning 
to make sure that the system was able to autonegotiate properly. 
The speed and duplex settings for the devices on the same 
Ethernet network must be the same to avoid transmission errors.

Type Details

Fiber-optic

• Long distances
• Near high magnetic fields, such as induction-heating processes
• For extreme high-noise environments
• For poorly grounded systems
• For outdoor applications

Shielded twisted-pair • Use Category 5e, 6, or 6a cables and connectors
• Use termination sequence 568A for industrial applications

PROCES-RD100 contains the recommended topology and switch settings. 
Download the spreadsheet and use the tab that is referenced in each step.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rd/proces-rd100_-en-p.xlsx
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Command-line Interface (CLI)

Along with Device Manager and Logix Designer applications, you can use the Cisco IOS® 
command-line interface (CLI) to manage the switch. This interface enables executes Cisco IOS 
commands by using a router console or terminal, or by using remote access methods. You can:

• Connect directly to the switch console port
• Enable Secure Shell (SSH) or Telnet in Device Manager

For more information about how to use the CLI, see https://www.cisco.com/.

Stratix 5200 and Stratix 5800 provide CLI access via the WebUI. The Command Line Interface 
can be accessed within the Administration menu in the WebUI.

Redundant PRP Topology Parallel Redundancy Protocol (PRP) is defined in international standard IEC 62439-3 and 
provides high-availability in Ethernet networks. PRP technology creates seamless redundancy 
by sending duplicate frames to two independent network infrastructures, which are known as 
LAN A and LAN B.

A PRP network includes the following components.

Table 5 - Descriptions for VLANs and Ethernet Address Ranges(1)

VLAN ID (Name) EtherNet/IP Address Range Description
1 N/A

N/A

Not used

300 (Native VLAN)(2) N/A Not to have any assigned IP addresses
Native for Control and Supervisory

500 (Control network
management VLAN)

172.18.0.1 Default gateway
172.18.0.2 172.18.0.9 VLAN routing – switch addresses (to be utilized for Layer 3 switches)
172.18.0.10 172.18.0.253 Application – switch addresses

501 (Control network – Default)
172.18.1.1 N/A Default gateway
172.18.1.2 172.18.1.9 VLAN routing
172.18.[2…].10 172.18.[…9].253 Ethernet interface between controllers and system applications.

502…509 (Additional Control 
network VLANs for IO and MCC)

172.18.[2…].1 172.18.[…9].1 Default gateway
172.18.[2…].2 172.18.[…9].9 VLAN routing
172.18.[2…].10 172.18.[…9].253 Ethernet interface between controllers, I/O modules, and MCCs (fixed)

600 (HMI Control + Supervisory 
management VLAN)

172.20.0.1 N/A Default gateway
172.20.0.2 172.20.0.9 VLAN routing – switch addresses (to be used for Layer 3 switches)
172.20.0.10 172.20.0.253 Application – switch addresses

601 (HMI Control network + 
Supervisory network –
wired network)

172.20.1.1 N/A Default gateway
172.20.1.10 N/A Domain/DNS primary server
172.20.1.11 N/A Domain/DNS secondary server
172.20.1.12 172.20.1.99 Servers and workstations (DHCP)
172.20.1.2 172.20.1.9 VLAN routing
172.20.1.1 172.20.1.25 Workstation interface

602 (Supervisory network - 
wireless network)

172.20.2.1 N/A Default gateway
172.20.2.2 172.20.2.9 VLAN routing – switch addresses (to be used fro Layer 3 switches)
172.20.2.10 172.20.2.253 Mobile interface

603 (External - untrusted 
network)
Note: From IDMZ (industrial 
demilitarized zone)

172.20.3.1 N/A Default gateway
172.20.3.2 172.20.3.9 VLAN routing – switch address (to be used for Layer 3 switches)
172.20.3.10 172.20.3.253 External interface

(1) The referenced IP Addresses can be changed for your system requirements.
(2) All networks do not need to use a dedicated management VLAN, but it’s a good practice. Many times, a supervisory VLAN is the same VLAN as the management VLAN.

https://content.cisco.com/chapter.sjs?uri=/searchable/chapter/content/en/us/td/docs/ios-xml/ios/fundamentals/configuration/15mt/fundamentals-15-mt-book/cf-cli-basics.html.xml&searchurl=https%3A%2F%2Fsearch.cisco.com%2Fsearch%3Fquery%3DCLI%26locale%3DenUS%26bizcontext%3D%26cat%3D%26mode%3Dtext%26clktyp%3Denter%26autosuggest%3Dfalse&dtid=osscdc000283


86 Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025

Chapter 4          Network Infrastructure

Redundancy uses Hot Standby Router Protocol (HSRP). HSRP lets you configure two or more 
routers as standby routers, but only one router is active at a time.

Additional Resources for PRP Topology

For more information, see these additional resources.

Component Description
LAN A and LAN B Redundant, active Ethernet networks that operate in parallel. 
Double attached node (DAN) An end device with PRP technology that connects to both LAN A and LAN B.

Single attached node (SAN) An end device without PRP technology that connects to either LAN A or LAN B.
A SAN does not have PRP redundancy.

Redundancy box (RedBox) A switch with PRP technology that connects devices without PRP technology to 
both LAN A and LAN B. 

Virtual double attached node 
(VDAN)

An end device without PRP technology that connects to both LAN A and LAN B 
through a RedBox.
A VDAN has PRP redundancy and appears to other nodes in the network as a DAN.

Infrastructure switch A switch that connects to either LAN A or LAN B and isn’t configured as a RedBox.

Resource Description
Design Guide, Deploying Parallel Redundancy Protocol 
within a CPwE Architecture, publication ENET-TD021.

Highlights key IACS application requirements, technology, and supporting design considerations to help 
with the successful design and deployment of PRP applications.

EtherNet/IP Parallel Redundancy Protocol,
publication ENET-AT006

Describes how you can configure a Parallel Redundancy Protocol (PRP) network with a compatible device 
or switch.

EtherNet/IP Network Devices User Manual,
publication ENET-UM006 Explains Logix 5000® tools that are used in EtherNet/IP topologies and network operation.

Cisco Catalyst® 9300 Series Switches

Describes the hardware installation.
Describes how to update firmware.
Lists the recommended firmware downloads.
Describes how to configure the switch.

https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td021_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at006_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/enet-um006_-en-p.pdf
https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst9300/hardware/install/b_c9300_hig.html
https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst9300/software/release/16-9/release_notes/ol-16-9-9300.html
https://www.cisco.com/c/en/us/support/docs/switches/catalyst-9300-series-switches/214814-recommended-releases-for-catalyst-9200-9.html
https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst9300/hardware/install/b_c9300_hig/b_c9300_hig_chapter_01000.html 
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Switch Configuration in a 
Redundant PRP Topology

The following figure shows an example PRP topology. The numbers circled in red match the 
sequential instructions below the example.

Figure 8 - Redundant PRP Topology Example

1. Configure the Cisco stack switches.
See the ‘1 PRP Cisco Stack Switch’ tab in the topology worksheet.xlsx.

a. Connect to distribution switches
b. Connect to application servers

For stacking guidelines and cabling considerations, see Cisco user documentation.
2. Configure the HSRP distribution switches.

See the ‘2 PRP HSRP Switch’ tab in the topology worksheet.xlsx.
a. Connect distribution switches to the core stack
b. Configure PRP

3. Configure the LAN A/B access switches.
See the ‘3 PRP LAN A B’ tab in the topology worksheet.xlsx.

4. Configure the RedBox switches.

Application Servers
(Hypervisor)

EWS/OWS

LAN A

LAN B

Remote 
I/O 

Supervisory Network (VLAN 601)

Control Network Default (VLAN 501)

Layer 3 Routed Point-to-Point

Trunk - (Native VLAN 300)

HSRP (Configuration Redundancy)

Secondary Connection
Logix Redundancy (RM)

EtherChannel
RedBox (PRP)
LAN-A / LAN-B (PRP)

Cisco Stack Member

Operator and 
Engineering 
WorkstationsControl Network I/O (VLAN 502)

Control Network MCC (VLAN 503)

3

4

5

1

2

PROCES-RD100 contains the recommended topology and switch settings. 
Download the spreadsheet and use the tab that is referenced in each step.

WARNING: Do not connect switches together before the network is fully 
configured.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rd/proces-rd100_-en-p.xlsx
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See the ‘4 PRP RedBox Infrastructure’ tab in the topology worksheet.xlsx.
5. Add PRP devices or skids.

See the user documentation for your devices on how to configure
PRP settings.
For examples, see Figure 9.

6. Verify the PRP configuration.
See the ‘5 PRP Verification’ tab in the topology worksheet.xlsx.

Figure 9 - PRP Skid and MCC Lineup

PRP Skid - Connected to LAN A and LAN B

DCS

Skid

RedBox VDAN 
Support

PRP Skid - Simplex Connected to Either LAN A/B

LAN A LAN BLAN A LAN B

DCS

Skid

PRP MCC - RedBox Connected to LAN A and LAN B

DCS

Skid

LAN A LAN B

PRP MCC - Connected to LAN A and LAN B with DLR Ring

Ring 

LAN A LAN B

DCS

MCC MCC

Skid
RedBox VDAN 
Support

RedBox VDAN 
Support
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Resilient DLR Topology Device Level Ring (DLR) is an EtherNet/IP protocol that is defined by the Open DeviceNet® 
Vendors’ Association (ODVA). DLR provides a means to detect, manage, and recover from single 
faults in a ring-based network.

A DLR network includes the following types of ring nodes.

Consider the following if you choose this topology:
• Depending on firmware capabilities, both devices and switches can operate as 

supervisors or ring nodes on a DLR network. Only switches can operate as redundant 
gateways.

• Multiport EtherNet/IP devices that are equipped with DLR technology connect directly to 
neighboring nodes and form a ring topology at the end devices. If a break in the line is 
detected, the network provides an alternate routing of the data to help recover the 
network at fast rates. 

• All end devices that are tightly coupled to a controller must be a part of the same 
embedded switch topology. This peer-to-peer architecture reduces the physical 
amount (and therefore cost) of cabling.

• Enhanced diagnostics that are built into DLR-enabled products identify the point of 
failure, helping to speed maintenance and reduce mean time to restoration. 

• The DLR ring supervisor maintains a loop-free topology by blocking
port 2 of the embedded-switch device. If the supervisor detects a fault in the network, 
it unblocks port 2 until the fault is corrected. It’s important to remember to enable a 
ring supervisor before closing the DLR ring. If the ring closed before the supervisor is 
enabled, a bridge loop results, which generates a broadcast storm.

Additional Resources for DLR Topology

For more information, see these additional resources.

Figure 10 shows an example DLR topology. The numbers circled in red match the sequential 
instructions below the example.

Node Description

Ring supervisor

A ring supervisor provides these functions:
• Manages traffic on the DLR network
• Collects diagnostic information for the network
A DLR network requires at least one node to be configured as ring supervisor.
By default, the supervisor function is disabled on supervisor-capable devices.

Ring participants

Ring participants provide these functions:
• Process data that is transmitted over the network.
• Pass on the data to the next node on the network.
• Report fault locations to the active ring supervisor.
When a fault occurs on the DLR network, ring participants reconfigure 
themselves and relearn the network topology. 

Redundant gateways 
(optional)

Redundant gateways are multiple switches that are connected to a single DLR 
network and also connected together through the rest of the network.
Redundant gateways provide DLR network resiliency to the rest of the network.

Resource Description

EtherNet/IP Device Level Ring, publication ENET-AT007 Describes DLR network operation, topologies, configuration considerations, and diagnostic 
methods

EtherNet/IP Network Devices User Manual, publication ENET-UM006 Explains Logix 5000 tools that are used in EtherNet/IP topologies and network operation.

https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at007_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/enet-um006_-en-p.pdf
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Figure 10 - Resilient DLR Topology Example

Switch Configuration in a 
Resilient DLR Topology

Switch configuration in a DLR topology follows the workflow that is shown
in Figure 10.

1. Configure the Cisco stack switches.
See the ‘1 DLR Cisco Stack Switch’ tab in the topology worksheet.xlsx.

a. Connect to distribution switches
b. Connect to application servers

For stacking guidelines and cabling considerations, see the Cisco user 
documentation.

2. Configure the gateways.
See the ‘2 DLR Gateway Switch’ tab in the topology worksheet.xlsx.

3. Configure the ring access switches.
See the ‘3 DLR Ring Switch’ tab in the topology worksheet.xlsx.

4. Add DLR devices or skids.
See the user documentation for your devices on how to configure DLR settings.
For examples, see Figure 11.

5. Verify the DLR configuration.
See the ‘4 DLR Verification’ tab in the topology worksheet.xlsx.

EWS/OWS

Operators and 
Engineering 
Workstations

Application Servers 
(hypervisor)

Supervisory Network (VLAN 601)
Control Network - Default (VLAN 

Trunk - (Native VLAN 300)
Secondary Connection
Logix Redundancy (RM)

EtherChannel
Cisco Stack Member
DLR Gateway (redundant)

1

2

3

4

Control Network - IO (VLAN 502)
Control Network - MCC (VLAN 503)

PROCES-RD100 contains the recommended topology and switch settings. 
Download the spreadsheet and use the tab that is referenced in each step.

WARNING: Do not connect switches together before the network is fully 
configured.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rd/proces-rd100_-en-p.xlsx
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Figure 11 - DLR Skid and MCC Lineup

Simplex - Star Topology In a star topology, access switches serve as an uplink from the servers to the workstations. 
Layer 2 switches also send information packets at the controller level from the end devices. 
With multiple network levels, access switches control the flow of information to make sure 
that packets are delivered to the correct network level.

Figure 12 shows an example simplex star topology. The numbers circled in red match the 
sequential instructions below the example.
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DLR Member DLR Member
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DCS
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DCS
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Figure 12 - Simplex - Star Topology Example

Consider the following if you choose this topology:
• The first switch that Rockwell Automation equipment touches must have IGMP snooping 

enabled. IGMP snooping enables switches to forward multicast packets to ports that are 
only part of a particular multicast group.

Additional Resources for Simplex Star Topology

For more information, see these additional resources.

Operator and 
Engineering 
Workstations

Application Servers 
(hypervisor)

EWS/OWS

Supervisory Network (VLAN 601)
Control Network (VLAN 501)
Trunk - (Native VLAN 301)

1

2

3

Resource Description
Stratix Managed Switches User Manual,
publication 1783-UM007

Describes the embedded software features and tools for configuring and managing the Ethernet managed 
switches.

Stratix 5200 and Stratix 5800 Managed Switches, 
publication 1783-UM012

Describes how to configure, manage, and troubleshoot Stratix® 5200 and Stratix 5800 managed Ethernet 
switches and expansion modules.

Stratix Infrastructure Product Family Quick Reference 
Drawing, publication IASIMP-QR029 Illustration that shows options for connecting your plant network by using standard Ethernet technology.

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1783-um007_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/qr/iasimp-qr029_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1783-um012_-en-p.pdf
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Switch Configuration in a 
Simplex Topology

Switch configuration in a simplex topology follows the workflow that is shown
in Figure 12.

1. Configure the Cisco stack switch.
See the ‘1 Simplex Cisco Stack Switch’ tab in the topology worksheet.xlsx.
For stacking guidelines and cabling considerations, see the Cisco user 
documentation.

2. Configure the access switches.
See the ‘2 Simplex Access Switch’ tab Simplex Switches tab in the topology 
worksheet.xlsx.

3. Add simplex devices.
See the user documentation for your devices on how to configure
network settings.
For examples, see Figure 13.

4. Verify the Simplex configuration.
See the ‘3 Simplex Verification’ tab in the topology worksheet.xlsx.

Figure 13 - Simplex Skid and MCC Lineup

Perimeter Network 
Considerations

The Perimeter Network (Microsoft®) is a buffer that enforces data security policies between a 
trusted network (Industrial Zone) and an untrusted network (Enterprise Zone). 

For secure data sharing, the Perimeter Network contains assets that act as brokers between 
the zones. Consider these methods:

• Use an application mirror, such as a PI-to-PI interface for
FactoryTalk® Historian

• Use Microsoft Remote Desktop Gateway services
• Use a reverse proxy server

Time Synchronization System time synchronization is important so that the internal clocks in the controllers, 
workstations, and servers reference the same time for any event or alarm that occurs. 
Configure the PASS, application servers, OWS, and EWS to use a single server (for example, a 
domain controller) as their time reference and keep their clocks synced to it. 

WARNING: Do not connect switches together before the network is fully 
configured.

PROCES-RD100 contains the recommended topology and switch settings. 
Download the spreadsheet and use the tab that is referenced in each step.

Skid - Simplex Connected to Simplex DCS

Skid

DCS

MCC - Connected to Simplex DCS

DCS

Skid

MCC

https://literature.rockwellautomation.com/idc/groups/literature/documents/rd/proces-rd100_-en-p.xlsx
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This chapter describes procedures for configuring time-sync applications by using two 
common protocols:

• Network Time Protocol (NTP)
• Precision Time Protocol (PTP)

NTP synchronizes time over the plant floor on an Ethernet network as shown in the following 
figure. NTP sources Coordinated Universal Time (UTC) as the universal standard for current 
time. Typically for Windows, a domain controller sources UTC time and becomes the Reliable 
Time Server for the domain.

Two methods are described to use UTC time in your domain:
• Via your local network (intranet) or the Internet (previous diagram)
• Via GPS 

The Internet can introduce more propagation delays than GPS that can cause inaccuracies in 
your system. Although the NTP system affords algorithms to calculate accurate time for either 
method, the GPS method provides better accuracy.

The Stratix switch is responsible for converting Network Time Protocol (NTP) to Precision Time 
Protocol (PTP). 

For more information on time synchronization and CIP Sync™, see the Deploying Scalable Time 
Distribution within a Converged Plantwide Ethernet Architecture design guide, 
publication ENET-TD016.

Considerations

Consider the following suggestions before starting this chapter:
• Decide which network time source, external NTP or GPS reference, that you’re going to 

use. 
• To enable CIP Sync functionality in a ControlLogix® controller, select Time 

Synchronization in Ethernet adapters by using Studio 5000 Logix Designer application.

Configure UTC Time Source UTC is independent of time zones and enables NTP to be used anywhere in the world 
regardless of time zone settings.

Operators and Engineering 
Workstations

External NTP
Time Server

NTP

Firewall

NTP

PDC
Emulator

Domain Controller

NTP/PTP clock 
mode internal in 
switch

NTP

PTP

NTP
 Application Servers

(Hypervisor)

https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td016_-en-p.pdf
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Configure Internet Time Synchronization

This section describes how to configure the Windows Time Service (w32Time) to use the 
Internet as a medium for sourcing a UTC time. Use the Windows time utility from an elevated 
command prompt.

Complete these steps by using the domain controller that is hosting the
PDC emulator role (PADCA).

1. Open an elevated Command session and click the Windows Key.
The Start Menu appears.

2. Choose Command Prompt (admin).
3. From within this Command session, type the following while substituting for the <pool> 

argument per your requirements:

w32tm /Config /ManualPeerList:<pool> /SyncFromFlags:Manual /Reliable:yes /Update

There are (at least) four server pools of pool.ntp.org. But, the preferred assignment for <pool> 
is the first one (us.pool.ntp.org,0x8). Windows Event Viewer can log errors for URLs that do not 
respond. 

The 0x8 qualifier specifies Client Mode packets for server communication. For more 
information, See Microsoft Knowledgebase article 875424, Time synchronization may not 
succeed when you try to synchronize with a non-Windows NTP server.

You can specify a list of URLs that are <space> separated and enclosed in quotes. Make sure 
to append a type identifier for the URLs identifier as shown in the previous table. For example, 
0x8 (client mode).

The illustration shows an example that sources the U.S. pool.

If your system can’t access the Internet, <pool> can be a single target such as your parent or 
local Domain controller. Your domain time might not be within tolerable differences of other 
domains in your enterprise.

IMPORTANT <pool> is a place holder for the URL or URLs of multiple time 
servers (for example, atomic clocks). If you can’t access the 
Internet, those URLs could be of your parent domain controller. 
You can research UTC sources for your proximity, the following 
table has examples that work for the U.S.

Example Purpose
us.pool.ntp.org,0x8 URL specifies a single server
0.us.pool.ntp.org,0x8
1.us.pool.ntp.org,0x8
1.us.pool.ntp.org,0x8
2.us.pool.ntp.org,0x8

URLs specify the use of 4 unique servers

Use a domain controller 
with these procedures.

PADCA

Example Purpose
. Uses the current computer (PADCA) as the time source
PADCA Specifies a network time server on your local network

https://learn.microsoft.com/en-us/troubleshoot/windows-server/welcome-windows-server
https://learn.microsoft.com/en-us/troubleshoot/windows-server/welcome-windows-server
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4. After you’ve commanded the w32tm utility by using the new configuration in step 3, use 
the Net utility to stop and then start the Windows Time Service from the same 
command session.

NTP to PTP Clock Conversion

This section illustrates how to configure a Stratix 5800 to convert Network Time Protocol 
(NTP) to Precision Time Protocol (PTP),

1. From the Device Manager of the switch, click Administration and
choose Time.

2. From the Mode pull-down, select NTP-PTP Clock.
3. Type a priority value for Priority1 and Priority2. 
4. Click Submit.
5.

Configure PTP Time 
Synchronization for 
Ethernet Bridges

Precision Time Protocol (PTP) enables precise synchronization of clocks in measurement and 
control systems. PTP generates a Master-Slave relationship among the clocks in the system. 
Clocks, which are synchronized over the EtherNet/IP network, derive their time from a clock 
that is selected as the Grandmaster clock. The Time Sync and Motion option must be enabled 
for Ethernet bridge modules to propagate time through the network via switches.

PROCES-RD100 contains the recommended topology and switch settings. 
Download the spreadsheet and use the tab that is referenced in each step.

Use an Engineering Workstation with 
these procedures.

EWS

https://literature.rockwellautomation.com/idc/groups/literature/documents/rd/proces-rd100_-en-p.xlsx
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1. Open your project in Logix Designer. On the General tab of the Module Properties dialog 
box, make sure that ‘Time Sync and Motion’ is selected for the connection. 

2. If online, select the Time Sync tab to confirm Grandmaster
clock settings.

Configure PTP Time Synchronization for Controllers

A Logix controller that is CIP Sync enabled and designated the Grandmaster clock is the real-
time source for the control system. The controller synchronizes with the PTP between the 
controllers and networks. Complete these steps.
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1. Using the Logix Designer application, click the Open Controller™ Properties symbol. 

The Controller Properties dialog box appears.

2. On the Date/Time tab, select Enable Time Synchronization.

3. Select Advanced.

IMPORTANT Use your local time to configure the Time Zone and Adjust for 
Daylight Saving.
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4. Select OK on the Controller Properties dialog box.

Network Device Library The Network Device Library is a tested, documented, and life cycle managed object library. 
The Device Library provides pre-configured status and diagnostic faceplates and AOI sets for 
Rockwell Automation® network devices.

The Network Device Objects may be used with Machine Builder, Process, and Packaged 
Libraries or as standalone components. Network Device Library addon instructions objects 
collect, process, and deliver data between hardware devices and application logic.

The Network Device Library includes Add-On Instructions (AOIs) and HMI Faceplates for Allen-
Bradley® Stratix® Switch products, Device-Level Ring (DLR) network monitoring and Parallel 
Redundancy Protocol (PRP) network monitoring.

For more information, see the Network Device Library reference manual, 
publication DEVICE-RM400.

The status ‘Is a synchronized slave’ appears 
when the controller is synchronized.

The Grandmaster clock reference can be confirmed.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/device-rm400_-en-p.pdf
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Notes:
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Process Controller Features
The process controller is a member of the Logix 5000® family that provides out-of-box 
process functionality. Embedded PlantPAx® instructions, graphical workflows, and tag-based 
alarms streamline code development for your system.

This chapter explains the process controller features that are central to a PlantPAx 
application. If you create a new application, see Use ACM to Create an Application. To modify 
an application, see Modifying an Existing PlantPAx System.

Prerequisites PlantPAx system release 5.0 added process controllers to the Logix 5000 family of controllers. 
The process controllers offer additional capabilities that are targeted for DCS applications.

For standard use information, see:
• ControlLogix 5580 and GuardLogix® 5580 Controllers,

publication 1756-UM543
• CompactLogix 5380 and Compact GuardLogix 5380 Controllers, publication 5069-UM001

To best use controller resources:
• Use periodic tasks only, with minimum number of tasks that are used to define 

execution speed, faster tasks getting higher priority (lower number).
• Use the raP_Dvc_LgxCPU_5X80 Add-On Instruction to monitor controller use.

For more information, see these additional resources.

EWS

Process 
Controller

Controller Catalog Numbers

ControlLogix® 5580 process controller
• 1756-L81EP
• 1756-L83EP
• 1756-L85EP

CompactLogix™ 5380 process controller • 5069-L320ERP
• 5069-L340ERP

Resource Description
High Availability Systems Reference Manual, 
HIGHAV-RM002

Provides guidelines for high availability systems, including redundant system components, networks, and other hardware 
and software considerations.

Rockwell Automation Library of Process 
Objects Reference Manual, publication 
PROCES-RM200

Describes how to build and use library components that comprise the Rockwell Automation Library of Process Objects.

Logix 5000 Controllers Produced and 
Consumed Tags, publication 1756-PM011 Details how, with a Logix 5000 controller, to produce and consume standard tags and produce a large array.

Logix 5000 Controllers Import/Export 
Programming Manual, publication 1756-PM019 Describes how to import and export logic components to and from a controller project.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/highav-rm002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/pm/1756-pm011_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/pm/1756-pm019_-en-p.pdf
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PlantPAx Process Objects Process controllers support an exclusive set of embedded PlantPAx instructions.

The PlantPAx instructions offer enhanced functionality, including tag-based alarms, that can 
reduce the number of steps to configure control strategies. For more information about the 
instructions, see:

• Studio 5000 Logix Designer® online help
• Logix 5000 Advanced Process Control and Drives and Equipment Phase and Sequence 

Instructions Reference Manual, 1756-RM006

Each PlantPAx instruction features an intuitive design-time configuration interface. It’s based 
on the SAMA (Scientific Apparatus Makers Association) diagram interface, which focuses on 
the flow of information.

The example shows the PAI - Process Analog Input Object.

This interface improves upon prior releases of the process library, in where the underlying 
elements of an Add-On Instruction can be viewed but do not illustrate how it functions.

The blue animation line adjusts depending on the instruction execution. In the previous 
example, see the Maintenance substitution option. If you select ‘Use substitute PV,’ the blue 
animation line shows a new execution path.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/1756-rm006_-en-p.pdf
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Import Add-On Instructions

There are additional libraries of Add-On Instructions that you can use to supplement the 
PlantPAx embedded instructions. Studio 5000 Logix Designer can import a single Add-On 
Instruction or a Program/Routine containing multiple Add-On Instructions, such as a control 
strategy generated with ACM software.

Add-On Instructions are used when the following functionality is required:

Configure Controller 
Properties

Use Studio5000 Logix Designer application to configure the controller.
1. From the Controller Properties dialog box, click the PlantPAx tab.

2. If you’re using a process controller, leave the check for Use PlantPAx Tasking Model box 
(checked by default).

3. Click the Date/Time tab and check the Enable Time
Synchronization box.

4. Enable Automatic Diagnostics on the Advanced tab.
Automatic Diagnostics is a mechanism to detect and present device descriptive 
events with no programming required. Diagnostics based on the device definition 
(such as fault or open wire) are sent to the HMI and displayed on the Automatic 
Diagnostic Event Summary object.

Feature Description

Organization, ownership, and arbitration
• Allows the organization of devices into groups from HMI
• Manages and prioritizes ownership of equipment groups
• Propagates command and status through equipment groups

Process Instructions from prior libraries Non-process controllers use the Add-On Instructions from the process library, release 4.1 or earlier

Device Add-On Instructions for supported network 
devices

The purpose of device Add-On Instructions is to reshape the data structure of similar but disparate 
equipment to a common structure that can be used by a single common PlantPAx instruction.
For example, a device Add-On Instruction for a Variable Speed Drive (VSD) is used to reshape the disparate 
VSD source data so that a common PlantPAx instruction (PVSD) can also mean that a common control 
strategy can be used to control all those same VSDs
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PlantPAx Task Model

The Task folder contains a project structure that consists of four pre-defined periodic tasks. 

Logic is placed in the appropriate task to verify that it meets the process requirements. These 
tasks are:

• Fast (100 ms) – For control fast loops, such as liquid pressure with related transmitters 
and pump drives

• Normal (250 ms) – For discrete control, such as motors, pumps, and valves
• Slow (500 ms) – For level, temperature, analysis loops, phases, and batch sequencing
• System (1000 ms) – For slow change temperature control and general controller 

operations, such as messaging or status

The ControlLogix 5580 and CompactLogix 5380 controllers (including the process controllers) 
have simplified task management from previous controllers. The controller runs control, 
communication, and packet processing on separate cores within the controller. You no longer 
have to reserve CPU time for communication or overhead.

Create the Logical Organizer

The Logical Organizer is a graphical representation of the organization of the configuration 
logic that is aligned to the process being controlled, called the logic model. It enables you to 
create and organize hierarchies of the programs and folders in your project, independent of 
the execution model. 

A process controller contains tasks that execute at various rates. Each task contains 
programs of code that is required to execute at the selected task’s rate of execution. The 
Logical Organizer helps create an understandable organization, based on process functional 
requirements.

• Server-based alarms and Logix tag-based alarms are often based on area organization 
within the Logical Organizer and built using the PlantPAx configuration tool. 

• Organize batch applications following the ISA-S88 physical model.

This example shows the same controller project that is viewed from the Controller Organizer 
and its associated Logical Organizer. The Controller Organizer is used to ensure that the logic 
is executed at a rate suitable for the process. The Logical Organizer can be used to create 
folders aligned with the application (a folder for each HMI display) and allows dragging the 
associated programs into the appropriate folders. This enables accurate alarm rollups and 

IMPORTANT Several components in a PlantPAx system depend on the 
organization and hierarchy of the system:
• HMI application
• Alarms
• User roles and responsibility
• Security
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breadcrumbs on the Navigation bars to assist the operator in troubleshooting abnormal 
conditions. (See PROCES-RM200 Chapters 2 and 3 for more detail).

Add Modules and Devices to the Controller Organizer

All Logix 5000 controllers require module connections (analog, communication, digital, 
specialty) to be defined in the I/O Configuration list.

Follow these guidelines for I/O module properties in a PlantPAx system.
Table 6 - Guidelines for Module Configuration

Item Description

Electronic keying

Electronic Keying reduces the possibility that you use the wrong device in a control system. It compares the 
device that is defined in your project to the installed device. If keying fails, a fault occurs.
• Use Exact Match for keying in a validated environment. This makes sure that only the same series and 

revision device can be used.
• Use Compatible Module for keying in environments where a newer series or revision device can be used 

without requiring changes to the definition.
For more detailed information on Electronic Keying, see Electronic Keying in Logix 5000 Control Systems 
Application Technique, publication LOGIXAT001.

Requested Packet Interval (RPI)

 The RPI value is the rate at which the controller attempts to communicate with the module. RPI is often 
defined by the inherent properties of the signal being measured. For example, a temperature measurement 
changes slower than pressure, so a larger RPI could be used to a device that measures the temperature.
We recommend that you specify an RPI that is two times faster than task period. For example:
• A device that is used within a 250 ms task requires a 125 ms RPI.
• A device that is used within a 100 ms task requires a 50 ms RPI.
Use NONE for the Connection Format to remote communication modules used as bridged adapters.
For modules that support Precision Time Protocol (PTP) synchronization, it’s recommended to use Time 
Sync
and Motion.

Connection tab options
• If inhibited, the controller does not attempt to make a connection. This is used as placeholder for a 

device that is not yet implemented or installed.
• Major Fault On Controller If Connection Fails While in Run Mode. This is used on critical connections, 

where controller execution can’t continue if a problem is detected.

Integrated HART device connection

Compact 5000, FLEX 5000®, and FLEXHA 5000™ I/O HART modules support two device connections types. 
The PlantPAx data format is recommended and is pre-defined for the PAH instruction.
• PlantPAx Data: Input data includes basic input from the HART device that is used by PlantPAx for the four 

dynamic variables and semi static data. Also includes the configured device variables and commands.
• Data: Input data includes basic input from the HART device for the dynamic and device variables that are 

configured plus the configured commands.
Concurrent Communications with FLEXHA 5000 I/O Concurrent communications require a dedicated 1756-EN4TR. 

https://literature.rockwellautomation.com/idc/groups/literature/documents/at/logix-at001_-en-p.pdf
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Integrated HART Configuration

HART integration lets you directly add field devices to the I/O Configuration list.

Configure the variables and commands for the HART devices within the Module Definition. You 
can add HART EDD files if additional device descriptions are required. See the appropriate 
manufacturer for these files. 

The PlantPAx Data connection creates a PAX_HART_DEVICE:I:0 structure that is formatted for 
direct use in the Process Analog HART (PAH) 
instruction.
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Concurrent Communication Module Configuration

FLEXHA 5000 I/O requires concurrent communications. To use concurrent communication 
with FLEXHA 5000 I/O modules, you must configure the 1756-EN4TR EtherNet/IP™ 
communication module on the Device Definition dialog box in your Studio 5000 Logix Designer 
application project to use concurrent communication.

Controller-to-Controller 
Communication

There are two main options to communicate among controllers:

For more information on controller communication options, see Logix 5000 Controllers Design 
Considerations Manual, publication 1756-RM094.

IMPORTANT You can configure the 1756-EN4TR EtherNet/IP communication module 
for concurrent communications, to use with I/O modules such as 
FLEXHA 5000 I/O modules. Or you can configure the 1756-EN4TR 
EtherNet/IP communication module for standard I/O, for example, 
remote 1756 ControlLogix I/O modules. You can only configure the 
module for one or the other.
If the 1756-EN4TR EtherNet/IP communication module is configured for 
concurrent communication, you can still use it for class 3 
communications, for example, HMI, program upload/download/monitor.

Produced and Consumed Tag Message (MSG) Instruction
Consumed tag data is automatically received from a producer controller, at a 
requested packet interval (RPI), without the need for logic programming.

Read or Write messages are programmatically initiated on condition (False to True 
transition).

Ideal for exchanging critical data that changes frequently; use for higher 
priority communication.

Ideal for exchanging non-critical data that changes less frequently; use for lower priority 
communication.

Data is constantly sent regardless of change of state. This does not impact the 
scan of the controller, but it can impact network bandwidth.

Communication and network resources that are used when needed only, however, a 
delay can occur if controller resources aren’t available when needed.

Tag size is limited to 500 bytes over the backplane and 480 bytes over a 
network. Supports larger data payloads, up to 32,767 elements, using multiple data packets.

Supports tags of mixed data types (UDT). CIP™ Generic messages to third-party devices.
You can’t modify or create produced/consumed tags online in Run mode. You can modify and create MSG instruction online in Run mode.
Routing of traffic across subnets depends upon the transmission type (Unicast 
or Multicast). Message traffic can be routed across subnets and across slots of a 1756 chassis.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/1756-rm094_-en-p.pdf
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Configure Produced and 
Consumed Tags

Group produced and consumed tags as members in user-defined structures. This technique 
helps monitor connection status between controllers without increasing execution time, such 
as using a GSV instruction to detect status.

1. In the Logix Designer application, define a user-defined structure of a tag to be used in 
all controllers.

2. Name the first member Status and a data type of CONNECTION_STATUS. 
This data type provides two BOOL bits (RunMode & ConnectionFaulted) in the Status 
member for each controller consuming the tag. 
MyTag.Connection_Status.RunMode

- Value of 1 when Producer is in Run mode.
- Value of 0 when Producer is in Program mode.

MyTag.Connection_Status.ConnectionFaulted
- Value of 0 when Producer connection is good, regardless of mode.
- Value of 1 when Producer Connection is broken.

3. Once the UDT is finished, create a tag of that UDT type to be either Produced or 
Consumed. 

4. It’s recommended to add a common prefix to each tag instance of the UDT, so you more 
easily search for those tags.

5. Create a Produced tag by simply changing the tag property from base to produced and 
setting the max number of consumers. 

6. Create a Consumed tag by changing the tag property from base to consumed. The 
Producer controller is selected from the I/O configuration list and the remote data 
(exact name of produced tag) is entered. 

7. Select the RPI rate in which the produce tag is consumed.
For bidirectional P/C tags between two controllers, both consuming controllers have 
each producer controller in its I/O configuration list. Multiple consumers can receive 
the same data from a single producer.

Data arrives asynchronous to program scan. Some applications may require a 
programmatic handshake. Buffering data to or from P/C tags helps to make sure 
that the user logic executes on that same data before it changes.

IMPORTANT When adding the Producer controller to the I/O configuration list 
of the Consumer controller, the firmware revision does not have 
to match. However, the rack size and slot number must be 
correct.
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8. Create logic that writes values to the Produce tag elements.

9. Add corresponding consume tags to each controller that consumes
the data. 

Note that UDT structures can be exported to. L5X format and imported into the other 
controllers.

10. Use Consume tag elements to write to variables in the Consuming controller.

PlantPAx Guidelines for Produced and Consumed Tags
• Produced and consumed (P/C) tags can be a single tag structure or a user-defined 

structure (UDT) of mixed data types. For example, a UDT tag can contain members up to 
120 REALs or 100 REALs and 640 BOOLs.

• Group data in produced and consumed tags into a UDT to reduce the total number of 
connections.

• Make the first member of the UDT a data type of CONNECTION_STATUS for connection 
status.

• Export/Import the same P/C UDT data type among controllers to confirm they match 
exactly.

• Make sure the number of consumers configured, for a produced tag, is the actual 
number of controllers consuming it to reduce the number of connections to the 
controller.

• Always use a handshake when transferring data between controllers through health 
data or manually configured diagnostic.
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• We recommend unicast traffic when possible, because it transmits only to an intended 
destination, which reduces bandwidth. However, redundant controllers require 
multicast traffic to consume data.

PlantPAx Guidelines for 
Message Instructions

The MSG instruction asynchronously reads or writes a block of data to another module on a 
network.

• ControlLogix 5580 and CompactLogix 5380 support up to 256 connections. If you want 
to enable more than 256 MSGs at one time, use some type of management strategy.

• Use the cached option when the message connection needs to
be maintained.

• Use message Reads, instead of Writes. This makes it easier to troubleshoot code by 
knowing where the incoming data is coming from.

• When messaging between Logix 5000 controllers, use a DINT data type where possible 
for maximum efficiency.

• Use MSG status flags, such as the. DN and .ER bits for handling
fault conditions.

• Data arrives asynchronous to program scan (use a programmatic handshake or insert 
between a UID/UIE instruction pair for higher priority)

• Use the unconnected option for CIP Generic messages

OPC UA Simplex Process controllers now support OPC UA via the embedded Ethernet ports. The 
controller can act as either an OPC UA server or client. The PlantPAx Process controllers 
support the following number of OPC UA nodes:

• 5069-L320ERP: 300 OPC UA nodes
• 5069-L340ERP: 600 OPC UA nodes
• 1756-L81EP: 0 (zero) OPC UA nodes
• 1756-L83EP: 1200 OPC UA nodes
• 1756-L85EP: 15,000 OPC UA nodes

No more than 50,000 nodes/sec of OPC UA data when a controller is acting as an OPC UA 
server in a PlantPAx system. Additionally, only OPC UA data should utilize the embedded port on 
5580 controllers in a PlantPAx system. All other data (HMI, I/O) should use an in-chassis 
communication module such as the 1756-EN4TR.

Diagnostic data regarding the OPC UA server can be monitored via the controller webpage. By 
default, the controller webpage is disabled. The controller webpage can be enabled in Studio 
5000 Logix Designer. Navigate to the Security tab within the Controller Properties and check 
the option “Enable Controller Web Pages”.

For more information on how to configure OPC UA on a Process Controller, see KnowledgeBase 
article OPC UA in 5580 and 5380 Logix Controllers 36 firmware ToC and OPC UA in 5580 and 
5380 Controllers, publication 1756-UM023.

Integrate Field Devices PlantPAx systems use specialized field devices that operate on various communication 
protocols, such as HART, EtherNet/IP™, PROFIBUS PA, and Foundation Fieldbus.

Depending on the controller type and process library version, you need different elements to 
integrate a field device. These elements use the Logix Designer application for device control 
to the corresponding object in FactoryTalk® View SE for HMI faceplates.

Most field device integrations require that you instantiate one Add-On module Profile (AOP) and 
two Add-On Instructions (AOI) per device for end-to-end control and monitoring.

• Module or Device-specific AOP for the Logix Designer application to create the item or 
device tags in the I/O Configuration list.

• Device-specific Add-On Instruction to access device tags and prepare the data for use 
within the controller project.

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1141548
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1756-um023_-en-p.pdf


Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 111

Chapter 5          Process Controller Features

• Generic Add-On Instruction to access device data, along with custom-made device 
diagnostics and unit tables, to enable visibility on an HMI faceplate within the PlantPAx 
system.

HART Integration

Highly integrated HART provides a PlantPAx data type in the process controller:
• See Integrate Endress+Hauser Instruments in a PlantPAx Distributed Control System, 

publication PROCES-SG003 for more information.
• Configuration of devices within the I/O Configuration tree (no Add-On Instruction 

needed). See section “5094-IF8IH to PAH Configuration Example” in publication PROCES-
RM200 for more information.

• Device diagnostics automatically propagate to the controller project

PROFIBUS PA Integration

See Profibus PA and FOUNDATION Fieldbus Linking Devices in a PlantPAx Distributed Control 
System, publication PROCES-RM213 for more information about integrating PROFIBUS PA 
devices.

FOUNDATION Fieldbus Integration 

See Profibus PA and FOUNDATION Fieldbus Linking Devices in a PlantPAx Distributed Control 
System, publication PROCES-RM213 for more information about integrating FOUNDATION 
Fieldbus devices.

Electrical Protection Devices Integration (IEC 61850)

See Rockwell Automation Library of Intelligent Electronic Devices, publication PROCES-RM211 
for more information about integrating electrical protection devices (IEC 61850).

Alarm Types Alarms are a critical function of a distributed control system. Alarms monitor conditions that 
need response, such as a temperature or pressure signal out of range, or device failures such 
as drives and motors.

The FactoryTalk® Alarms and Events server provides a common, consistent view of alarms and 
events throughout a PlantPAx system. Language-switching alarm messages are also available. 
When an alarm condition is received, the FTAE server publishes the information to a 
subscribing Operator workstation via FactoryTalk Alarm and Event services.

• For information on how to configure the FTAE server on a PASS, see Chapter 3, Process 
Automation System Server.

• For information on how to configure and monitor FTAE alarm components, see the 
FactoryTalk Alarms and Events System Configuration Guide, publication FTAE-RM001.

The Alarm Banner resides on the Header display.

An effective alarm system directs the attention of an operator to improve the productivity, 
safety, and environment of a process plant. 

• A PlantPAx system can use device-level and server-level alarm methods.
• Recommendations are based on the controller type and supported functionality.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm211_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/ftae-rm001_-en-e.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm213_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm213_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/sg/proces-sg003_-en-p.pdf
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Guidelines for Logix Tag-based Alarms

In a PlantPAx 5.0 or later system, we recommend no more than 7500 in-use Logix tag-based 
alarms per controller.

Create Logix tag-based alarms to send alerts about specific events or conditions. A tag-based 
alarm is similar to a digital alarm because both monitor a tag value to determine an alarm 
condition. However, a tag-based alarm isn’t part of the logic program and does not increase 
the scan time for a project.

Tag-based alarms do not require an FTAE server. A controller's subscription to the HMI can be 
serviced using a FactoryTalk® Linx data server. See Add a Data Server (FactoryTalk Linx) on 
page 57 to confirm that FactoryTalk® Linx is configured for Logix Tag-based alarms. PlantPAx 
recommends a limit of 15,000 Logix Tag-based alarms per instance of FactoryTalk Linx. A PASS 
can host up to two instances of FactoryTalk Linx for a total of 30,000 Logix Tag-based alarms 
per PASS.

An alarm definition is associated with an Add-On Instruction (AOI) or a defined data type. When 
a tag is created using a data type or an AOI that has alarm definitions, alarms are created 
automatically based on the alarm definitions.

Embedded Tag-based Alarms in PlantPAx Instructions

The PlantPAx instructions have embedded tag-based alarms. Configure the states as needed 
and simply enable the alarms that you want to use.

Table 7 - Alarm Types Based on Instructions and Add-On Instructions

If You Have You Have This Alarm Type Description

PlantPAx 5.0 library Logix Tag-based

Device level, tag-based alarms monitor a tag value to determine the alarm condition. Tag-based 
alarms aren’t part of the logic program and do not increase the scan time for a project. The controller 
caches information, such as time stamps, alarm states, and associated tag values in a 1000 KB buffer. 
The controller transmits the information to subscribing FactoryTalk® Alarms and Event servers.
Recommended: PlantPAx system release 5.0 or later.
Requires: ControlLogix 5580 controller, CompactLogix 5380 controller.

PlantPAx 4.1 library or earlier Server Tag-based

A FactoryTalk Alarm and Event server monitors controllers for alarm conditions through data servers 
and publishes event information that can be displayed and logged.
Recommended: PlantPAx system release 4.6 and earlier.
Server-based alarm monitoring offers the equivalent of HMI tag alarm monitoring, but with an 
expanded feature set of the FactoryTalk Alarm and Event server.

ALMA or ALMD controller instructions Logix Instruction-based

These device-level alarm instructions can consume a larger portion of controller memory and 
increase scan time when executed. When an alarm is detected, it’s time stamped and buffered until 
it’s transmitted to subscribing FactoryTalk Alarms and Events servers.
Not Recommended in large deployments due to added controller overhead.
Requires: ControlLogix 5570, CompactLogix 5370, ControlLogix 5580, CompactLogix 5380 controller.
Device level, Logix instruction-based alarms are programmed within the controller program and 
integrated to the FactoryTalk Alarm and Event server.
• The Digital Alarm (ALMD) instruction detects alarms that are based on Boolean (true/false) 

conditions.
• The Analog Alarm (ALMA) instruction detects alarms that are based on the level or rate of change of 

analog values.
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Use the Alarms tab on the instruction properties to assign settings to all pre-defined alarms. 
There’s an option to propagate specified Class/Group settings to all alarms in the instruction.

Alarm settings are also accessible via the Alarm Manager.

Guidelines for Server Tag-based Alarms (FactoryTalk Alarms 
and Events)

An FTAE server is required for server tag-based alarms. The server puts these alarm tags on 
scan, just as it does all other tags it polls for the HMI and Historian. In a PlantPAx 5.0 or later 
system, we recommend you limit the number of server tag-based alarms to 20,000 per FTAE 
Server. A PASS can host a single instance of the FTAE server for Server tag-based alarms. There 
are no hard-coded limitations, however you could experience longer recovery time during 
system restoration if you exceed the recommendation.

Use the PlantPAx System Estimator (PSE) for sizing the number of alarm instructions for a 
more accurate limit that is based on your specific configuration. Be sure to add additional 
memory that is required to maintain the alarm subscription as it isn’t accounted for in the PSE 
memory calculations.

• Use alarm groups to organize alarms by operator role.
• Use alarm expressions against user groups to provide rolled up indication of alarms by 

role or display. For example, AE_InAlmUnackCount('T1*') returns a count of 
unacknowledged alarms within groups that start with T1.

For more information on alarm expressions, see the FactoryTalk View Site Edition 
User's Guide, publication VIEWSE-UM006.

• Use an alarm class to identify alarms that share common management requirements 
(for example, testing, training, monitoring, and audit requirements). Do not use alarm 
class to identify alarms by operator role or display because you can’t retrieve an alarm 
count by class by using alarm expressions in FactoryTalk® View software. However, you 
can filter by class on the alarm displays.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/viewse-um006_-en-e.pdf
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• Use the alarm builder feature in the PlantPAx Configuration Tool to help build server 
tag-based alarms.

Guidelines for Logix Instruction-based Alarms

The process library does not provide support for Logix instruction-based alarms. Note that the 
instruction-based alarms can impact controller performance.

Controller scan time and memory usage are variable with the use of the ALMA or ALMD 
instructions, depending on the states of the controller. Large alarm bursts can have a 
significant impact on controller CPU utilization. For example: Controller memory used for 
buffering by each subscriber (topic in the data server) = 100 KB.

Example execution times:
- ALMD in a 1756-L73 controller with no alarm state changes: 7 µs
- ALMD in a 1756-L73 controller with alarm state changes: 16 µs

In redundant controller configurations, cross loading of redundancy can add up to 70 µs per 
ALMD instruction.

Reserve the use of ALMA and ALMD instructions for the most critical alarms. Although there are 
no hard-coded limitations, we recommend limiting the number of instructions to the following:

- 250 per redundant controller
- 2000 per simplex controller

Monitor Alarms

You can use the alarm status explorer in FactoryTalk View SE to browse all of your configured 
alarms on a server or the entire system. Alarms also are filtered by the Shelved, Suppressed, 
and Disabled options. The alarm explorer can be preconfigured as a Shelved alarm display to 
let operators view a list of shelved alarms. 

ANSI/ISA-18.2 provides alarm performance metrics and recommended target values. Some key 
metrics include the following:

• Alarm rates: annunciated alarms per operator console:
- Average of 6…12 per hour
- Average 1…2 per 10 minutes

• Contribution of the top 10 most frequent alarms to the overall alarm load: ~<1…5% 
maximum, with action plans to address deficiencies

• Less than 5 stale alarms (remains annunciated for an extended period, such as 24 
hours) present on any day with action plans to address
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Use the Process System Estimator to Plan Alarms

Process System Estimator - Summary

1 3
4
5
6

2

Item Description
1 Select the top of the project tree to view the system summary.
2 Select to view some of the system limits.
3 System Summary

4
Total number of Server Tag-Based FactoryTalk Alarm and Event servers.
Note: These servers support controllers that utilize the PlantPAx Process Object Library 4.1 and 
earlier.

5 The total number of Server Tag-Based Alarms.
6 The total number of Logix Tag-Based Alarms.
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Process System Estimator - FactoryTalk Alarms and Events Limits

1

2
3
4
5

6

7
8

Item Description
1 The maximum number of Data and Alarm Servers (Server Tag-Based) in the project.

2
Total number of FTAE Alarms allowed in the system.
Note: The total Server Tag-Based Alarms plus the total Logix Tag-Based Alarms must be less 
than this value.

3
Total number of FTAE Alarms allowed in per PASS server.
Note: The total Server Tag-Based Alarms plus the total Logix Tag-Based Alarms supported by 
any individual PASS must be less than this value.

4 The maximum Server Tag-Based Alarms that an individual PASS can support.

5 The maximum Logix Tag-Based Alarms that an instance of FactoryTalk Linx data server can 
support. A single PASS can host up to two data servers.

6 The average number of backing taqgs that are configured for Server Tag-Based Alarms. This 
field only applies to Server Tag-Based Alarms.

7 Maximum number of Logix Tag-Based Alarms. (CompactLogix)
8 Maximum number of Logix Tag-Based Alarms. (ControlLogix)
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Process System Estimator - PASS Alarms

Process System Estimator - Non-Process Controller

1

3
4

2

Item Description
1 Select to view the alarm information for the PASS.

2

PASS-specific configuration information for the Server Tag-Based Alarm server. This is the 
configurable percent of Server Tag-Based Alarms that will be used for each controller under 
this PASS.
Note: You can also add additional alarms in the server that are beyond what is calculated. The 
default is zero. When using the latest library and Process Controllers, the section in the red box 
does not appear as it does not apply.

3 Total number of Server Tag-Based Alarms for this PASS.
4 Total number of Logix Tag-Based Alarms for this PASS.

1

2
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Process System Estimator - Process Controller

Security Considerations PlantPAx provides options you can use to make your controller more secure. For controller 
security options, see:

• ControlLogix 5580 and GuardLogix 5580 Controllers,
publication 1756-UM543

• CompactLogix 5380 and Compact GuardLogix 5380 Controllers, publication 5069-UM001

For runtime security, See Configure Runtime Security on page 66

For general system security (domain controller, FT Security), See Domain or Workgroup on 
page 23

A PlantPAx reference architecture has been certified for the IEC-62443-3-3 SL1 requirements. 
When certification is necessary, designing and implementing a similar architecture can 
improve the certification process timing. See PlantPAx Security Certification on page 239.

Create HMI Displays The Process Automation System Server (PASS) is a required system element for the PlantPAx 
system. The PASS hosts the HMI server, which stores the HMI project components, such as graphic 
displays, and provides these components to an Operator Workstations (OWS) client upon request.

For more information on how to configure these servers, see Chapter 3, Process Automation 
System Server.

Item Description

1 This non-Process controller uses PlantPAx Process Object Library 4.1.
Note: Since this controller is using Process Object Library 4.1, it uses Server Tag-Based alarms.

2
Potential Server Tag-Based Alarms. 
We know that 30 percent of these alarms are used (See Process System Estimator - PASS Alarms 
on page 117.) therefore, the actual load on the server for this specific controller will be: 
2940 alarms x 30% = 882 alarms.

1

2

3

Item Description
1 This Process controller uses PlantPAx Process Object Library 5.0 and later.

2 The calculated Potential Logix Alarms in the controller based on the configured I/O or control 
strategy counts.

3 Configured Logix alarms once multiplied by the user indicated percentage. In this example, 50%.
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Follow these guidelines:
• Use FactoryTalk® View Studio software on the EWS to access the application.
• Configure the FactoryTalk View SE servers to start automatically on startup on the 

PASS. Let the servers fully start up before starting the client computers.
• FactoryTalk View SE displays contain expressions for each customized animation that 

holds simple or complex calculations to accomplish the animations. Each expression 
consumes memory and requires processing time to execute. Too many expressions can 
make the screen animate sluggishly and affect system performance.

•  Use global objects to display the status of a control module or device when the 
information to be displayed is stored in a tag structure within Logix (for example, UDT 
or Add-On Instruction) and there are many identical instances. A global object is a 
display element that is created once and can be referenced multiple times on multiple 
displays in an application. When changes are made to the original (base) object, the 
instantiated copies (reference objects) are automatically updated. 
- Base global objects are stored in FactoryTalk View in displays (.ggfx files). If you have 

a large number of base global objects defined, do not put them all in a single display. 
Limit the number of global object instances on a single display to 60 or less.

- As global objects can be instantiated multiple times, the performance impact of their 
design is amplified by their number of instances. Therefore, design global objects 
carefully to reduce the number of objects, expressions, and animations that are used 
within the base object.

• Use ‘Replace’ display types. This display type closes the currently displayed screen 
when a new screen opens. ‘Overlay’ display types must be managed because multiple 
screens open at once consumes memory and CPU resources.

• Only use Cache After Displaying and Always Updating for displays frequently accessed 
by the operator and not applied generally. Used sparingly on these displays, these 
settings improve display call-up time for important displays. When displays are cached 
and always updating, the additional memory load of this display on the view client is 
persistent after call-up regardless of whether the display remains visible. This action 
affects system load and can affect system performance.

• We do not recommend the use of data logs. If necessary, use data logs for short-term 
data retention only.

• Do not create derived tags that depend on the results of other derived tags. Derived tag 
processing is not sequential.

• Avoid use of VBA when possible. VBA runs as a single-threaded process so it’s possible 
the application that is written in VB does not allow the HMI to perform predictably.

Use FactoryTalk View Studio software to create or import any system-specific graphic 
displays that your PlantPAx system requires.

For PlantPAx common graphics, you can use ACM-generated displays or graphic framework 
displays (from the process library).

Graphic Framework Displays

For more information on how to develop graphic framework displays, see the Rockwell 
Automation Library of Process Objects Reference Manual, publication PROCES-RM200.

Optimize Runtime Performance

PlantPAx guidelines recommend using global objects to display the status of a control module 
or device when there are multiple, identical instances. Global objects offer consistency; and 
changes to a global object propagate to all the affected displays.

FactoryTalk View Studio has an Enable Global Object Runtime Optimization feature that 
improves runtime performance.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
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1. After you modify graphics that contain global objects, select Global Object Compilation 
Required

2. Select Compile Global Objects to optimize the changes for the runtime system.

The first time that you compile global objects, the process can take an extended amount of 
time, depending on the number of displays in the application. Subsequent compiles require 
less time as they only process changes to displays.

Optimize HMI Redundancy

For HMI redundancy, change these settings to optimize the failover speed to achieve proper 
visibility on the HMI clients. 

1. In FactoryTalk View Studio, go to System > Policies > System Policies and select Health 
Monitoring Policy.

2. Change the following settings:
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- Network failure detection interval: From 2 seconds to 1 
- Maximum network glitch: From 5 seconds to 1 second
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Notes:
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Use ACM to Create an Application
Studio 5000® Application Code Manager is a tool that enables more efficient project 
development with libraries of reusable code. This software enables more efficient project 
development with bulk configuration of highly reusable libraries of code. Reclaim some of your 
valuable time by leveraging this tool to streamline design and achieve faster commissioning.

Modularity in your projects means that they are repeatable, supportable, and consistent. 
Whether you are using the Rockwell Automation application libraries or creating your own, 
Studio 5000 Application Code Manager software allows you to manage and rapidly deploy 
projects across your organization. Additionally, you can drive standardization across your 
teams by using library objects that are consistent no matter who does the programming.

See PROCES-RM201 for more details on using the Control Strategies.

Prerequisites Following the System Workflow, develop your process application, including graphical displays 
and controller logic. To develop your controller program, you must be familiar with how to do 
the following:

1. Gather system requirements, such as:
- User requirement specifications
- Instrument index or database
- P&ID diagrams
- Network architecture requirements
- I/O requirements
- Produced/consume and message requirements
- Product specifications

2. Use the PlantPAx® System Estimator tool that comes with Integrated Architecture® 
Builder utility, to:
- Size your PlantPAx system
- Generate a bill of materials

3. Build your PlantPAx system:
- Install and configure process controllers (recommended)
- Make sure that the HMI server and requirements are configured (required)

For more information, see these additional resources.

Resource Description
Rockwell Automation Library of Process 
Objects Reference Manual, publication 
PROCES-RM200

Describes how to build and use library components that comprise the Rockwell Automation Library of Process Objects.

Application Code Manager User Manual, 
publication LOGIX-UM003

Provides details on a modular, object-based approach to the creation of ACD controller code, FactoryTalk® View SE /ME 
display content, FactoryTalk® Historian Tag and FactoryTalk® Alarms and Events (FTAE) import configuration.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm201_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/logix-um003_-en-p.pdf
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Develop a Project Plan Based on the system requirements and PSE results, start by planning the scope of the process 
application. Use a spreadsheet or other tracking tool to define the details for each controller in 
the project, such as:

• Controller name
• Task name
• Program name
• Description
• I/O type
• Control strategy name
• Minimum and maximum values and units of measure
• Alarm values (LoLo, Low, High, and HiHi)
• HMI display name

This level of detail helps you organize the actual programs and tasks in the application. For 
example:

Determine Which Libraries to Use

Rockwell Automation provides libraries to simplify application development.  
Table 8 - Library Descriptions

Item Description

Process Library

Rockwell Automation Library of Process Objects provides sample projects, application templates, Endress + Hauser library objects, 
Application Code Manager library objects, and tools and utilities. 
Includes the following:
• Graphics for built-in instructions
• HMI images and Help files
• Logix diagnostic objects
• Process objects
• Control strategies
• Sequencer object
• PlantPAx Configuration Tools for Tags, Alarms, and Historian
• Color Change utility
• Historian -- Asset Framework template and objects

I/O Device Library
Provides objects for Rockwell Automation 1756, 1769, 1734, 1794, 1738, 1732E, 1719, 5015, 5069, 5094 I/O modules.
Provides preconfigured status and diagnostic faceplates sets for Rockwell Automation digital and analog I/O devices. You can use 
these objects with Machine Builder, Process, and Packaged Libraries, or as standalone components.

IO-Link Device Library Provides IO-Link master and sensor objects.
Provides preconfigured status and diagnostic faceplates.

Machine Builder Libraries

Library objects for use with Application Code Manager.
• Independent Cart Technology Libraries, includes ICT Libraries for iTRAK® and MagneMotion®
• Studio 5000® Application Code Manager
• Power Device Library, including objects for E300, ArmorStart®, PowerFlex®, and Kinetix®

Network Device Library Provides objects for Stratix® switch, Parallel Redundancy Protocol (PRP) network objects, and Device Level Ring (DLR) network objects. 
Power Device Library Provides objects for E300, ArmorStart, SMC™-50, PowerFlex, and Kinetix.
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Develop an Example 
Application

In this example you will create a process application to allow flow in and out of a tank. You will 
also monitor the tank level and control a motor to pump out of the tank. The system design is 
based on this drawing. We will start with a simple tank configuration and then show how that 
can be used to complete a bulk configuration file to be used in larger deployments.

The following information is required as part of the project plan.
• Controller name - (CLX)
• Task name - (Normal)
• Program name - (Tanks)
• Description - (Process_Example)
• I/O type - 5 “Use Program Connections” (recommended)
• Control strategy names – (LI100, XV100 & XV101, MT100)
• Minimum and maximum values and units of measure - (example: 0-100)
• Alarm values (LoLo, Low, High, and HiHi) - (example: 1,10,90,99)
• HMI display name - (Tank1...)

Create the Example Project Create a New Project
1. Launch the ACM software
2. Create a project using the File> New > Project option from the top menu.

3. Select (RA-LIB) Process 5 Project and select Next.
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4. Enter a new project name. Throughout this example, we use Process_Example. Name 
the project and configure if the control strategies should be coded in function block or 
ladder Logic. The project has a parameter to configure code type for each control 
strategy, so a mix of function block and ladder is supported in the project. All control 
strategies of a given type added to the project will follow this code type selection in the 
resulting ACD file. 

If 'Ladder Logic' is selected on any of the parameters, the Ladder_Routine_Selection 
parameter becomes visible. Select if the ladder-based control modules will all be 
created in one or multiple routines using this parameter. This determines the code 
structure for all ladder-based PlantPAx Control Modules that are created in this 
project.

Select Finish and your project will be created.

Add System References

Application Code Manager provides capability to generate content for PlantPAx system 
elements associated with the HMI, Historian, and Batch. For example, ACM can generate tags 
for FactoryTalk Historian SE and HMI graphics for FactoryTalk View SE HMI displays. This 
section adds system server references and create a display for the tank graphics.

1. In System View, expand Historian and right-click ScanClass then select Add.
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2. Select (RA-LIB) Process 5 HistorianSE and select Next.

3. Select Next to view the Point Types. The defaults are sufficient for this example. Select 
Finish.

4. In System View, expand HMI and right click Displays then select Add.

5. Select (RA-LIB) Process 5 HMI and select Next.

6. In the Object Configuration Wizard, use the parameters list to select a Display Template.
The HMI Configuration parameters can remain at default settings. In some cases, you 
can change the Display Template to match the correct version of FactoryTalk View 
that you are using. In this case, we are using FactoryTalk View SE version 15 
templates.
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7. Select the Displays tab. Right click within the displays window and select Add New.

A new FactoryTalk View SE display is added to the table with the name “Graphic”.
8. This display is where your tank graphics will be created and later imported to the HMI. 

Change the graphic name and size as follows:
• Name: Tank_Display_SE_Import
• Display Width & Height: 1920 x 1080

9. Select Finish. You now have both the Historian ScanClass and HMI FTViewSE_Server 
references within your ACM project.
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Add a Controller
1. Add a new object in the class view window.

2. Select the controller family that is used in the application and if it is a regular or 
process series controller. To use PlantPAx Process Objects one of the Process controller 
options must be used. In this example we select a ControlLogix® Process Controller. 
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Configure the Controller Object

In this example, you use ACM to create a controller named CLX. 
1. Name the controller and match controller parameters to equipment that will be used in 

the project.

Add Devices

In this example, you add two I/O modules. One communication module and one drive.
• 1756-IF8 Analog Input module (Local_01) for the tank level input.
• 1756-OB16 Digital Output module (Local_02) to control both valves.
• 1756-EN2T Communication module (Local_03) to connect the drive.
• PowerFlex 755T Variable Speed Drive (MT100_Dvc) to run the pump motor.

Create the 1756-IF8 Analog Input Module 
1. Right click the I/O Configuration > Backplane and select Add New.

2. Enter 1756-IF8 into the Filter bar. Select the first option (RA-LIB) ACM 2.0 Module Analog 
1756-IF8 and select Next.
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3. When the Object Configuration Wizard for the 1756-IF8 appears, select Finish. The 
default for slot 1 is acceptable for this example. 

Create the 1756-OB16 Digital Output Module 
1. Right click the I/O Configuration > Backplane and select Add New.

2. Enter 1756-OB16I into the Filter bar. 
Select the (RA-LIB) ACM 2.0 Module Digital 1756-OB16I.

3. When the Object Configuration Wizard for the 1756-OB16I appears, select Finish. The 
default for slot 2 is acceptable for this example.

Create the 1756-EN2T Communication Module
1. Right click the I/O Configuration > Backplane and select Add New.
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2. Enter 1756-EN2T into the Filter. Select the first (RA-LIB) ACM 2.0 Module Communication 
1756-EN2T.

3. When the Object Configuration Wizard for the 1756-EN2T appears, select Finish. The 
default for slot 3 is acceptable for this example.

Create the PowerFlex 755T Variable Speed Drive
1. Using the Class View window, right-click on the CLX controller and select Add New.

2. Enter PF755T into the Filter bar. Select the (RA-LIB) Device Power Velocity 
raC_LD_Dvc_PF755T.

3. In the Object Configuration Wizard for PF755T, change the name of the drive MT100_Dvc 
and change the ObjectInterfaceDatatype to PredefinedDatatype.
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4. Add a parent module by selecting the ellipse button. Select the 1756-EN2T module in slot 
3. (Local_03) and select Finish.

5. Change the IP Address to 192.168.1.10 (must be something different than the parent) and 
then select Next.

6. Select the Linked Libraries tab and select the Auto Create button on the next screen.

7. Select the raC_Dvc_PF755T link name and select OK.

8. Select the Normal Task in which the logic will be inserted and select Add New program.

Linking to the device library allows ACM to create the Add-On Instruction 
(AOI) designed to interface to the drive data structure. The AOI formats the 
data for use throughout the project and control strategies.
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9. Type Tanks for the new Program the name and select Finish to complete adding the 
PowerFlex 755T Drive and device library code.

Add Hardware Bus Object

In this section you create the Hardware Bus object to reference the three local I/O modules 
from the prior section.

1. Right click the CLX controller and select Add New.

2. Enter Hardware into the Filter bar. Select (RA-LIB) Process 5 Organization Hardware_Bus 
and select Next.
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3. Use the Task drop down and select the System Task.

4. Select Finish and verify that the Bus was created

Add Hardware Module Status Object

In this section you create the Hardware Module Status object to reference the three local I/O 
modules from the prior section.

1. Right click the CLX controller and select Add New.

You will see a warning on the next window stating, “Library contains the 
program Hardware Tree which is already scheduled in the task System”. 
This is normal.
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2. Enter Hardware into the Filter. Select the (RA-LIB) Process 5 Hardware_Module_Status 
and select Next.

3. To select a module, select the ellipse button on the far right of the Module row.

4. Select your first module. In this example, select the module in slot 1 (Local_01) and 
select Finish.

5. To select a Bus Instance, select the ellipse button on the far right of the Bus_Instance 
row.

6. Select the Bus tab on the far right. Select Cmd_1 and select Finish.
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7. Verify the module Local_01 is assigned to HWBus_Org_Bus_Cmd_1 and select Finish.

The first Hardware Module Status object looks like the following highlighted example.

8. Right-click on Hardware_Module_Status. and select Add New Instance for the second 
module.
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9. Using the same steps when adding the first module, select the Ellipse on the right and 
select the module in slot 2 (Local_02). Then select the second bus element 
(HWBus_Org_Bus.Cmd_2).

10. Select Finish.
11. Right-click on Hardware_Module_Status. and select Add New Instance for the third 

module.

12. Using the same steps when adding the second module, select the Ellipse on the right 
and select the module in slot 3 (Local_03). Then select the second bus element 
(HWBus_Org_Bus.Cmd_3).
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13. Select Finish. The Hardware Module Status looks as follows:

Add Control Strategies

In this section, you add three Control Strategies into the ACM project.
• CS_PAI (Process Analog Input) for the Tank Level Indicator LI100
• CS_PVLV (Process Valve) for the Inlet and Outlet Valves XV100 & XV101
• CS_PVSD (Process Variable Speed Drive) for the pump motor MT100

See PROCES-RM201 for more details on using the Control Strategies.

Add CS_PAI
1. Right click the CLX controller and select Add New.

2. Enter PAI into the Filter bar. Select the option (RA-LIB) Process 5 Control Strategies 
Input Processing PAI and select Next.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm201_-en-p.pdf
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3. Change the control strategy name to LI100 and select the Task Normal and Program 
Tanks, then select Finish.

4. When the import is complete, select the LI100 routine in the Class View window. In the 
center window, provide a description of Level Indicator and scroll down the parameters 
list to the IO Configuration section. Select the Ellipse button for input process variable 
Inp_PV.

5. Select the module Local_01 and channel 0 Local_01_00 for the input process variable 
reference, then select Finish.

6. Scroll down the parameters list for LI100 to the HMI Configuration and select the Ellipse 
button for input process variable AssocDisplay.

IMPORTANT Select a Control Strategies solution and not a Plug-In. 
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7. Select the HMI FTViewSE Server and the Displays tab on the right. Select the Display that 
we created earlier named Tank_Display_SE_Import then select Finish.

8. When the HMI display named Tank_Display_SE_Import is selected for the LI100 control 
strategy, select the Apply Changes button. This reference will create and link LI100 to a 
level indicator graphic for our Tank display in the HMI.

The AssocDisplay reference allows ACM to create a level indicator graphic for LI100 
on our Tank display in the HMI.

Add CS_PVLV
1. Right click the CLX controller and select Add New.

2. Enter PVLV into the Filter bar. Select the bottom option (RA-LIB) Process 5 Control 
Strategies Device Control PVLV and select Next.
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3. Change the control strategy name to XV100 and select the Task Normal and Program 
Tanks. Then scroll down the Parameters list and select the Out_Pos2 reference to 
Local_02.DO.Local_02_00.

4. Scroll down the parameters list for XV100 to the HMI Configuration and select the Ellipse 
button for input process variable AssocDisplay. Configure the AssocDisplay to 
Tank_Display_SE_Import display to select the references as you did with the level 
indicator control strategy previously.

5. Select the Interlocks tab. Right click in the background and select Add New.
6. For Intk_00 choose a reference tag by selecting the Ellipse button.

7. Select the PAI LI100 control strategy that we created earlier and in the right-side 
window select Sts_HiHi reference, then select Finish.
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8. Verify the level indicator LI100#Sts_HiHi is selected for the Interlock, then select Finish.

This interlock prevents the inlet valve from opening and filling the tank when the 
tank level is full.

9. To create a second control strategy for the outlet valve, you can repeat the previous 
steps or follow the faster copy/paste method as described for this example. Right click 
the XV100 control strategy and select Copy.

10. After XV100 is copied, right click CLX and select Paste.
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11. The paste operation asks you to rename the control strategy. Rename XV100_copy to 
XV101 and select OK.

12. Using the Class View window, select XV101 control strategy. Change the description to 
Outlet Valve and scroll down the parameters list to Out_Pos2 and change the IO point to 
channel 1 Local_02.DO.Local_02_01, then select Apply Changes.

Add CS_PVSD
1. Right click the CLX controller and select Add New.
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2. Enter PVSD into the Filter bar. Select the bottom option (RA-LIB) Process 5 Control 
Strategies Device Control PVSD and select Next.

3. Change the name of the drive control strategy for the motor to MT100 and assign it to 
Task Normal and Program Tanks. Change Cfg_HasDvcObj from False to True. Then 
select the ellipse for the Ref_DvcOject and browse to the drive MT100_Dvc.

4. Select the Linked Libraries tab. 



146 Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025

Chapter 6          Use ACM to Create an Application

5. Select Link to Existing Instance.

6. Select MT100_Dvc and select finish.

7. Select the Parameters tab and scroll down the list to change the options for 
Cfg_HasFwdPermObject and Cft_HasIntlkObj both to True.
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8. Continue to scroll down the parameters list to assign the 06 - HMI Configuration to 
reference the graphic using the Ellipse button.

9. Browse to the HMI FTViewSE Server and select the Displays tab on the right. Select the 
display that we created earlier named Tank_Display_SE_Import.

10. Select Finish. The display reference appears as follows.

11. Select the Interlocks tab. Right-click and select Add New. Select the Ellipse button in the 
Reference Tag column.
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12. Browse to the PAI > LI100 level indicator control strategy. On the right, select the 
Sts_LoLo reference. Select Finish.

This interlock prevents the pump from dry starting if the tank is nearly empty. 
13. Select the Fwd_Permissive tab. Right-click and select Add New. Select the Ellipse button 

in the Reference Tag column.

14. Browse to the PVLV > XV101 level indicator control strategy. On the right, select the 
Sts_Pos2 reference. Select Finish.

This permissive only allows the pump to start when the outlet valve is opened.
15. Select Finish in the Object Configuration Wizard.
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16. Select the newly created control strategy MT100 for the pump motor and scroll down the 
parameters list to IO Configuration.

Tags are automatically created for connection parameters. This strategy IO was 
determined when you first created the controller and entered type 5.

Add Alarm Groups ACM can create alarm groups and you can assign alarms within control strategies to those 
groups based on organization. Specify the type of alarms that ACM generates in the controller 
parameters.

1. Go to ACM System View > HMI > Alarms and add an FTAlarmEvent object from the library.
The default name is FTAlarmEvent_Server.
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2. Select the FTAlarmEvent_Server object to access the Alarm Group Tab and select Add 
New.

3. Add groups for your areas and assign the Parent Alarm Group ID to represent the 
parent/child hierarchy.

Once you have alarm groups, you can enable alarms in your control strategies and 
link each alarm to the desired group.

4. For each control strategy, access the parameters tab and expand 04 - Alarm 
Configuration. Enable the alarms that you need (such as, Hi Hi, Hi, Lo, or Lo Lo).

5. Expand an enabled alarm (such as, Hi Hi Alarm) and select the Group parameter (such 
as, Cfg_HiHiAlarmGroup).

Ideally an alarm design has been performed to assure that only those alarms that 
uniquely identify an abnormal situation and require action by the operator are 
enabled. Configuring alarms without a proper design effort creates nuisance 
alarms that make the operator less effective and create mistrust in the alarm 
system
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6. Click the ellipse button and use the Select a Reference dialog to choose the alarm 
group.

Generate Controller and Graphics Files

Application Code Manager can generate Logix Designer controller files in both the L5X and ACD 
formats. The controller files contain the I/O modules, hardware bus and status, and control 
strategies that you created in ACM so you can download the project to a Logix controller.

ACM can also generate HMI graphics to be imported to FactoryTalk View SE displays. These 
standard PlantPAx graphics are sourced from the Process Library and each graphic is 
associated to the control strategy referenced in ACM.

Generate Controller ACD File
1. Right click the CLX controller and select Generate Controller.

The Logix Code Generation dialog appears. 
2. Check the Create ACD box. Take note of where you save the file. Select the Generate 

button. 
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The Overwrite existing checkbox is optional and is selected if you want to overwrite 
a file already in the directory. The ACM Project Data creates just the L5X formatted 
file.

3. When the generation is completed, select the Close button.

Generate the HMI Display File
1. Using the System View, expand HMI > Displays and right-click on FTViewSE_Server. 

Select Generate Displays and Generate Tank_Display_SE_Import display.

2. Save the display Tanks_Display_SE_Import.xml to the same directory as the ACM file.
3. Select OK when the Generation is complete.

4. If needed, generate a CSV file of tags to import into your FactoryTalk Historian SE 
database. 
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Download ACD File to the Controller

Since ACM is an offline tool, after a controller file is generated, the Studio 5000 Logix Designer 
software is required to open and download to a Logix controller.

1. Using Logix Designer select Communications > Who Active from the top menu.

2. Select a controller from the tree. For this example, expand the Ethernet, 
EmulateEthernet driver in FactoryTalk Linx and select the empty controller at address 
127.0.0.1. 9310-WED300ENT, CLX and then select Download.

3. Review the standard warning dialog and select Download.

4. After the download is complete, put the controller into Remote Run mode.

5. Select Yes to change the mode to Remote Run.
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Add Graphics to HMI

See Rockwell Automation Publication, PlantPAx Display and Library Guidelines PROCES-RM200 
for information on the Graphic Framework.

Bulk Configuration

This section is to demonstrate the advantage that Application Code Manager has over Studio 
5000 Logix Designer when creating large projects with numerous similar devices.

For simple projects the traditional Studio 5000 design environments can be sufficient, 
however as complexity and size increase the export\import features of ACM can greatly 
reduce design time.

ACM creates the initial control strategy and devices. ACM then exports the project where 
devices can be quickly replicated. Afterwards, import the bulk project back into ACM to 
generate your final controller file, HMI graphics and Historian tags.

1. In ACM, sect Tools > Import Export Manager.

2. Select the Export tab, select Complete Project and select Export.

3. Save the export file and ensure that you keep the default file name.
4. Select Finish when the export is done and minimize ACM software.
5. Navigate to the newly exported file.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
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6. The project opens to the PVLV control strategy tab by default. Notice both valves XV100 
& XV101 are listed, along with the configured parameters as you scroll right. Explore the 
other tabs across the bottom to review other components of the ACM project. 

7. The bulk creation of devices is achieved by copying existing devices and pasting as 
new rows. Then focus on a new row and using Search & Replace you can easily change 
the names for each new additional device that is controlled by this control strategy.

8. Save the bulk ACM file and close the spreadsheet.
9. In ACM, select Tools and Import Export Manager from the top menu.
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10. Select the Import tab, select Replace - Overwrite project. Using overwrite for this 
example prevents errors if the user project differs from what was intended.

11. Use Ellipse to navigate and select the bulk creation file and select Import.

12. Select Next on the import verification and Finish when the import is done.
13. Explore the additional content imported into ACM.
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Modifying an Existing PlantPAx System
The process library includes templates of controller and HMI applications to get you started If 
you are not using ACM or have an existing project. 

The PlantPAx® Configuration Tool for Tags, Alarms, and FactoryTalk® Historian are compiled in 
a separate download, PlantPAx Tools, which can be used to edit existing projects. See the 
following table for software and tool usage and explanation.

Prerequisites Which library elements to use depends on whether you:
• Modify an existing application
• Create a new application based on a sample template
• Import library elements into a project
• Generate library elements into code by tools

For more information about the process library, see the Rockwell Automation Library of 
Process Objects Reference Manual, publication PROCES-RM200.

Studio 5000 Logix Designer 
and FactoryTalk View SE 
Software

The process library includes templates of controller and HMI applications. These templates are 
designed to get you started if you aren’t using ACM software or do not have an existing project.

New or existing Studio 5000 Logix Designer® and 
FactoryTalk® View SE software

Studio 5000 Logix Designer and FactoryTalk View SE software can open templates to start new projects or 
import library elements directly into existing projects. Both software products are required throughout the 
application development process,

Open and import library elements:
• Controller project template .ACD files
• Controller Add-On Instruction and rung .L5X files
• HMI project template .APA files
• HMI global object and graphic display .GFX files
• HMI image .PNG files

 Existing PlantPAx Configuration Tool for 
Tags, Alarms, and Historian

The PlantPAx Configuration Tool for Tags, Alarms, and Historian helps define controller .ACD files with 
associated HMI applications. The PlantPAx Configuration Tool for Tags, Alarms, and Historian is best suited for 
modifying the output from an ACM project, an existing controller project, or a template project from the process 
library.

Use the PlantPAx Configuration Tool for Tags, Alarms, and Historian to:
• Organize parameter files for use the code, tags, and HMI displays into a process tree (builds the Logical 

Organizer)
• Create FactoryTalk® Alarms and Events alarm groups
• Create Historian Asset Framework elements
• Edit controller tag data with import and export
• Build HMI parameters for use with tag search and navigation graphics

EWS

Process 
Controller

Resource Description
Rockwell Automation Library of Process 
Objects Reference Manual, publication 
PROCES-RM200

Describes how to build and use library components that comprise the Rockwell Automation Library of Process Objects.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
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Logix Designer Application Templates

Controller templates have the library instructions and task model already defined. They also 
have a basic IO configuration that you can modify according to your project plan.

Open a Logix Designer application project and browse to the template directory and select the 
template to open.

For more information, see PlantPAx Process Objects.

FactoryTalk View SE templates

HMI templates contain pre-defined components such as, Displays, Global Objects, Libraries, 
Images, Macros, and basic configurations for FactoryTalk View SE applications.

If you already have an HMI project on your PASS, you can:
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• Use the template application as a new HMI, then recreate your Areas, HMI server, data 
server and alarms and events server, such as you do when you configure a PASS.

• Use the existing HMI application, on the PASS, and add library components into the 
application.

You must restore the template so you can access the application and its components.
1. Go to the FactoryTalk View SE Application Manager and select to restore a local station 

archive.
2. Browse to the .APB file in the templates folder in the process library and open the 

application.
- If you choose to make this template your new HMI application, see Chapter 3, 

Process Automation System Server for how to create areas and servers.
- If you choose to maintain your existing HMI application, export the Displays, Global 

Objects, Libraries, Images, Macros from the template and import them into your 
application.

You can use the Add Components in Application method to add Displays, Global Objects, 
Libraries, Images, directly from the library.

1. In your application, select the component (such as Displays) and select Add Component 
in Application.

2. Browse to the .GFX files in the library folders and select those to open.

Edit a Project via the 
PlantPAx Configuration Tool 
for Tags, Alarms, and 
Historian 

The PlantPAx® Configuration Tool for Tags, Alarms, and FactoryTalk® Historian are compiled in 
a separate download, PlantPAx Tools, which can be used to edit existing projects. This tool 
performs various functions to help you create or modify an existing PlantPAx project. To use this 
tool, you must have a controller project (.ACD) file, which can be:

• Generated from ACM
• Existing controller project
• Sample controller project from the process library
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For more information, see the quick start guide that comes with the tool. The Quick Start guide 
automatically launches when you open the PlantPAx Configuration Tool for Tags, Alarms, and 
Historian.

With the PlantPAx Configuration Tool for Tags, Alarms, and Historian, you can:
• Define a project that has multiple controller .ACD files and associated FactoryTalk® 

View HMI applications.
• Organize controller logic, tags, and HMI displays in a Process Tree organizer. You can 

then use the tree structure to create FactoryTalk Alarms and Events alarm groups and 
Historian Asset Framework elements.

Edit Tag Data • Edit tags and data in offline controller .ACD files.
• Export and import tag data to and from text files.
• Create Microsoft® Excel® workbooks for online OPC tag data reads and writes.
1. Add controllers to the project or load existing project.
2. Launch the bulk data editing function from the controllers project tree by right-mouse 

clicking a project controller and selecting one of the four export/import tools:

3. This launches a dialog window for each of the tools. Click the “Help” button in the dialog 
window for additional instructions.

Edit Alarms • Create FactoryTalk Alarms and Events. XML import files using tag data from controller 
files.
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1. Multiple AE alarm servers can be used in FactoryTalk applications. Each AE alarm server 
can provide alarms from multiple Logix controllers. The project can contain multiple 
controllers. Select the controllers to use for each AE alarm server XML import file you 
want to create. Right-mouse click “HMI Alarm Servers” and “Add Alarm Server”:

2. Enter alarm server name and description. It is recommended that the FactoryTalk AE 
server name be used.

3. Select the controllers to associate with the alarm server. Only Logix tags from the 
selected controllers will be used.

The alarm server and associated controllers are added to the project tree.

IMPORTANT The software does not have the capability of accessing the FactoryTalk 
AE server. The alarm server created here is merely used for organizing 
the controllers associated with the server. Any name can be used. 
However, it is recommended to use the actual AE server name to avoid 
confusion.
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Launch AE Alarm Configuration Tools

The tool can be used for controller tag-based alarms and AE server-based alarms. Click Help 
for details.

Edit Historian Points • Bulk configure OSI PI Asset Framework (AF) databases with Logix tag AF elements. This 
includes automatic configuration of related PI points in the FactoryTalk® Historian data 
server (PI data server).

• For systems without Asset Framework, a separate utility provides bulk configuration of 
PI points in the Historian data server. The utility provides the option of generating a 
bulk import file, or adding the PI points directly if a Historian data server connection is 
available. The bulk import file can be used with the PI Point Builder Excel AddIn to 
create points in the data server. 

For more information about Historian tags, see Chapter 9, Historical Data
1. Create project with Logix controller files.
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2. Right-mouse click on the Historian Servers tree node and add a historian server. Any 
names and description can be used as the name is used as a project placeholder.

3. Select the controllers to use and fill in the information in the window. For FTH, the point 
source name is “FTLD”. Contact your PI administrator for the point source name if not 
using FTH. Note the data server name is not required when the point source is not FTLD.

If the controllers are already configured for a project Alarm Server (refer to the Alarm 
Builder user manual), then the application and data server information are 
automatically filled in – it’s assumed that the same data servers from the HMI 
application are used. Make any changes if necessary.
Use FactoryTalk Administration Console to find the data server information:
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4. Click OK when the information has been entered. A new Historian Server tree node 
should appear in the project tree.

5. Right-mouse click the historian server node to make changes.
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6. Right-mouse click the project historian server tree node and select “Build PI Points or 
Import File”:

7. Select the Build Option to create an import file or add PI points directly to an FTH Data 
Server. An OSI PI client must be installed to add PI points directly. See OSI PI 
documentation for instructions.

8. If the “Build PI Points in FTH Data Server” option is selected, then use the pull-down list 
box to select the data server and click Connect.

The connection status is displayed under the pull-down list box after clicking 
Connect:
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9. Since different Process Library versions can have the same data type names containing 
different parameter names, separate sets of historian library definitions and templates 
are used. Select the library version using the pull-down list box:

10. Use the “PlantPAx Elements to use for PI Points” pull-down box to select the project 
elements to use.

a. “ControllerLogicalOrganizer”. All tags from the historian controllers list are added 
(same as ControllerTagsInFlatStructure option).

b. “ProcessTree”. The contents of the project Process Tree are used. See the “Process 
Tree Organizer” user manual for configuration instructions.

c. “ControllerTagsInFlatStructure”. All tags from the historian controllers list are added 
(same as ControllerLogicalOrganizer option).

11. Click the Build button to create the import file or add PI points to the PI data server.

If the build import file setup option was selected, then a text file with PI points 
configuration generated. Use PI Builder Excel add-in to import the points to the PI 
data server.
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If the PI points in FTH data server setup option was selected, then the build function 
updates the connected data server with library digital states sets and PI points.

See the help user manual for additional details:
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Edit HMI Displays Two utilities help build specially formatted FactoryTalk View SE parameter files.
• One utility builds a parameter file containing a list of controller tags with associated HMI 

faceplate displays. Users can search for tags using tag names and tag descriptions. The 
user can open tag faceplates from the returned search results.

• The other utility creates a navigation tree from the project Process Tree structure.

Organize the FactoryTalk View SE HMI displays under process tree folders.
1. Go to Logix Controllers > Open FactoryTalk View SE Displays List… and select the 

Process Tree tab.
2. Drag a display file from the SE display files window and drop it into the Process Tree 

folder. 
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Asset Management
FactoryTalk® AssetCentre software is a centralized tool that helps:

• Maintain inventory assets in the system
• Manage version control to track program changes
• Collect audit logs to track user and system activity
• Schedule backups and verify program integrity

This is the recommended workflow to configure and implement a FactoryTalk AssetCentre 
application. Each step outlines requirements. For more detailed information, follow the 
referenced links.

Example Asset Data Flow
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Prerequisites Following the System Workflow, configure application servers.

An asset management server (AppServ-Asset) supports maintenance and plant operations to 
the system with FactoryTalk AssetCentre software. 

In most PlantPAx® systems, the AppServ-Asset server is on a separate computer and requires 
these components local or distributed on remote servers:

• FactoryTalk® Directory 
• FactoryTalk® Activation server
• FactoryTalk® SQL server (can be on the same computer as the AppServ-Asset server or 

on its own computer)

Install FactoryTalk AssetCentre Client software on the FactoryTalk AssetCentre server, the 
EWS, and the OWS.

For more information, see these additional resources.

For Rockwell Automation tutorials, see these YouTube videos.
• Introduction to Asset Management
• Using the Inventory Agent in FactoryTalk AssetCentre
• Getting Started with FactoryTalk AssetCentre
• Introduction to FactoryTalk AssetCentre Disaster Recovery
• FactoryTalk AssetCentre Disaster Recovery to Backup and Compare a FactoryTalk® 

View SE Application

FactoryTalk AssetCentre FactoryTalk AssetCentre provides a centralized tool to manage and track asset information 
and protect assets.

To help protect your automated control system, we recommend that you develop a strategy for 
archiving application data and determine recovery plans. For a tutorial, see the YouTube video 
‘Introduction to Asset Management’.

Inventory Plant Assets FactoryTalk AssetCentre software provides a centralized tool to manage and track asset 
information as well as protect assets. You can:

• Scan the network for existing devices to create an inventory.
• Manually add individual assets.

Regardless of method, we recommend that you add asset types for controller project, HMI, 
engineering workstation, and servers.

An asset inventory lists the connected devices and computers on the network and stores 
unique identification information about the hardware, firmware, and software in the system.

There are multiple ways to build your inventory list of assets with FactoryTalk AssetCentre 
software tools.

Scan the System for Assets

Drag-and-drop an Asset Inventory asset type into the FactoryTalk AssetCentre tree and scan 
for device information.

For a tutorial, see the YouTube video ‘Using the Inventory Agent in FactoryTalk AssetCentre’.

Application 
Servers

Resource Description
FactoryTalk AssetCentre Installation Guide, publication FTAC-IN005. How to install the FactoryTalk AssetCentre system.
FactoryTalk AssetCentre Getting Results Guide publication FTAC-GR002 How to get started with the FactoryTalk AssetCentre system.
FactoryTalk AssetCentre Utilities User Manual, publication FTAC-UM001 How to use FactoryTalk AssetCentre utilities.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/ftac-in005_-en-e.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/gr/ftac-gr002_-en-e.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/ftac-um001_-en-e.pdf
https://www.youtube.com/playlist?list=PL3K_BigUXJ1NLQyp5q1DEbOw16kki5JWP
https://www.youtube.com/playlist?list=PL3K_BigUXJ1NLQyp5q1DEbOw16kki5JWP
https://www.youtube.com/playlist?list=PL3K_BigUXJ1NLQyp5q1DEbOw16kki5JWP
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1. In the FactoryTalk AssetCentre window in Design mode, move the Asset Inventory item 
into your asset tree.

2. Open the Asset Inventory Properties and select Scanning Configuration to define how to 
scan the system.

3. Select a device.

The device must have communication paths to any devices that you want to return when the 
Inventory Agent runs.

Dialog Box Action

Scanning Configuration

Select a type of scan from the following options:
Scan devices using CIP™: Common Industrial Protocol (CIP) scanning browses the network by using FactoryTalk® Linx drivers to 
return Rockwell Automation® Asset Management Program™.
Scan devices using SNMP: Simple Network Management Protocol (SNMP) scanning browses the network for SNMP-enabled devices 
with a specified IP address range or IP subnet. If a device responds, the FactoryTalk AssetCentre service requests available SNMP 
information.
Scan software using WMI: Windows® Management Instrumentation (WMI) scanning browses the network within the specified IP 
address range or IP subnet, and returns software installed on a Windows host.

When you’ve selected a scan type, select Advanced Settings.
IMPORTANT: Leave the default Unlimited scanning box checked to scan the entire network.

Advanced Settings Select Community String.
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4. Select Schedules and create a schedule for the Asset Inventory item. When the schedule 
runs, an inventory list is generated.

An inventory has a list of devices and a list of software.
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Manually Add Individual 
Assets

You can manually add assets.

For a tutorial, see the YouTube video ‘Getting Started with FactoryTalk® AssetCentre’.
1. While in Design mode, drag-and-drop the asset into your

FactoryTalk AssetCentre project.

An FactoryTalk AssetCentre dialog box appears for the asset that you are adding.
2. Select the asset to configure details.

For example, add an .ACD file for a controller.

3. For a controller, select a path to the controller by using the Addressing Info Browser (‘…’ 
ellipsis) button.

4. Name the asset.
We recommend that you use the steps to add each of these asset types from the 
catalog to your inventory:

• Controller project

https://www.youtube.com/playlist?list=PL3K_BigUXJ1NLQyp5q1DEbOw16kki5JWP
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• HMI
• Engineering workstation
• Servers

Configure Audit Logs There are multiple logs that can be generated to capture asset data. Select the one that you 
want:

• Audit Log monitors FactoryTalk-enabled software products and logs user actions. For 
example, who was the last user to change a program.

• Diagnostic Log to monitor system health.
• Event Log to track FactoryTalk AssetCentre events, such as when a backup starts and 

who generates a report.

Audit data is stored in the SQL server and displayed in the FactoryTalk AssetCentre logs. 
Information that is collected includes:

• User actions
• Program changes
• Security events

Security Audit Logs

Microsoft Windows® OS captures security audit records locally for every PlantPAx server and 
workstation. We recommend that you make sure the log is sized adequately to capture 
sufficient records to satisfy your retention policy. In Windows Event Viewer adjust the 
configuration of the security log according to your system requirements.

For information about how to configure secure audit logs, see Configure System Security 
Features User Manual, publication SECURE-UM001.

Schedule System Backups FactoryTalk AssetCentre software stores backup data on an SQL server.

The Disaster Recovery function creates backup files from the running asset on the plant floor. 
The backup file is compared to the original and archived to a Master version. The Agent 
service performs these comparisons and can be scheduled to operate at specific times and 
intervals.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
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Example Asset Data Flow

Once assets have been added to your system, the assets can be configured from the Archive 
tab. From the Archive view, you can do the following:

• View the archive of current and previous versions of programs
and assets.

• Set a personal working folder to hold Checked-Out files.
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• Promote a specific program version to be the master.

Create a Backup Schedule
1. From the main menu of the FactoryTalk AssetCentre client dialog box,

select Schedules.
2. Select New and follow the Wizard instructions at the top of the

dialog boxes.

Configure Disaster Recovery

The Disaster Recovery function creates backup files from the running asset on the plant floor. 
The backup file is compared to the original and archived to a Master version. The Agent 
service performs these comparisons and can be scheduled to operate at specific times and 
intervals.

The Agent service can be co-located with the FactoryTalk AssetCentre server, or it can be 
located with another server. The Agent service performs the background actions of uploading 
and comparing program files and versions.

For more information about FactoryTalk AssetCentre Agents, see the resources that are listed 
in the table on page 170.

For a tutorial, see the YouTube video ‘Introduction to FactoryTalk AssetCentre Disaster 
Recovery’.

https://www.youtube.com/playlist?list=PL3K_BigUXJ1NLQyp5q1DEbOw16kki5JWP


Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 177

Chapter 8          Asset Management

Maintenance Strategy 
Recommendations

We suggest that you develop a plan to back up your control system configuration and process 
data on a regular schedule. Consider involving your IT department to develop this plan. An 
effective backup plan can help protect you from loss of resources and revenue.

The following table summarizes the types of backups and updates for routine and annual 
maintenance. The time frames are examples and can be modified based on the attributes and 
risk factors in your plant.

The PlantPAx system can be configured to back up control system configuration data 
automatically. FactoryTalk AssetCentre software stores data in a SQL server. The server stores 
an Archived copy of both the master files and previous file revisions in a protected database. 
The Archived files are available if there’s a failure.

Database backups for FactoryTalk software packages (Historian, FactoryTalk AssetCentre) can 
occur anytime without system operation impact. We recommend that process backups be 
routinely scheduled so that data loss is minimized if computer issues occur.

FactoryTalk® Batch uses a SQL server for archiving journal data, storing master recipes, and 
material database.

Application configurations for PlantPAx system servers and workstations are to be backed up 
separately and more regularly. The frequent backups mitigate the risk of configuration and 
application information loss between PlantPAx system backups. Frequent backups simplify 
the process of restoring only a portion of your application, if needed.

The following table shows examples of project files that are to be backed up regularly. Some 
files contain configuration scripts and collected data.

Controller Project File

Use FactoryTalk AssetCentre software on your AppServ-Asset server to back up Logix 5000® 
software and Studio 5000 Logix Designer® application project files (.ACD). Logix 5000 assets 
are created in the FactoryTalk AssetCentre project tree for each controller and project files 
can be associated with those assets and checked into FactoryTalk AssetCentre software. 

IMPORTANT We recommend that you verify operating system or software 
updates on a non-production system or when the affected 
system components are not-active. These precautions help to 
prevent unexpected results.
For equipment monitoring and safety, we recommend that you 
follow the procedures of the manufacturer

Maintenance Type Recommendations

Backups Why? When? What?

Application configuration - See page 177 Roll back or file protection Periodic

Controllers
PASS servers
• FactoryTalk Directory
• HMI, FactoryTalk® Linx data servers
• FactoryTalk® Alarms and Events servers
Network switches

Data - See page 179 Archive or project protection Periodic and on-demand
FactoryTalk® Historian
FactoryTalk® Batch
FactoryTalk AssetCentre 

Recommended Configuration Backup

Configuration Host Environment Tool Files Backed Up
Controller project file Studio 5000® application FactoryTalk AssetCentre Disaster Recovery .ACD
FactoryTalk Directory FactoryTalk® Administration Console

Distributed Application Manager .APB
PASS servers FactoryTalk® View Studio software
Network switches System network User choice .TXT (based)

AppServ-Asset

Ba
ck

up
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up

EWS
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A schedule can be created to back up the project files at regular intervals. Use an EWS to 
perform check-out and check-in features to make modifications to the project file.

FactoryTalk AssetCentre software is integrated with the Logix Designer application to let you 
access files in the Archive without leaving the design environment. Use change tracking on 
project files to audit modifications.

FactoryTalk Directory

Our recommendation is to back up the FactoryTalk® Directory regularly. The backup includes 
any FactoryTalk® Security, users, and computers, among
other configurations.

The backup is contained in the output .APB file of the Distributed Application Manager, which is 
installed on the PASS with the FactoryTalk® View software, version 8.1 and later.

PASS Servers

The core servers in the FactoryTalk View application need to be backed up regularly whenever 
changes are made. The core servers on the PASS consist of the HMI, Data, and Alarm and Event 
servers.

A FactoryTalk AssetCentre custom asset can be created by following the procedure in 
Knowledgebase Answer ID 818741 ‘Building Custom Device assets for FactoryTalk Distributed 
Application Disaster Recovery’. The project servers store the output .APB file to the FactoryTalk 
AssetCentre server. Schedule the custom asset to run regularly.

Network Switches

If using an older version of FactoryTalk AssetCentre software, back up the network switch 
configuration to retain the network architecture by using a custom asset. An export of the 
switch configuration can be generated by using various tools, including the following:

• Studio 5000 Logix Designer
application software

• Third-party applications, for example the Cisco® Network Assistant Tool
• Command-line interface
• Other desired methods of your IT department

The custom asset pulls the contents of the backup into the FactoryTalk AssetCentre server. 
You specify the file location in the custom asset configuration. Schedule the FactoryTalk 
AssetCentre software to back up the exported switch configuration regularly.

For more details about the custom device plug-in for FactoryTalk AssetCentre, see the 
Knowledgebase Answer ID 634595 Building Custom Devices for use with FactoryTalk 
AssetCentre Disaster Recovery.

IMPORTANT FactoryTalk AssetCentre software, version 9, includes an asset 
for FactoryTalk View SE version 11 and later. This new asset can 
be created to support disaster recovery for a FactoryTalk View 
SE application. For details see the YouTube video ‘Use 
FactoryTalk AssetCentre Disaster Recovery to Backup & Compare 
a FactoryTalk View SE application’.
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Server Back up and System 
Restore

FactoryTalk® Historian and FactoryTalk® Batch servers produce process system data to 
document historical production data. The software configurations, which create the system 
data, must be protected along with the data.

Consider the following when using FactoryTalk AssetCentre software:
• No single asset (verification or custom asset) is to exceed 1 GB.
• The system is not to exceed 100 assets that are scheduled in a 12-hour period for one 

Agent only. Increasing the number of Agents can increase the load capacity of your 
system.

Historian Configuration and Data

The FactoryTalk® Historian server contains historian points, configurations, and data that 
need to be regularly backed up. As a part of the Historian standard installation, a script file 
pibackup.bat is installed on the Historian server. This script is used to back up the Historian 
server. 

The output of this tool is a folder hierarchy that contains all components necessary to back up 
and recover the Historian server. We suggest that you consider separating the historical data 
from the configuration for scheduling purposes. 

The historical backup data, which is generated by FactoryTalk Historian, is stored on the 
Historian server. Consult with your IT department to determine the appropriate location to 
move and store these files outside of the AppServ-Info (Historian) server.

Batch Configuration and Data

There are multiple components of a FactoryTalk® Batch system that require a backup plan 
depending on the implementation of your system. See Knowledgebase Answer ID 538578 
‘FactoryTalk Batch: How to backup and restore a Batch configuration to a new computer’. 
Included are files that are to be backed up for each of the following components of a batch 
system:

• Batch server files
• Batch client files
• eProcedure® files
• Material manager files

The file contents of the various Batch system components need to be separated into two 
groups: (1) configuration or system files and (2) data files.

The configuration files are all files that comprise the Batch project, such as area models and 
recipes. The data files are the batch journals that are constantly created by a running Batch 
server. 

The configuration files and data can be backed up at different intervals to a safe, IT-managed 
location outside of your AppServ-Batch server.

Recommended Data Backup

Configuration Host Environment Tool Files Backed Up
Historian configuration and data FactoryTalk® Historian software Pibackup.bat Backup folder contents
Batch configuration and data FactoryTalk® Batch software Batch system files System folder contents
FactoryTalk AssetCentre data

SQL server SQL Management Studio
AssetCentre.BAK

SQL server data [DBName].BAK

Historian Server
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FactoryTalk AssetCentre Data

FactoryTalk AssetCentre software manages the information that is produced by each of its 
assets and processes the data into a SQL server. When performing a backup of FactoryTalk 
AssetCentre software, nothing must be done within FactoryTalk AssetCentre. To back up the 
FactoryTalk AssetCentre configuration and data, back up the FactoryTalk AssetCentre 
database in your SQL server.

For guidelines on how to back up your FactoryTalk AssetCentre database in SQL, see the 
Knowledgebase Answer ID 59541 Backing up and Restoring FactoryTalk AssetCentre with 
Microsoft® SQL Server.

SQL Server Data

The FactoryTalk® Alarms and Events History software is configured to log to a SQL database.

These databases include the following:
• For FactoryTalk Alarms and Event database, go to FactoryTalk® Administration Console 

and expand System>Connections>Databases. Select the database to view the 
information on the Alarm and Event Historian Database Properties dialog box.

• For FactoryTalk Historian Asset Framework, the SQL Database ‘PIFD’ contains the Asset 
Framework data and configuration content.

Backup Verification

We recommend that your system use a dedicated, non-production environment that is capable 
of accepting and validating backups. You need a strategy for how frequently the backups are 
validated.

System Restore

We recommend that you consider a strategy for recovering and restoring your PlantPAx 
system to a known secure state after a disruption or failure.

System recovery and restore to a known secure state means that all system parameters 
(either default or configurable) are set to secure values. If any
security-critical information, such as patches, is installed after the last backup, the 
information must be reinstalled. For example:

• Security-related configuration settings re-established
• System documentation and operating procedures available
• Application and system software that is reinstalled and configured

with secure settings
• Information from the most recent, known secure backup is loaded and the system that 

is fully tested and functional.

Retention Policy 
Considerations

There are two ways to retain data: archived records and a detailed backup policy. While 
archiving provides historical records, backups are typically not useful unless you can access 
the data for a restore. You must take the time to design a retention policy for the reuse of 
dated materials.

For example, a backed up .ACD file from the Studio 5000 Logix Designer application could 
possibly not be saved in the most current version of Studio 5000 environment. Accessing the 
contents of this .ACD file could be problematic. But an archived printout of the logic that is 
stored in PDF format could help restore a system project.

Secure archived data and make sure that you can search for the data if requested. There are 
numerous reasons to archive data, including, but not limited to, the following:

• Compliance with government regulations

SQL Server

FactoryTalk 
AssetCentre Server

https://rockwellautomation.custhelp.com/app/answers/detail/a_id/59541
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• Retention of production knowledge 
• Reduction of backup storage footprint 

Consider the following when developing a backup retention policy:
• Location – Backup information is only worthwhile if retrievable for a restore. To 

mitigate risk, duplicate the backup contents to an off-site location if an 'Act of God' 
renders the on-site copy unusable.

• Storage – The type of storage medium that is used to backup data can affect how 
quickly you’re able to restore data. Cloud storage provides scalable backup potential 
and requires the least amount of on-site hardware. But, the cloud requires additional 
steps if the process facility isn’t connected to the enterprise cloud servers. Disk 
mirroring can provide the fastest time to restore and smaller data loss intervals. This 
process can cost more than periodic backups to a hard disk drive.

• Security – The confidentiality and importance of backup information must be carefully 
evaluated. Limit access to the retained backup storage devices and locations to help 
reduce the risk of threats. Password protection and encryption can improve risk 
mitigation.

• Cost – The cost of backing up a process system can be justified with one application 
configuration restore. The time alone to re-engineer a process configuration can justify 
the cost of physical media and IT infrastructure. Automated backup policies can reduce 
time and money for IT to complete regular backups.

System Storage Rates

The following tables provide an estimate of storage usage for a PlantPAx system. Evaluate 
your system size and adjust appropriately according to your corporate policy.

System Operating Assumptions

Description Small (1) Medium(2) Large(3)

Alarms SQL database
(alarms/min according to the ISA 18.2 peak alarm rate) 20 50 100

FactoryTalk Historian Event Frames SQL database
(event frames per hour) 250 500 1000

FactoryTalk AssetCentre SQL database
(commands/min per PlantPAx audit log guidelines) 2 5 10

FactoryTalk Historian points 5000 10,000 20,000
(1) 3000 I/O points and 10 operator workstations
(2) 3000 I/O points and 25 operator workstations
(3) 5000 I/O points and 50 operator workstations

Storage Rates

Description Small (1) Medium(2) Large(3)

Microsoft SQL server 4 GB/month 5 GB/month 9 GB/month
FactoryTalk Historian server 2 GB/month 3 GB/month 6 GB/month

(1) 3000 I/O points and 10 operator workstations
(2) 3000 I/O points and 25 operator workstations
(3) 5000 I/O points and 50 operator workstations



182 Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025

Chapter 8          Asset Management

Notes:
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Historical Data
FactoryTalk® Historian SE software captures data for reports to help maximize plant-floor 
objectives and productivity. The software collects historical points in the system to produce 
analytical data. Analytical data includes process variables, trends, estimations, and statistical 
reporting.

For a PlantPAx® system, it’s recommended to implement more than one historian server to 
create a collective of historian servers. A collective provides higher availability with 
continuous access to data during planned and unplanned outages. Adding redundant node 
interfaces is also recommended to send time-series data to all servers in the collective.

To streamline the FactoryTalk® Historian SE software configuration, follow this quick start. For 
experienced users, each step outlines requirements. For more detailed information, follow the 
referenced links.

Prerequisites Following the System Workflow, configure application servers.

A historian application in a PlantPAx system requires:
• Domain controller
• Process Automation System Server (PASS) hosting the FactoryTalk® Directory (PASS01)
• Process Automation System Servers (PASS) for node interfaces (PASS02A, PASS02B)
• Engineering Workstation (EWS)
• Operator Workstation (OWS)
• SQL standard or SQL Express database server
• Asset Framework server

When you deploy a FactoryTalk Historian application in a PlantPAx system:
• Install FactoryTalk Historian servers as a collective.
• Configure a Performance Monitor interface.

The following software must be available:
• FactoryTalk Historian SE Server
• FactoryTalk Historian Asset Framework Server
• FactoryTalk Historian Asset Framework SQL database
• PI Builder Excel® add-in

Your must be familiar with the following utilities:
• PI SDK – An object-oriented library that is designed for customizing applications
• Powershell – Command-line shell and scripting language.

For more information, see this additional resource.

Application 
Servers

Resource Description
FactoryTalk Historian SE 7.00 Installation and Configuration Guide, 
publication HSE-IN025 Installation, configuration, and troubleshooting of FactoryTalk Historian Site Edition software.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/hse-in025_-en-e.pdf
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Required PlantPAx Elements

Configuring historical data collection requires access to the following equipment. All 
equipment must be physically installed before using this document.

Historical Data In a PlantPAx system, the FactoryTalk Historian SE software collects, stores, and manages 
data. The software includes these hardware and software components:

• Data Sources - Plant floor devices and instruments that generate data, typically 
controllers. Other Data Sources can include external databases.

• Historian SE Interfaces - The FactoryTalk Historian node interface enables process 
data to be passed between a FactoryTalk® Live Data Interface (for example, 
FactoryTalk® Linx) and a FactoryTalk Historian server. Each instance of the interface 
can provide data to a single FactoryTalk Historian server or collective.

• Historian SE Server - Compresses and stores the collected data and acts as a data 
server for Microsoft® Windows®-based clients applications. It’s also possible to use the 
Historian SE server to interact with data that is stored in external systems.

• Historian SE Clients - Microsoft Windows-based applications that are used by plant 
personnel to visualize the Historian SE data.

• Historian Asset Framework - Asset Framework replaces the Historian module 
database (MDB) with a Microsoft SQL server database for improved scripting and 
reporting. 

Configure Servers for a 
Collective

A collective is a configuration of multiple servers that act as a logical server in your Historian 
database to provide high availability (HA), disaster recovery, load distribution, and increased 
scalability. Each server in a collective is called a member of the collective. When the primary 
member in a collective becomes unavailable, a secondary collective member continues to 
collect and provide data access to your Historian clients.

Create Firewall Rule for Historian Servers

To create a server collective on computers that have the Windows Firewall turned on, you 
must manually open the TCP 445 port between the two computers. Perform this section on 
both the primary and secondary Historian servers.

1. Go to Control Panel > Windows Firewall settings on the Historian Server.

Engineering Workstation (EWS) Operator Workstation (OWS) Domain 
Controller

PASS02A
FactoryTalk® Live Data 

Server
Primary Node Interface

AppServ-Info 
Historian (ASIH01)

Primary

PASS01
FactoryTalk 

Directory

PASS02B
FactoryTalk Live Data Server

Secondary Node Interface

AppServ-Info 
Historian (ASIH02)

Secondary

ASIH01
ASIH02
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2. In the Advanced Settings, select Inbound Rules and create a New Rule.
For the new rule, specify the following:

Set Initial Security Settings

For any Historian server that is going to join a Collective, security settings must be considered 
for each initial connection. To simplify the connection process, reduce the security levels of 
both the primary and secondary Historian servers. After the initial connection, the security 
levels can be modified as needed.

1. Go to Rockwell Software > FactoryTalk Historian SE > System Management Tools.
2. Select the server in the Collectives and Servers section.
3. In the System Management Tools section, select Security > Security Settings.
4. Set the slider to its lowest point and click Save.

5. Repeat the settings for the secondary server.
6. For the security setting changes to take effect, restart the servers.

Create Connections Between Historian Servers

The PI SDK Utility is used to create the connection between the Historian servers. This action 
is required on both servers before creating a collective.

1. Go to Rockwell Software > FactoryTalk Historian SE > FactoryTalk Historian SE System > 
PISDK Utility.

2. Select Connections and then right-click on the empty area next to
the servers.

On This Page Configure
Rule Type Select Port
Protocol and Ports Configure Specific Local TCP Port as 445
Action Allow the connection
Profile Apply the rule to the Domain, Private, and Public
Name Type a name for this rule (Collective Connection in the example)

ASIH01
ASIH02

ASIH01
ASIH02
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3. Select Add Server.

4. Enter the server name in the Network Path dialog box and accept the rest of the default 
settings.

5. Remove any servers that aren’t necessary. 
6. To verify the connections, go to Security Settings > PI System Management Tools 

(Administrator.)
This example shows servers ASIH01 and ASIH02. 
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Create the Historian 
Collective

 Now that the servers are configured, you can create a Collective by using the PI Collective 
Manager.

Go to Rockwell Software > FactoryTalk Historian SE> FactoryTalk Historian SE System > PI 
Collective Manager and complete these steps:

Client to Server 
Connections

For all servers and workstations that require access to Historian data, use the
PI SDK Utility to add a connection to a Historian server or Collective of servers. This includes 
the PASS servers (PASS01, PASS02A & PASS02B), EWS, and OWS workstations.

Connect another Computer to Historian Server

For each computer that requires a connection to the collective, complete
these steps:

1. Go to Rockwell Software > FactoryTalk Historian SE > FactoryTalk Historian SE System > 
PISDKUtility.

2. Select Connections and then right-click on the empty area next to the servers to add a 
new server.

On this Dialog Box Action

Create New Collective Initial Page • Select I have verified my backups are valid
• Select I have verified my PI interface servers configuration

Create New Collective - Existing or New 
Primary

Select a newly installed PI server

Create New Collective - Select Primary 
and Collective name Select the Collective Primary server and define the properties.

Create New Collective - Select Secondary 
Servers Select the Collective Primary server and define the properties.

Create New Collective - Select Archives • Accept the default number of archives to be copies
• Accept the default location for the temporary backup

Create New Collective - Verify Selections Verify the information
Create New Collective - Conversion 
Progress Verify the conversion progress is completed

Server ID Mismatch Select Accept the new ID
Create New Collective - Finished Acknowledge the creation of the collective

ASIH01

EWS OWS
Domain

Controller PASS01

ASIH01
ASIH02

PASS02A
PASS02B



188 Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025

Chapter 9          Historical Data

3. Maintain the default connection name of 'Production Historian' for library object 
reference, then select the Server or Collective Name and click Test Server Connection.

4. Select the box next to the new server.
The server appears in the middle of the utility for a successful connection.

5. Remove any server connections that aren’t necessary.

Historian to FactoryTalk 
Directory Connection

Use the FactoryTalk® Administration Console to add the FactoryTalk Historian server 
connection to the FactoryTalk Directory.

1. Go to Rockwell Software > FactoryTalk Administration Console and select ‘Network’ for 
the directory you want to use.

2. Go to Network > System > Connections > Historical Data and select New Historian 
Server Connection.

3. Select the Server or Collective Name and click Test Server Connection.

If you’re using a collective, enter the primary server.

EWS
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If the connection is good, a green check mark appears along with the text 'Server 
Found.'

4. In the FactoryTalk Administration Console, go to Network > System > Connections > 
Historical Data > Production Historian and
choose Properties.

5. Select the Licensing tab and enter how many licenses are stored
on the server.
• If one license is stored locally in each collective server, enter '1' in the 

Assigned column.
• If both activation licenses are on the activation server, enter ‘2’ in the 

Assigned column

Create a Data Collection Interface

A data collection interface is used to collect data (tags) from data sources, such as Logix 
5000™ controllers, and pass it to the FactoryTalk Historian server or collective.

The FactoryTalk Administration Console is used to create and configure the data collection 
interface.

1. Using an EWS, launch the FactoryTalk Administration Console and expand Historian 
server connection.

When a new FactoryTalk Historian server is added, a default node interface is 
created along with a name FTLD and ID 1 (FTLD1).

2. Delete the default node interface FTLD1.
3. Select the Historian server connection and select New Data Collection Interface.

4. Select the Interface Type: (FactoryTalk Live Data), Name: FTLD and
ID: 1 and choose the computer hosting the interface.

EWS
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For example (PASS02A) where the remote FactoryTalk® Linx data
server runs.

Create a Synchronization Path for Redundant Node Interfaces

A common folder is used for files that are used for handshaking and redundancy. This folder is 
created on the PASS server that hosts the FactoryTalk Directory.

1. On the PASS01, create a folder on Local Disk (C:) named FTHSE_Failover.
2. Specify these properties for the folder.

IMPORTANT When redundant node interfaces exist (PASS02A & PASS02B), only 
one data collection interface is required, and it references the 
primary (PASS02A) node interface.

From this Location Configure
Sharing Tab Advanced Sharing

Advanced Sharing • Select Share this folder
• Select Permissions

Permissions for FTHSE_Failover Add the group Everyone
Select Users, Computers, Service Accounts, or Groups Select Object Types

PASS01

Synchronization
Folder

FTD

PASS01

PASS02A

PASS02BASIH01
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Configure Redundant Node 
Interfaces

A FactoryTalk Historian node interface enables process data to be passed between a 
FactoryTalk Live Data server and a FactoryTalk Historian server.

A PlantPAx system with redundant data servers requires configuration of the node interface on 
the primary and secondary servers (PASS02A and PASS02B).

The PI Configuration Utility (PI ICU) is an application that aids in system management by 
consolidating the setup and configuration options of each node interface. PI ICU allows you to:

• Configure all interface parameters
• Manage, start and stop interface service
• View and configure interface service dependencies
• Configure and run buffering
• Configures the Universal Interface (UniInt)

UniInt provides generic functions that are required by most interfaces, such as establishing a 
connection to the Historian Server node and monitoring the Historian Point Database for 
changes. To minimize data loss during a single point of failure within a system, UniInt provides 
two failover schemas: (1) synchronization through the data source (Phase 1) and (2) 
synchronization through a shared file (Phase 2).

Phase 1 UniInt Failover uses the data source itself to synchronize failover operations and 
provides a hot failover, no data loss solution when a single point of failure occurs. 

Phase 2 UniInt Failover uses a shared file to synchronize failover operations and provides for 
hot, warm, or cold failover. The Phase 2 hot failover configuration provides a no data loss 
solution for a single point of failure similar to Phase 1.

The UniInt failover scheme requires the data source to be able to communicate and service 
data to two interfaces simultaneously. Additionally, the failover configuration requires that the 
interface supports outputs. A redundant solution requires two separate interface nodes 
communicating with the data source.

Object Types Select Computers

Select Users, Computers, Service Accounts, or Groups

Enter the PASS servers used as Node Interfaces as the 
object names to select

Permissions for FTHSE_Failover Allow Full Control, Change, and Read permissions for all 
Node Interface servers

From this Location Configure

IMPORTANT In this section, only Phase 2 UniInt Failover is addressed.

Synchronization Folder

PASS01

FTD

ASIH01

PASS02A

PASS02B
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In a hot failover configuration, the interface copy that is in a backup role collects and queues 
data in parallel to the interface that is in the primary role. The interface in the backup role 
does not send the data that is collected to the Historian server. However, if a failover occurs, 
the interface immediately sends its data to the Historian server.

Configure a FactoryTalk Live Data Primary Interface

The primary interface goes on PASS02A and connects data servers to the historian database.
1. Go to Rockwell Software > FactoryTalk Historian SE > Interface Configuration Utility and 

select the interface.
For example, select 'FTLDint1 (FTLDInt1)->ASIH01.'

2. If the Interface ID isn’t already ‘1’, change it to ‘1’.

3. Select Service and do one of the following:
• If prompted, select Yes. The PI ICU sets the PIBufss service to be a 

dependency of FTLDint1.
• If you aren’t prompted, you must scroll down the Services list and set 

the PIBufss service to be a dependency of FTLDint1.
4. Go to UniInit > Failover and select the following:

Location Action
UniInit Failover Select Enable UniInit Failover and Phase 2
UFO Type HOT

Synchronization File Path Path = Network > pass01 > FTHSE_Failover directory (that was 
created in the previous section)

PASS02A
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5. Right-click the tag area and select 'Create UFO_State Digital Set on Server ASIH01'.

6. In the tag area, select ‘Create all points (UFO Phase 2')
7. When the status for FTLDInt1_UFO2_ActionID tags changes to 'Created', select Apply.

The 'UniInt Failover’ configuration isn’t complete until the 'Other' interface is 
selected' message appears.

Configure a FactoryTalk Live Data Secondary Interface

The secondary interface goes on PASS02B and connects data servers to the historian 
database. The configuration is provided in a .BAT file.

1. Go to Rockwell Software > FactoryTalk Historian SE > Interface Configuration Utility.
2. Select the folder symbol to create an interface instance from a .BAT file and enter this 

information.

From Location Action
Open Interface Configuration File Dialog Box Select the LDInterface folder

Interfaces > LDInterface directory Select C:\Program Files (x86)\Rockwell Software\FactoryTalk 
Historian\PIPC\Interfaces\LDInterface\ directory

The Select Host PI Data server/collective dialog 
box

Select the hose PI Data server/collective and the collective 
member

Service > Service Configuration >Display name Enter FTLD1
General > General > Interface ID Enter 1

UniInit > Failover > UniInit Failover Select Enable UniInit Failover
Select Phase 2

UniInit > Failover > UFO Type Select HOT
UniInit > Failover > Synchronization File Path Path = Network > pass01 > FTHSE_Failover 

PASS02B
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3. The failover and synchronization information appears in the respective fields.

4. In the PI Interface Configuration Utility window, select Apply.

Return to the Primary PASS (PASS02A)
1. Select the interface path for the second interface.

2. Go to Control Panel > Administration Tools > Services and select Properties for FTLD1.

3. From the Log On tab, Select Log on as Local System Account.

UniInit > Failover > UniInit Failover > Failover ID 
# for this instance Enter 2

UniInit > Failover > UniInit Failover > Failover ID 
# for the other instance

Enter 1
Select the interface file (FTLDInt_FTLD.bat.bak) on the 
secondary server

Synchronize UFO settings dialog box Select yes to synchronize the UFO settings

From Location Action

PASS02A
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4. In the PI Interface Configuration Utility window, select Apply and Play  to start the 
primary service (if not already running).

5. Select Yes if asked 'Would you like ICU to start this service for you?'

Return to the Secondary PASS (PASS02B).

1. Select the Interface that was created earlier and click Play  to start the secondary 
service.

2. Select Yes if asked 'Would you like ICU to start this service for you?’

Confirm Unit Failover Diagnostics

From an EWS, test and confirm the failover diagnostics from the
Historian server.

1. Go to Rockwell Software > FactoryTalk Historian SE > System Management Tools.

2. Select Data > Current Values and select the Tag Search  icon.

From Location Action
Tag Mask field Enter *FTLD*
Tag Search Dialog Box Select all tags

PASS02B

EWS
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3. Select Play  to see the online status.

Configure PI Performance 
Monitor

The Windows Performance Monitor (PerfMon) is a powerful operating system tool to monitor 
the health of resource usage and processes on a computer.

The PI Interface for Performance Monitor (PIPerfMon) collects performance counter data from 
Windows performance data providers, local and remote, and sends this data to the Historian 
server. It’s recommended to use PIPerfMon in a PlantPAx system.

Create Domain User for PIPerfMon Service

The PIPerfMon service defaults to running in a local account. For PlantPAx systems with a 
domain, it’s recommended running the PIPerfMon service in a domain account. This enhances 
security and provides access to obtain data for a performance capture among other domain 
computers.

The domain user account for PIPerfMon service must be created on the domain controller. It’s 
a user account with privileges to run the service on other computers within the domain. 

1. From the Server Manager utility on the domain controller, select Tools > Active Directory 
Users and Computers.

2. Add a new user to the Managed Service Accounts.

Domain 
Controller
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3. Specify these properties for the User.

4. Create a password with the following conditions:
• User cannot change password
• Password never expires 

5. Assign the PIPerfMon profile as a member of Performance Monitor User.

Configure the PIPerfMon Interface

To use PIPerfMon, you must configure an interface name and a points value within the 
FactoryTalk Directory. The points are the limit that the interface uses based on the number of 
computers in your system. Each variable – CPU usage, RAM, disk space – is one point. You can 
use the number of points up to 20% of your FactoryTalk Historian SE software license.

Configure the interface on the primary historian server.
1. Go to Rockwell Software > FactoryTalk Administration Console and select ‘Network’ for 

the directory you want to use.

Item Description

First name Type a name for the PI PerfMon service.
IMPORTANT: The ‘PI’ preface is the name of the OSISoft product.

Initials Optional
Full name Type the same name for the PI PerfMon service.

User login name Type the same name for the PI PerfMon service and click the pull-down to 
select your domain folder.

IMPORTANT The logon password creates a service user, not a person. The 
service user grants access to system computers for placing data 
into memory (buffer).

ASIH01
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2. Go to System > Connections > Historical Data folders > Production Historian and select 
properties.

3. On the Point Sources tab, type an interface name (such as PerfMon) and a value for the 
points limit.

The value is the expected number of performance points in the system.
4. Go to Rockwell Software > FactoryTalk Historian SE > Interface Configuration Utility. 

and select New Windows Interface Instance from BAT file.

5. Select the PiPerMon.bat_new file from C:\Program Files (x86)\Rockwell 
Software\FactoryTalk Historian\PIPC\Interfaces\PIPerfMon directory.

6. Select the FactoryTalk Historian server as the host PI Data server/collective.

IMPORTANT Be patient because this dialog box could take a few minutes to 
appear.
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7. Enter a Point Source name and an Interface ID number.

8. Restart the interface service.

Create PIPerfMon Diagnostic Health Points

For diagnostics, associate the PIPerfMon interface with the health tags that monitor a device 
heartbeat. The heartbeat count helps to determine if the system is working efficiently. If 
there’s a stoppage, you can analyze what prompted the fault or device error.

1. Go to Rockwell Software > FactoryTalk Historian SE > Interface Configuration Utility and 
select the PIPerfMon for the interface.

2. Create the Health Points for PIPerfMon.DeviceStatus.

3. Create the Health Points for PIPerfMon.Heartbeat.

IMPORTANT The Point Source name must match the interface name that you 
typed in the Historian Production dialog box in step 3 on 
page 198.
The Interface ID number must be unique in the system.

ASIH01
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4. Go to Service and complete the following information.

5. Go to Control Panel > Administrative Tools > Services. 
6. Select PI Buffer Subsystem, and set the Startup type to Automatic.

7. Restart the interface service from the dialog box.

Test the PIPerfMon Interface

From the primary Historian sever, verify that the PIPerfMon interface has a good working 
status.

1. Go to Rockwell Software > FactoryTalk Historian SE > System Management Tools.
2. In the left, top pane, select the appropriate server with the interface.
3. In the lower, left pane, go to Data folder > Current Values.

From this Section Action
Installed Services Move pibufss to Dependencies
Service Configuration Select Log on as: Domain\Username
UserName Enter the same user name and password that you initially 

created for the service. See Create Domain User for PIPerfMon 
Service on page 196Password

ASIH01
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After you search for tags you need, the Value category displays the health state of 
the interface and the number of seconds between the heartbeat counts.

Enable the PIPerfMon Interface on other Computers

After the PIPerfMon interface is verified to work correctly on the Historian server, you can 
configure the other servers and workstations that you’re collecting data. This requires the 
domain account to allow PIPerfMon to be added, create a Windows Firewall rule for access and 
enable the Performance Counter DLL Host service.

1. Go to Control Panel > User Accounts and define this information.

2. Go to the Control Panel > Windows Firewall and define
this information.

3. Go to Control Panel > Administrative Tools > Services and find Performance Counter 
DLL Host.

From this Page Action
Control Panel\User Accounts Select Manage User Accounts
User Accounts Select Add

Add a User Enter the same user name and Domain that you did to grant 
system access for the PerfMon service. See step 4 on page 200

What level of access do you want to grant this 
user?

Select Other and choose Performance Monitor Users from the 
pull-down.

From this Page Action
Control Panel\Windows Firewall Select Advanced settings

Advanced Settings

Create a new inbound rule.

New Inbound Rule Wizard: File Type Select Port
New Inbound Rule Wizard: Protocol and Ports Select TCP and enter the Specific local ports: 135 and 445
New Inbound Rule Wizard: Action Select Allow the connection
New Inbound Rule Wizard: Profile The rule applies to Domain, Private, and Public.

New Inbound Rule Wizard: Name Enter a name for the rule. 
For example, Perfmon Connection

EWS OWS
Domain

Controller PASS01

ASIH01
ASIH02

PASS02A
PASS02B
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4. Right-click Performance Counter DLL Host and select Properties.

5. Select Automatic as the Startup type.

Configure PI Buffering PI Buffering helps to protect local data in the event a client loses connection to the Collective.

Create Domain User for PI Buffer Service

The PI Buffer service defaults to running in a local account. For PlantPAx systems with a 
domain, it’s recommended running the PI Buffer service in a domain account. This enhances 
security and provides access among other domain computers.

The domain user account for PI Buffer service must be created on the domain controller. It’s a 
user account with privileges to run the service on other computers within the domain.

1. From the Server Manager, click Tools and choose Active Directory Users and Computers.
2. Expand your domain folder, right-click Managed Service Accounts and choose 

New>User.
3. Complete the User text boxes.
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4. Type your password twice.

5. Make sure that the following boxes are checked:
• User cannot change password
• Password never expires (indefinite service for system access)

Item Description

First name
Type a name for the PI buffering service.
IMPORTANT: The ‘PI’ preface is the name of the OSISoft 
product.

Initials Optional; you can leave blank.
Full name Type the same name for the PI buffering service.

User login name
Type the same name for the PI buffering service
and click the pull-down menu to select your
domain folder.

User logon name (pre-Windows 2000) Use the SYSTEM\ default and type the same name for the PI 
buffering service.

IMPORTANT The logon password creates a service user, not a person. The 
service user grants access to system computers for placing data 
into memory (buffer).
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Create Security Mappings

On the Historian server, associate the service user identity with the Historian mapping and 
trusts.

1. Go to Rockwell Software>FactoryTalk Historian SE>System Management Tools.
The PI System Management Tools window appears.

2. Do the following:
• Under Servers, check the server that you want to set the

security settings
• Under System Management Tools, choose Mappings & Trusts
• Click Add Mapping icon
• From the Add New Mapping dialog box (right pane), click

Browse (ellipsis '…')
3. Select the PIBufferService user that you created earlier.

4. On the Add New Mapping dialog box, click Browse and select a group from the Type pull-
down menu.
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5. Select a desired identity.

6. Click Create.
Your security mapping should look similar to the example.

Configure the Buffering Interface

Configure buffering for the server that you’re connected, such as PASS02A
and PASS02B.

1. Go to Rockwell Software>FactoryTalk Historian SE>Interface Configuration Utility.
The PI Interface Configuration Utility dialog box appears.

2. From the Tools menu, choose Options.
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3. Click 'Load interfaces from a selected list of PI Data servers'.

4. Select a server box.
5. From the Tools menu, choose Buffering.
6. Message windows appear.
7. Click Yes, and then 'Continue with configuration' to initiate the Buffering Manager 

wizard.
8. Complete the Buffering Manager wizard.

9. From the PI Interface Configuration Utility dialog box, click Tools menu and choose 
Buffering.

10. Verify that your information matches the dialog box example.

11. Close the Buffering Manager dialog box.
12. From the PI Interface Configuration Utility dialog box, click Tools menu and choose 

Options.
13. From the Options dialog box, check 'Load interfaces from a selected list of PI servers' 

and make sure that the server is checked.

Item Description
Detected PI Interfaces Select the PI interfaces that you’re buffering and click Next.

PI Data Archive security
Click Change, and enter the user name and password that you 
created earlier. Click Next.
Click Next twice, and then ‘Exit new installation wizard’.

Buffering Manager message windows Click Yes and OK to confirm PI ICU dependency.
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Configure the PI Buffer Service Logon

The following procedure applies only if the Change Option wasn’t available on the New Install 
Wizard dialog box.

1. On the PASS server, right-click Start menu and choose Computer Management.
2. Complete the New Install Wizard dialog box.

Configure Historian Data 
Collection

The procedures in this section use the 'System Management Tool' and PI System Explorer 
within FactoryTalk Historian software. The tool is available for Historian Asset Framework 
management computers, such as server, node interface, and EWS.

Microsoft® Excel® software is required to enable the bulk editing capability. An additional 
license is required to use PI Datalink.

We also document how to manually create Historian tags, digital states, and Asset Framework. 
We recommend using the section “Configure Asset Framework Databases with the PlantPAx 
Configuration Tool” on page 220 for creating bulk tags for large process systems.

Create Digital States

Historian points can be defined as analog or digital. Digital points can be used to enumerate 
the process states, thus creating a relationship between the value and the text state name. For 
example: 1 = Good.

1. Go to Rockwell Software > FactoryTalk Historian SE > System Management Tools and 
select Points > Digital States

2. Add a Digital State Set to the server.

Item Description
Local User and Group (left pane) Open Local Users and Groups, right-click Groups and choose Administrators.

Add name
Click Add and type
SYSTEM\pibufferservice.

Click Check Names, and click OK.

Assign log on service account

From the Start menu, click Programs and choose Administrative 
Tools>Services.
Right-click PIBuffer Subsystem and choose Properties.
On the Log On tab, click Browse. 
Click Locations, choose 'Entire Directory', and click OK.
Enter SYSTEM\pibufferservice and click Check Names.
Click OK.

ASIH01
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Source Quality Data Examples

Import Digital Sets and States

To save time entering common Digital Sets and States, templates are available to import.

A Process Objects Digital Set is available from the PlantPAx Process Library. After downloading 
the library, the Templates folder contains Historian files.

The PIPermon Digital States are available from a local template in the installation directory.
1. Go to Rockwell Software > FactoryTalk Historian SE > System Management Tools and 

select Points > Digital States

Parameter Data Type Description

SrcQ SINT

Final PV source and quality.
GOOD 0 = I/O live and confirmed good quality 

1 = I/O live and assumed good quality 
2 = No feedback configured, assumed good quality 

TEST 8 = Device simulated 
9 = Device loopback simulation 
10 = Manually entered value 

UNCERTAIN 16 = Live input, off-specification 
17 = Value substituted at device/bus 
18 = Value substituted by maintenance (Has and not Use) 
19 = Shed, using last good value 
20 = Shed, using replacement value 

BAD 32 = Signal failure (out-of-range, NaN, invalid combination) 
33 = I/O channel fault 
34 = I/O module fault 
35 = Bad I/O configuration (for example, scaling parameters) 

ASIH01
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2. Select Import.

3. Select the PI_PIperfmon_DS.csv file for the Comma delimited file with sets and states. 
The file is located in C:\Program Files (x86)\Rockwell Software\FactoryTalk 
Historian\PIPC\Interfaces\PIPerfMon.

4. Select Create the Set(s). 
A minimum number of the recommended Digital Sets is created. This procedure does 
not create the basic Digital Set file for all Process Objects digital states.

Create Individual Historian Points

You can create historian points by using the FactoryTalk® Administration Console. Define 
these points from an engineering workstation or an Historian server. The following is one 
example. 

1. Go to Rockwell Automation Software > FactoryTalk Administration Console and select 
the network for the type of FactoryTalk directory.

EWS

ASIH01
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2. In the Explorer pane, select an application (PlantPAx is our example) and choose Add 
Individual Historian Points.

3. On the Add Historian Points dialog box, select Browse Tags.
4. In the Tag Browser window, select an object tag (TT01001 in the example) in the Folders 

pane on the left side of the window.

5. In the pane on the right side of the Tag Browser window, double-click the tag to 
configure as a Historian Point.

Val (Process Variable Value) is the example.
6. Select Add Tags to List and OK to accept the tags in the list.
7. Go to Rockwell Software > FactoryTalk Historian SE > System Management Tools.
8. In the Servers Pane (or the Servers and Collectives pane if you’ve a collective), select 

the historian server.
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9. Select Point Builder and search for tags.

10. In the Tag Search window, type the Tag Mask and select Search.
You can use an asterisk (*) for a wildcard. The point name and entire path appear on 
the Point Builder window.

11. Select the tag and select OK. 
12. Select the tag and select Rename.
13. Enter a new name in the Rename PI Point dialog box. 

The name must be modified as OPCTopic.Backingtag.parameter in order to populate 
a historical trend in the PlantPAx faceplate. In the following example it 
isLGXC01.TT01001.Val.

14. In the General tab of the Point Builder dialog box, enter a tag description and 
engineering units.

15. In the Archive tab, configure the range (Zero and Span), typical value, and all exception 
and compression data for the historical point. 

IMPORTANT Usually, Minimum Range Value = Zero, Span = Maximum Range 
Value minus Minimum Range Value. The Typical Value is between 
the Minimum Range Value and the Maximum Range Value.
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16. Select the Classic tab, to view the historical tag path (instrument tag) that includes the 
Data server name.

This example shows the FactoryTalk® Linx name, PlantPAx_DAT.
The historical point link is broken if any change is made to the FactoryTalk® Linx application 
name.

Monitor Historical Data

From the primary Historian server, use the PI System Management Tool to verify Historical 
data has good values.

1. Go to Rockwell Software > FactoryTalk Historian SE > System Management Tools and 
select Current Values and select the search button.

2. Enter a tag mask or an asterisk (*) for all tags.
3. Select any tags that you wish to monitor.

4. To see values change as they periodically refresh, select the Play  button.



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 213

Chapter 9          Historical Data

Define Digital Historical Points

The digital set is available only to a digital points type. The FactoryTalk Administration Console 
automatically creates a Float32 (Real) point type for each new point. 

1. Go to Rockwell Software > FactoryTalk Historian SE > System Management Tools
2. To be able to change the digital set, select Digital for the Point type and then select a 

Digital Set (SrcQ in the example).

3. Select the Save  icon to store the Historian point.

Historian Asset Framework Use the FactoryTalk Historian Asset Framework to build and deliver model-driven analysis and 
reporting solutions.

Configure the Connections to the Servers

When a Historian Collective is used, the Asset Framework server and PI Analysis Service must 
be installed on a separate computer, such as a dedicated SQL server.

1. Go to Rockwell Software > FactoryTalk Historian SE > System Explorer (64-bit) and 
select File to choose Connections.

2. Select the data collective (ASIH01) and choose Properties.
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3. Rename or configure this connection as necessary for your system.

4. Select the Asset Server (ASIS01) and choose Properties.

5. Rename or configure this connection as necessary for your system.

Import Asset Framework Templates

An asset framework provides a means to organize your process equipment assets. Asset 
Framework Templates are provided in the process library. This download is available online 
from the Product Comparability and Download Center (PCDC).

1. Go to Programs > Rockwell Software > FactoryTalk Historian SE > System Explorer (64-
bit).

2. Select Yes from the Create Database dialog box to create a user database.
3. Enter the name of the user database.

IMPORTANT Steps 2 and 3 are only performed the first time that you name the 
database.

https://compatibility.rockwellautomation.com/Pages/home.aspx
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4. Select Library in the lower, left pane, select the database name and choose Import from 
File.

5. Browse in your system files to the 
(RA-LIB) AssetFramework_Templates .xml file and open the file.

There are these template files:
- Base Asset Framework Template File for standard Asset Framework functionality for 

the process library, release 4.1 and 5.0. 
- Advanced Asset Framework Template File for use with SQL Server Reporting Services 

reports. These objects use the base template, with additional parameters to enable 
reporting functionality. 

6. Accept the default import options.
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The database now contains the Library object templates.

Configure Asset Framework Elements

Associate the tags with historian elements, which are the Process object templates 

The term ‘element’ is used in the Asset Framework software. For PlantPAx system purposes, 
‘element’ can be considered synonymous with ‘objects’ in the process library.

1. Go to Programs > Rockwell Software > FactoryTalk Historian SE > System Explorer (64-
bit).

2. Select Elements in the lower, left pane, select Element and create a New Element.

3. Select P_AIn in the Choose Element Template dialog box.

Objects
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4. Type the tag name that is being assigned to the object and check it in.

5. Confirm the settings and Check In again to complete the check in process.
6. The current historical value is accessed by selecting the Attributes tab and refreshing.

Search Event Frames

You can search for event frames, for example, if you want to find abnormal conditions that 
triggered an event.

1. Go to Programs > Rockwell Software > FactoryTalk Historian SE > System Explorer (64-
bit)

2. Select Elements in the lower, left pane of the PI System Explorer dialog box and then 
select the Analyses tab.



218 Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025

Chapter 9          Historical Data

Finding Faults for Analysis

You can also search event frames to assess faults.
1. Go to Programs > Rockwell Software > FactoryTalk Historian SE > System Explorer (64-

bit)
2. Select Event Frames in the lower, left pane, select Event Frame Searches and choose 

New Search.

3. Select the desired search criteria and any filters. 
The search results for the selected criteria appear at the bottom of the dialog box.

4. To view elements (tags) that are associated with the fault for the selected search 
criteria, double-click a fault.

5. Select the Referenced Elements tab.
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Each tag (and description) that is assigned to the element appears.

6. To view a description of the abnormal condition, select the
Attributes tab.

Tools for Creating Historian 
Tags

Depending upon how far along you are in your process application build, these can help create 
tags and other bulk code:

• Application Code Manager software
• PlantPAx Configuration tool
• PI Builder Add-in for Microsoft Excel

Application Code Manager

Application Code Manager (ACM) software supports a historian library to assist with creating 
historian tags.

Use ACM to create the historian tags when your control strategies in ACM are in the final stages 
and ready to generate a Logix 5000 Controller .ACD file.

See Chapter 6, Use ACM to Create an Application for specific details on ACM.

After ACM generates historian tags, the .CSV file needs to be copied to the computer that has 
PI Builder Add-in for Microsoft Excel installed to publish the tags into the historian database.

PI Builder Add-in for Microsoft Excel

PI Builder is a Microsoft Excel add-in that lets you use Excel to create, view and modify PI 
points and Asset Framework objects in your Historian database. With PI Builder you can make 
bulk tag edits by importing and exporting your spreadsheet.

All functionality of the prior PI Tag Configurator has been replaced with PI Builder, which is 
included with the PI SMT and PI Data Archive setup kits (as part of the PI AF Client installer).

If Microsoft Excel was installed after the Historian software, the PI AF Services will need to be 
modified to include the PI Builder feature.

1. To start the modification, run file named <PI-AF-Services_2017-R2A_.exe> located in the 
\Redist\PIAFSetup\ directory of the Historian SE software installation media.

A maintenance dialog prompts to modify, repair, or uninstall the PI AF Services 2017 
R2 installation.

IMPORTANT If additional control strategies are created using the Logix 
Designer application, then ACM won’t be able to generate the new 
historian tags. In this scenario, the PlantPAx Configuration Tool 
may be considered to create the historian tags.

IMPORTANT Microsoft Excel 32-bit software must be installed for these 
procedures.
This section uses Microsoft Excel 2013. Your version could be 
different.
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2. Choose to Modify the installation and click Next.
3. Select PI Builder from the list of Features and click Next.

4. Restart the computer after the installation is complete.

To retrieve and publish PI AF objects, PI Builder must connect to a PI AF database and for PI 
points a PI Data Archiver server.

1. Open your version of Microsoft Excel and click the PI Builder tab.
2. In the Connections group on the upper left corner. Select your Data Server, Asset Server, 

and Database as available. 

For information on how to publish your historian tags to the historian database, see the PI 
Builder add-on Help section.

Configure Asset Framework Databases with the PlantPAx 
Configuration Tool 

Use the PlantPAx Configuration tool to configure Asset Framework databases with Logix tag 
elements. This includes the automatic configuration of related PI points in the FactoryTalk 
Historian data server (PI data server).

This procedure assumes that the controller, HMI server, and the alarm server are configured 
for using the PlantPAx Configuration Tool.

1. Open the PlantPAx Configuration Tool.
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2. Add the Historian Server.

From this Page Action
Add Historian Server Type the name of the historian server.
Select Controllers for Building Data Points in Historian 
Server

Enter the server collective name and select the 
applicable controllers.
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3. Select the Historian server that you just created (Production Historian in our example), 
and select to Import to Asset Framework (AF) Database

Verify Asset Framework Library and Elements

After using the PlantPAx Configuration Tool, you must verify that the asset framework library 
and elements are properly imported into the Asset Framework database.

1. Go to Programs > Rockwell Software > FactoryTalk Historian SE > System Explorer (64-
bit).

From this Location Action
Build Tags: Setup Tab Select Connect
Connect dialog Box Set the PI Server, AF Server, and AF Database

OK Connected dialog box Verify that you’re connected to the PI Server, AF Server, 
and AF Database

Build Tags: Setup Tab Select PI Point Builder Options
FactoryTalk Historian Import File Builder Options dialog 
box: Naming tab

Use the controller name as a prefix to Historian tags. For 
example, LGXC01.<tagname>

Build Tags: Information Tab Review and verify the information
Build Tags: Build Tab Select Build
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2. Select Library in the bottom left of the system explorer and verify the contents of the 
library.

3. Select Elements in the bottom left of the system explorer and verify the elements.
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Notes:
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Batch Management
PlantPAx® systems support scalable options for batch management that are based on ISA88 
standards and can help:

• Automate sequences to reduce time-to-market
• Manage recipes and procedures to focus on yield, throughput, and quality
• Provide models to improve traceability, reporting, and approval controls.

Select the Batch Solution Scalable offerings and tools range from controller-based to enterprise-wide solutions.

Logix Batch and SequenceManager Requirements

The Logix Batch and SequenceManager™ option consists of controller code and visualization 
elements. You need:

• Logix 5000® controller
• FactoryTalk® View Studio software
• Logix Batch and Sequence Manager files

For more information, see Logix Batch and Sequence Manager.

Feature Logix Batch & Sequence 
Manager SequenceManager FactoryTalk Batch

Deployment Logix controller code Firmware-based controller feature Server-based application

Supported controllers
ControlLogix® 5580
CompactLogix™ 5380
ControlLogix 5570
CompactLogix 5370

ControlLogix 5570
CompactLogix 5370
ControlLogix 5580
CompactLogix 5380

ControlLogix 5580
CompactLogix 5380
ControlLogix 5570
CompactLogix 5370

Units Single unit recipes Single unit recipes Multiple unit recipes
Phase construction PhaseManager™ programs PhaseManager programs PhaseManager programs
Phase interface Phase and bit logic Dropdown menu Dropdown menu
Max recipes/steps/phases 32 Limited by memory or resources Limited by memory or resources
Max input/report parameters 4 No max No max
Parameter expressions No Yes Yes

Parameter data types BOOL
REAL

BOOL
INT, INT, DINT
REAL

BOOL
SINT, INT, DINT
REAL

Procedural structure Sequential
Concurrent

Sequential
Concurrent
Divergent
Recurrent

Sequential
Concurrent
Divergent
Recurrent

Recipe design Tabular HMI configured SFC like SFC like
Recipe editing Runtime via HMI Import only at runtime Runtime editing via Recipe Editor

HMI integration Faceplates 3 Active X 4 Active X
API

Batch reporting Queue controller services Event client and archive services Event client and archive services
FactoryTalk Batch integration No Yes —
Dynamic unit binding No No Yes
Unit arbitration No No Yes
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SequenceManager Requirements

SequenceManager controls direct PhaseManager programs in this controller-based option. 
You need:

• Logix 5000 controller
• FactoryTalk View Studio software
• SequenceManager software

For more information, see SequenceManager Controls.

FactoryTalk Batch Requirements

A FactoryTalk Batch application is a server-based option.

AppServ-Batch application server with:
• FactoryTalk Batch server
• FactoryTalk® eProcedure® server
• FactoryTalk® Event Archiver database

AppServ-Info SQL server with:
• SQL server
• FactoryTalk Batch Material server
• Master Recipe storage

For more information, see Factory Talk Batch Application on page 228

The batch solutions work with each other to provide a comprehensive solution.

For more information, see these additional resources.

Resource Description
PlantPAx Logix Batch and Sequence Manager Reference 
Manual, publication PROCES-RM007

Provides procedures on how to use LBSM to store recipes and sequences equipment and phases to make 
products.

SequenceManager Controller Reference Manual,
publication 1756-RM101 Describes how to install, configure, and run SequenceManager Controls.

FactoryTalk Batch User Manual, publication BATCH-
UM011

Contains instructions for configuring security and services, and implementing components, such as the 
FactoryTalk Batch server, simulator, and performance chart.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/1756-rm101_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/batch-um011_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/batch-um011_-en-p.pdf
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Logix Batch and Sequence 
Manager

The Logix Batch and Sequence Manager application is controller-resident batch execution for 
single-unit or multiple-independent unit operations.

An LBSM application is best for:
• Single-unit batch processes, with 5…10 recipes, that can be defined with

four real and four Boolean parameters per phase
• Processes that need frequent recipe changes
• Systems where recipe changes must be made through an HMI
• Process skids
• Pilot plants

LBSM Details

The LBSM application provides controller logic and HMI objects.

An LBSM application supports:
• PhaseManager programs and custom sequences
• Maximum of 32 recipes per controller
• Maximum of 32 steps per recipe
• Maximum of 4 real and 4 Boolean Parameters/phase
• Recipe changes are made from the HMI

For more information, see PlantPAx Logix Batch and Sequence Manager Reference Manual, 
publication PROCES-RM007.

PlantPAx Batch Design Considerations Reference 
Manual, publication PROCES-RM008 Provides guidance on selected batch implementation topics in a PlantPAx system.

Batch Application Toolkit Quick Start,
publication IASIMP-QS042 Provides a framework for how to use the tasks to complete the components of the Toolkit.

PhaseManager User Manual, publication LOGIX-UM001 Provides instructions on how to configure and use a Logix 5000 controller with equipment phases.
FactoryTalk Batch PhaseManager User Manual, BATCHX-
UM011

Provide instructions on how to use phase logic to integrate FactoryTalk Batch software with a Logix Designer 
application.

Resource Description

http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm008_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/qs/iasimp-qs042_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/logix-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/batchx-um011_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm007_-en-p.pdf
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SequenceManager Controls SequenceManager is a firmware-based feature that directs PhaseManager programs inside a 
Logix 5000 controller in an ordered sequence.

A SequenceManager application is best for:
• Small batch systems (single unit)
• Systems with no server connectivity
• Process skids

• Modular systems connected into larger FactoryTalk Batch processes
• Fast processes

SequenceManager Details

The Logix controller must have firmware support to implement a SequenceManager 
application. Not all controllers support the SequenceManager application.

Use the SequenceManager to model and execute sequential manufacturing processes using 
the ControlLogix features described in the following tasks:

• Configure the coordination of Equipment Phase execution using the Equipment 
Sequence Editor.

• Execute Equipment Sequence programs using ControlLogix.
• Monitor and manage running Equipment Sequences using the Logix Designer 

application.
• Enable operators to monitor and manage running Equipment Sequences and Equipment 

Phases by adding SequenceManager ActiveX controls to FactoryTalk® View SE displays.
• Subscribe and collect generated sequence events using SequenceManager Event Client 

Service and SequenceManager Event Archiving Service.

For more information, see SequenceManager Quick Start Guide, publication 1756-QS109.

Factory Talk Batch 
Application

A FactoryTalk Batch application is a server-based, comprehensive approach to batch 
management.

• Handles complex unit coordination, resource arbitration, and optimization of routes
• Manages recipes including formulations, scaling, secure approvals, and versioning

Editor – Logix Designer application
Define a procedural sequence that 

coordinates the execution of 
equipment phases

Operator – FTView SE
Monitor and interact with a running 
procedural sequence in the HMI

Data Collection & Reporting Services
Generate events used to produce 

batch reports and procedural analysis

https://literature.rockwellautomation.com/idc/groups/literature/documents/qs/1756-qs109_-en-p.pdf
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• Includes integrated visualization and reporting

A FactoryTalk Batch application is best for:
• Multi-unit batch control
• Integration of process skids
• Integration with third-party systems

FactoryTalk Batch Details

A maximum of 10 FactoryTalk Batch servers can exist in a PlantPAx DCS. Follow these 
guidelines when you install FactoryTalk Batch on the AppServ-Batch server:

• Install the FactoryTalk® eProcedure® server on the same computer as the FactoryTalk 
Batch server.

• Install the FactoryTalk Batch Material server on a computer with the
SQL server. The computer must be different than the computer that hosts the 
FactoryTalk Batch server.

• Install the FactoryTalk Event Archiver Database and Management Tool on another 
server from the FactoryTalk Batch server.
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Example FactoryTalk Batch Network

For more information, see:
• PlantPAx Batch Design Considerations Reference Manual, publication PROCES-RM008
• FactoryTalk Batch User Guide, publication BATCH-UM011

FactoryTalk Batch Server 
with Redundant Controllers

Using a FactoryTalk Batch server with redundant controllers requires an understanding of the 
batch server hold/failure propagation behaviors.

Redundant ControlLogix 5580 controllers do not support ControlNet® communications. This 
means a FactoryTalk Batch application with active phases isn’t a bumpless event when a 
switchover from primary to secondary controllers occurs.

The phases switch over and remain in their respective state and code executes as expected, 
but the FactoryTalk Batch server observes a brief momentary communication loss over the 
EtherNet/IP™ network.

This communication loss is enough for the batch server to issue Hold propagation on all 
recipes with phase actively running in the controller than switched over. In this circumstance, 
the transitions in the recipe Held while the phases in the controller are still running.

Hold Propagation

The Hold Propagation area lets you indicate the hold propagation type to use when the 
FactoryTalk Batch server detects a failure that is caused by a watchdog timeout, a handshake 
timeout, or a phase failure (PHASE_F > 0).

No. Description No. Description
1 Site level 8 FactoryTalk eProcedure clients
2 FactoryTalk Batch Material Manager clients 9 FactoryTalk Batch server (1…10) and FactoryTalk eProcedure server
3, 14 FactoryTalk Batch Material server; FactoryTalk Event Archiver database 10 FactoryTalk Batch server connects to SQL server for Master Recipe storage
4 SQL server 11 FactoryTalk Batch View clients
5 FactoryTalk Batch clients 12 Proprietary network
6 TCP/IP 13 Process-connected device 
7 Plant floor

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm008_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/batch-um011_-en-p.pdf
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Hold propagation is a configurable selection that defines how the batch server reacts to 
failures that affect an active control recipe. Configure the selection in the Equipment Editor, 
which stores the value in the BATCHSVR.INI.

A Hold command that is associated with a failure propagates up through the recipe hierarchy 
as high as the mode and selected option allows.

The most common event to trigger Hold propagation is an abnormal process condition being 
continually monitored by the controller. 

When an abnormal process event occurs in the system, the controller logic sets phase failure 
for the appropriate phases actively running in the unit, or units. As a result, the phase failure 
tags are set with a value greater than zero value by the controller logic. The value corresponds 
with a known failure condition in the process. The batch server can display the failure to the 
operators and record the appropriate phase failure event. 

State Composite Evaluation

The Hold propagation configuration determines the highest procedure level within the running 
recipe for which the Hold command from the batch server is issued when a failure is detected. 

Hold Propagation Option Description

None The batch server does not issue a Hold command to any level of the running procedure for any phase 
failure. Therefore, the phase logic is solely responsible for putting a failed phase into Hold.

Phase

The batch server issues a Hold command to only the phase in which the phase failure occurred. This 
includes only the active step within the operation that experienced the failure, and not the active transition 
that belongs to the operation. Therefore, only the failed phase is commanded to Hold by the batch server 
and any other level of the batch remains unaffected such as, any running phase, operation, unit procedure, 
and the procedure itself

Operation

The batch server issues a Hold command to the running operation in which the phase failure occurred. This 
includes all active steps and transitions within the operation level of the batch. Therefore, all running 
phases within this operation, and the active operation transitions are commanded to Hold by the batch 
server. Any other running operation, unit procedure, and the procedure itself aren’t affected by the Hold 
command; the batch server does not propagate the Hold command to these other levels of the batch. 

Unit

The batch server issues a Hold command to the running unit procedure in which the phase failure occurred. 
All running phases and operations within this unit procedure, and the unit procedure itself, are commanded 
to Hold by the batch server. This includes all active steps and transitions within these specific levels of the 
batch operations and the unit procedure. Any other running unit procedure and procedure itself aren’t 
affected by the Hold propagation; the batch server does not propagate the Hold command to these other 
levels of the batch.

Batch
The batch server issues a Hold command to the entire running procedure in which the phase failure 
occurred. All running phases, operations, unit procedures, and the procedure itself, are commanded to Hold. 
This includes all active steps and transitions within all levels of the batch.
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The state of each batch level (such as procedure, unit procedure, operation) is continually 
evaluated by the batch server. Each batch level state is based on the composite states of its 
underlying steps and transitions.

• In the case of an operation, the composite state is based on the state of all active 
phases and the state of their underlying active phases transitions.

• In the case of the unit procedure, the composite state is based on the state of all active 
operation steps and the state of their underlying active operation transitions.

• In the case of the procedure, the composite state is based on the state of all active unit 
procedure steps and the state of their underlying active unit procedure transitions.

If the owner of the step (a phase) is EXTERNAL, then the step isn’t considered in the 
calculation.

The determining state for any procedure level (procedure, unit procedure, or operation) is 
based on the states of the active recipe elements it contains – both, steps and transitions. All 
these S88 procedure levels are virtual to the PC memory in the batch server, except for 
SequenceManager operations which reside in the controller, much like most phases. 

When a procedure level of a control recipe is connected and commanded by the batch server, 
the state of each of its procedure levels is derived by a composite state analysis to determine 
a final state for each procedure level. As the path of recipe execution proceeds through a 
control recipe, the state of each recipe element object is dynamic, and is continuously 
updated. The state with the highest priority becomes the state of the procedure level for an 
operation, unit procedure or procedure. 

• In the case of an Operation procedure level, the composite state is based on the state of 
all active phases e active transitions within the operation. 

• In the case of the Unit Procedure level, the composite state is based on the state of all 
active operation steps and active transitions within the unit procedure. 

• In the case of the Procedure level, the composite state is based on the state of all active 
unit procedure steps and active transitions in the procedure.

Types of Failures

The batch server translates a phase failure value to an enumeration string that presents an 
actionable string of text to the operators for the type of failure. A phase failure is the most 

Order of Precedence for Batch States

State Element Type Priority
RESTARTING Step‘ 12 (highest)
HOLDING Step 11
ABORTING Step
RUNNING Step 9
ARMING Transition 9
ARMED Transition 9
FIRING Transition 9
STARTING Step 8
STOPPING Step 8
HELD Step 6
HELD Transition 6
IDLE Step 5
ABORTED Transition 4
ABORTED Transition 4
STOPPED Step 3
STOPPED Transition 3
COMPLETE Step 2
NOTCONNECTED Step 1
UNKNOWN Step 0 (lowest)
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common type of failure. Other types of failures may occur in the batch system such as, a 
parameter download failure, a report upload failure, a failed phase request, a request timeout, 
a command timeout, a quality tag status other than good, a watchdog failure, or a 
communication failure.

In most cases, the batch server reacts to these failures just as it does for the phase failure 
event with Hold propagation. An exception occurs whenever the batch server experiences a 
communication failure to a controller, a data server, or a phase.

When communication to the controller or phase is compromised, the Hold propagation only 
acts on the components of the control recipe that are without risk, or internal to the batch 
server memory (procedure, unit procedure, operation). In this case, the risk pertains to those 
components where the phases or SequenceManager operations reside, so Hold propagation 
isn’t executed to the phase level or SequenceManager operations.

If communications are restored quickly so the watchdog in the controller does not time out 
and place the running phases into a Held state, running phases stay running as if nothing 
occurred. If communications are restored quickly and the controller phases aren’t configured 
to Hold upon communication loss, then running phases also stay running as if nothing 
occurred.

This momentary communication blip where phases remain running can cause a dynamic when 
all other levels (procedure, unit procedure, operation) are sent Hold commands upon failure 
according to the Hold propagation configuration. As a result, these procedure levels are Held 
but the composite state of a running phase and Held transition is running state for the 
operation. This traverses up the control recipe where a running operation step and a Held unit 
procedure transition evaluates as a running state for the unit procedure, and so on one more 
level to the procedure. With transitions Held, the recipe can’t move transition to other steps, 
and the recipe could act to an untrained operator as though it’s hung, or unresponsive. One 
solution is to issue a Hold command to the control recipe, then a restart to the control recipe 
to get all steps and transitions in an active and running state as expected.

In the case of redundant systems with newer ControlLogix firmware revisions that do not use 
ControlNet communication, the switchover of the controllers where active phases are being 
run by the FactoryTalk Batch application isn’t a bumpless event. The phases switch over and 
remain in their perspective state and code executes as expected, but the FactoryTalk batch 
server observes a brief momentary communication loss. This loss is enough for the batch 
server to issue Hold propagation on all recipes with phase actively running in the controller 
than switched over. In this circumstance, you can find transitions in the recipe Held while the 
phases in the controller are still running.
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Notes:
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Automatic Diagnostics

Automatic diagnostics is a system-level feature in devices that provides device diagnostics to 
HMIs and other clients, with zero programming. Devices that support automatic diagnostics 
have the feature enabled by default.

You can deactivate and activate the whole feature while online or offline from the Controller 
Properties dialog box. You can also deactivate automatic diagnostics for a specific device in 
the module properties.

Configure Automatic 
Diagnostics

On the Controller properties Advanced tab, Enable Automatic Diagnostics is a new feature that 
was added with the process controllers, firmware revision 33. When enabled, it sends analog I/
O modules diagnostic information to the Automatic Diagnostics Event Summary object.

If deactivated, you only see Mode changes and loss on communication with controllers in the 
Automatic Diagnostics Event Summary object. 

The automatic diagnostics feature is enabled by default in the Logix Designer application. The 
deactivation of automatic diagnostics at the device level deactivates all device-driven 
diagnostics. You still get device faulted/communication loss diagnostics as the controller 
drives these diagnostics.

Automatic Diagnostics on 
FactoryTalk View SE

You can use the Subscribe To setting under FactoryTalk Alarms and Events in FactoryTalk Linx 
to activate or deactivate diagnostic information that is sent to the Automatic Diagnostics 
Event Summary object.

IMPORTANT Verify that FactoryTalk Alarms and Events is installed and configured before attempting to view automatic 
diagnostics. For more information, see publication FTAE-RM001.

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/ftae-rm001_-en-e.pdf
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Subscribe To
1. To adjust your automatic diagnostics, access the Communication setup and select your 

device.

2. To receive all notifications from your devices, set the Subscribe To setting to All Alarms 
& Events Notification Messages.

If the Subscribe To is set to Only Alarms Notification Messages, then the Automatic 
Diagnostics Event Summary object is blank.

View Automatic Diagnostic Messages

Events are delivered through FactoryTalk® Alarms and Events (FTAE) with FactoryTalk View 
Site Edition (SE) v12 and greater as a Display Client™.

Figure 14 - FTView SE v12.0 Automatic Diagnostics Example

To view these diagnostic messages, you need:
• FactoryTalk Alarms and Events, version 6.20 and greater
• FactoryTalk View SE, version 12 and greater

Automatic diagnostics are enabled by default. Check the configuration of your device to see 
whether the firmware supports automatic diagnostics.

Automatic Diagnostics History

FactoryTalk Alarms and Events (FTAE) keeps a historical log all Automatic Diagnostics activity. 
The historical log is stored in the same SQL database as the FTAE alarms. FTLinx must be 
configured to log alarm and event historical information into the SQL database. In the FTView 
SE application, the historical log is viewed using the data grid control. From the data grid, you 
can export to CSV.

IMPORTANT After Logix version 33 release, any device can participate in automatic diagnostics with an AOP update.
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Online Updates of Device Additional Diagnostics
• Additional device diagnostics are distributed with updated AOPs
• These additional device diagnostics can be added while online to a running controller
• You are notified that updates are available in the following ways:

- Project verification warning

- Information message in the controller Properties (Advanced tab)

Additional diagnostics can be downloaded to the controller by pressing the Update Project button.
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Notes:
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PlantPAx Security Certification
The PlantPAx® architecture supports IEC-62443-3-3 SL 1 security requirements. To help meet 
these requirements, reference these publications:

PlantPAx Security 
Architecture

Integrating industrial automation and control systems (IACS) with enterprise-level systems 
enables better visibility and collaboration, which helps improve efficiency, production, and 
profitability. But greater connectivity also exposes control systems to additional cybersecurity 
risks. Availability is the most crucial aspect of a secure IACS. To meet the needs of industrial 
environments, Rockwell Automation aligns PlantPAx systems that are developed on our 
technology with the international standard ISA-99/IEC 62443-3-3. This standard is designed 
specifically for Industrial Automation and Control Systems and defines procedures to 
implement an electronically secure system.

ISA-99/IEC 62443 is based on seven foundational requirements that cover a defense-in-depth 
approach that is suited for an IACS. These foundational requirements are:

• FR1: Identification and authentication control (IAC) 
• FR2: Use control (UC) 
• FR3: System integrity (SI) 
• FR4: Data confidentiality (DC) 
• FR5: Restricted data flow (RDF) 
• FR6: Timely response to events (TRE) 
• FR7: Resource availability (RA)

The guidelines and checklists in this appendix present the collective strategy to meet the ISA-
99/IEC 62443-3-3 SL1 requirements in conformant PlantPAx systems. The intent of a certified 
architecture is to demonstrate security competency, as well as to provide a standard, 
prescriptive reference design. 

For this information See
Guidance on how to conduct security assessments, implement Rockwell 
Automation products in a secure system, harden the control system, manage 
user access, and dispose of equipment. 

System Security Design Guidelines Reference Manual, SECURE-RM001

Network architecture recommendations Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, 
publication ENET-TD001

Windows® infrastructure recommendations
How to configure and use these Rockwell Automation products:
• FactoryTalk® Directory
• FactoryTalk® Activation Manager
• FactoryTalk® Security
• FactoryTalk® AssetCentre

Security Configuration User Manual, publication SECURE-UM001. 

How to configure and use CIP Security™ with Rockwell Automation products to 
improve the security of your industrial automation system

CIP Security™ with Rockwell Automation Products Application Technique, 
publication SECURE-AT001

https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at001_-en-p.pdf
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The certified PlantPAx architecture relies on zones to segment the system.

CIP Security Zone
(See (See 

CIP Security Zone



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 241

Appendix A          PlantPAx Security Certification

Trusted Zones

ISA-99/IEC 62443-3-3 SL1 requires the capability to separate trusted and untrusted zones. You 
can use a standard firewall implementation to separate trusted traffic and untrusted traffic. 
Standard implementation creates two basic security zones that are known as inside and 
outside. The inside, or trusted zone, is also referred to as the private zone. The outside, or 
untrusted zone, is also known as the public zone. The public zone is outside the control of an 
organization and can be thought of as simply the public Internet.

Rockwell Automation recommends a risk assessment for network security zoning. Your risk 
assessment and risk posture help determine the trust level of each zone. You can have 
multiple levels of trust on inside zones with different types of access. For further guidance on 
risk assessments, see the ISA-99/IEC 62443-3-2 standard.

Certificate Authority

A trusted certificate authority, also known as a commercial certificate authority, is a third-
party entity that issues certificates for organizations that request them. They aren’t controlled 
in any way by the person or organization that requests a certificate from them. A trusted CA 
issues publicly trusted digital certificates that meet at least the minimum regulatory 
standards (baseline requirements) that are outlined by the CA/Browser Forum (CA/B Forum).

A private certificate authority, also known as private PKI, is an internal CA that exists within a 
larger organization (typically an enterprise) that issues its own certificates.

Zone Description

IDMZ
An IDMZ is required to connect to the corporate network. This zone contains a firewall stack, a pivot host, 
SEP Server and WSUS host. Additional hosts can be added, as needed.
Configure the IDMZ to separate untrusted (public) zones from the trusted (private) zones. Communication 
outside of the IDMZ is considered untrusted.

Application Server

The Application Server zone houses all application servers. Each server is deployed on a separate VM. The 
following mandatory nodes must be deployed:
• FactoryTalk Directory server 
• FactoryTalk® View SE HMI server
• FactoryTalk View Data server
Other optional servers include:
• FactoryTalk® Historian server
• FactoryTalk® AssetCentre server 
• SQL server

EWS/OWS

This zone contains the engineering workstations to provide programmer access and the operator 
workstations to provide operator access.
Each workstation has the necessary software to program or interact with the system. Workstations can be 
virtualized or they can be ThinManager® clients.

Each EWS has:
• Studio 5000® environment
• FactoryTalk View Enterprise Edition 
• RSLinx® Classic
• FactoryTalk AssetCentre client

Additional software includes:
• Studio 5000 Application Code Manager,
• Microsoft® Office
• PuTTY

Each OWS has the FactoryTalk View runtime client.
Additional software includes:
• FactoryTalk Historian client
• FactoryTalk AssetCentre client
• Microsoft Office

PRP The control system is segmented into process areas. Each process area contains the hardware necessary 
to run and operate that area. The topology of each area can be:
• PRP
• DLR
• Simplex

DLR

Simplex
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• A private CA functions like its public counterparts, but a private CA’s certificates are 
trusted only by its internal users, clients, and IT systems.

• A private CA issues certificates that restrict access to a select group of users.
• You must configure and host the private CA yourself.

For more information about CAs, see Microsoft Server Certificate Deployment Planning 
information or the Microsoft documentation for your operating system.

System Security Feature 
Checklists

Use the following checklists to secure your system.

Identify and authenticate all users.
Requirements for Identification and Authentication Control

Product Required to Meet IEC-
62443-3-3 SL 1 Details

Windows® infrastructure Yes

Configure and use the following:
• Create Active Directory groups and unique users for each zone
• Enable 802.1X authentication on all switchports
• Implement encryption algorithms for wireless access (such as WPA2 

Enterprise, TLS, or IPSEC)
• Implement public key infrastructure (PKI) certificates
• Authenticate Group membership via a RADIUS server
• Enable system notifications
• Configure Kerberos
• Configure an interactive login policy
• Monitor unsuccessful login attempts

For more information, see:
• Configure System Security Features User Manual, SECURE-UM001
• System Security Design Guidelines Reference Manual, SECURE-RM001
• Deploying 802.11 Wireless LAN Technology within a Converged Plantwide 

Ethernet Architecture Design and Implementation Guide, ENET-TD006
• Deploying Identity and Mobility Services within a Converged Plantwide 

Ethernet Architecture Design and Implementation Guide, ENET-TD008
• Site-to-Site VPN to a Converged Plantwide Ethernet Architecture Design and 

Implementation Guide, ENET-TD012

Password strength and 
recommendations Yes

Follow standard guidelines for password strength and recommendations

For more information, see:
• NIST Special Publication 800-63B Digital Identity Guidelines
• Configure System Security Features User Manual, SECURE-UM001
• System Security Design Guidelines Reference Manual, SECURE-RM001

Windows domain Yes

• Configure the PlantPAx domain controller.
• Configure all operating system clients as domain members
• Enable multi-factor authentication on the domain controller
• Create and manage all accounts in the Active Directory
• Require administrative credentials to manage account activities

For more information, see:
• Chapter 2 Domain or Workgroup
• System Security Design Guidelines Reference Manual, SECURE-RM001

https://docs.microsoft.com/en-us/windows-server/networking/core-network-guide/cncg/server-certs/server-certificate-deployment-planning
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td008_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td012_-en-p.pdf
https://pages.nist.gov/800-63-3/sp800-63b.html
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
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Define control policies to control the use between users and assets.

FactoryTalk Directory software
FactoryTalk Security software Yes

Configure appropriate:
• Users, groups, roles
• Security policies

For more information, see:
• Configure System Security Features User Manual, SECURE-UM001.
• System Security Design Guidelines Reference Manual, SECURE-RM001

Wireless access Optional

Configure and use the following:
• Implement encryption algorithms for wireless access (such as WPA2 

Enterprise, AES Encryption TLS, or IPSEC)
• Obtain access to the IACS from an untrusted network through the IDMZ with 

multi-factor authentication and certification-base authentication
• Use encryption tunnels (such as VPN and IPSEC) between VLANS
• Allow remote access only when necessary to authorized users in the Active 

Directory

Important: Hardwired connections are always preferred. Never use wireless 
connections for safety functions.

For more information, see:
• System Security Design Guidelines Reference Manual, SECURE-RM001

FactoryTalk Secure Remote Access
Optional
(Required if access via 
untrusted networks is 
desired)

Configure appropriate:
• Users, groups, roles
• Security policies
• Logging

By default,
MFA is enforced for all users
Traffic is encrypted

For more information, see: 
• Stratix 4300 Remote Access Routers user manual, 1783-UM014A-EN-P

Requirements for Identification and Authentication Control

Product Required to Meet IEC-
62443-3-3 SL 1 Details

Requirements for Use Control

Product Required to Meet IEC-
62443-3-3 SL 1 Details

Windows infrastructure Yes

Configure and use the following:
• Active Directory Groups for each zone
• Group membership authentication via RADIUS server
• 802.1X authentication on all switchports
• Session lock
• Remote session termination
• Concurrent session control
• Interactive login policy
• Notifications for unsuccessful login attempts

For more information, see:
• Configure System Security Features User Manual, SECURE-UM001
• System Security Design Guidelines Reference Manual, SECURE-RM001
• Deploying 802.11 Wireless LAN Technology within a Converged Plantwide 

Ethernet Architecture Design and Implementation Guide, ENET-TD006
• Deploying Identity and Mobility Services within a Converged Plantwide 

Ethernet Architecture Design and Implementation Guide, ENET-TD008

Windows domain Yes
Configure all operating system clients as domain members

For more information, see:
• Chapter 2 Domain or Workgroup

FactoryTalk Directory software
FactoryTalk Security software Yes

Configure appropriate
User Groups in each Area to support the segregation of duties and least 
privilege

For more information, see:
• Configure System Security Features User Manual, SECURE-UM001.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1783-um014_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td008_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
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Protect the integrity of transmitted data. Recognize changes to information during 
communication.

ThinManager software Recommended

Manage mobile and portable device access via a ThinManager server and route 
through the IDMZ. The ThinManager server limits mobile applications to view 
only.

For more information, see”
• ThinManager and FactoryTalk View SE Deployment Guide, TM-AT001
• ThinManager User Manual, TM-UM001

FactoryTalk AssetCentre software Yes

Configure and use the following:
• Auditable events
• Audit storage capacity
• Diagnostics and health log

For more information, see:
• System Security Design Guidelines Reference Manual, SECURE-RM001

Requirements for Use Control

Product Required to Meet IEC-
62443-3-3 SL 1 Details

Requirements for System Integrity

Product Required to Meet IEC-
62443-3-3 SL 1 Details

Windows infrastructure Yes
Configure and use the Active Directory and domain structure to handle authorization.

For more information, see:
• System Security Design Guidelines Reference Manual, SECURE-RM001

Converged Plantwide Ethernet 
architecture (CPwE) Yes

Configure the Industrial Demilitarized Zone (IDMZ) with appropriate firewalls.
Use TCP/IP connections between zones.

For more information, see: 
Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, ENET-TD001

Endpoint Protection Yes

Use endpoint protection to harden workstations. 

Important: Confirm that the endpoint protection solution does not affect control system 
processing

For more information, see:
• System Security Design Guidelines Reference Manual, SECURE-RM001

CIP Security™ Recommended

Use FactoryTalk® Policy Manager software (installed on the FactoryTalk Directory Server) 
to define communication between zones.

For more information, see:
• CIP Security with Rockwell Automation Products Application Technique, SECURE-AT001
• Deploying CIP Security within a Converged Plantwide Ethernet Architecture, ENET-

TD022
• FactoryTalk Policy Manager Getting Results Guide, FTALK-GR001

FactoryTalk AssetCentre software Yes

Configure and use the following:
• Change detection and reporting
• Scheduled backups

For more information, see:
• Configure System Security Features User Manual, SECURE-UM001
• System Security Design Guidelines Reference Manual, SECURE-RM001

PlantPAx process instructions and 
object library Recommended

The process instructions and library objects are designed to work with Rockwell 
Automation products to provide:
• Input validation
• Deterministic output
• Alarms and error handling

For more information, see PROCES-RM200

https://literature.rockwellautomation.com/idc/groups/literature/documents/at/tm-at001_-en-e.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/tm-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td022_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td022_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/gr/ftalk-gr001_-en-e.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
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Protect the confidentiality of communication and data to help prevent unauthorized 
disclosure.

Segment the network into zones and conduits to manage the flow of data.

Requirements for Data Confidentiality

Product Required to Meet IEC-
62443-3-3 SL 1 Details

Converged Plantwide Ethernet 
architecture (CPwE) Yes

Segment the network into the required zones and use firewalls.
Use conduits to zone-to-zone connections.
Use encrypted hard disk drives in computers.
If necessary, use cryptographic algorithms according to industry practices.

For more information, see:
• Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, ENET-TD001
• Deploying Industrial Firewalls within a Converged Plantwide Ethernet Architecture, 

ENET-TD002

CIP Security Recommended

Use FactoryTalk Policy Manager software (installed on the FactoryTalk Directory Server) 
to define communication between zones.

Note: Integrity only does not provide confidentiality. Use CIP Security confidentiality 
profile if confidentiality is desired.

For more information, see:
• CIP Security with Rockwell Automation Products Application Technique, SECURE-AT001
• Deploying CIP Security within a Converged Plantwide Ethernet Architecture, ENET-

TD022
• FactoryTalk Policy Manager Getting Results Guide, FTALK-GR001

Wireless access Recommended

Configure and use the following:
• Implement encryption algorithms for wireless access (such as WPA2 Enterprise, AES 

Encryption TLS, or IPSEC)
• Implement the PKI infrastructure to aid device authentication

For more information, see:
• System Security Design Guidelines Reference Manual, SECURE-RM001

Requirements for Restricted Data Flow

Product Required to Meet IEC-
62443-3-3 SL 1 Details

Converged Plantwide Ethernet 
architecture (CPwE) Yes

Segment the network into the required zones.
• Use a separate VLAN for each zone. 
• Firewalls provide additional protection

For more information, see:
• Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, ENET-TD001
• System Security Design Guidelines Reference Manual, SECURE-RM001

Virtualization Recommended For more information, see:
• Virtualization on page 247.

CIP Security Recommended

Use FactoryTalk Policy Manager software (installed on the FactoryTalk Directory Server) 
to define conduits.

For more information, see:
• CIP Security with Rockwell Automation Products Application Technique, SECURE-AT001
• Deploying CIP Security within a Converged Plantwide Ethernet Architecture, ENET-

TD022
• FactoryTalk Policy Manager Getting Results Guide, FTALK-GR001

Network Attached Storage (NAS) Recommended
Use Network Attached Storage (NAS) in a segmented location to store backups of virtual 
images, system documentation, and related files where a FactoryTalk AssetCentre 
application isn’t appropriate.

https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td022_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td022_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/gr/ftalk-gr001_-en-e.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td022_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td022_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/gr/ftalk-gr001_-en-e.pdf
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Collect and access security logs.

Maintain the availability of the system against the denial-of-service events.

Requirements for Timely Response to Events

Product Required to Meet IEC-
62443-3-3 SL 1 Details

FactoryTalk AssetCentre software Yes

Configure and use the following:
• Audit log accessibility
• Continuous monitoring

For more information, see:
• Configure System Security Features User Manual, SECURE-UM001.
• System Security Design Guidelines Reference Manual, SECURE-RM001

FactoryTalk Secure Remote Access 
Software

Optional
(Required if access via 
untrusted networks is 
desired)

For more information, see Remote Access on page 248

Individual products in the system Yes

Protect the internally stored audit logs in individual products in the system. 
Configure the FactoryTalk AssetCentre audit log to collect these individual audit 
logs.

For more information, see the user documentation for the individual products.

Threat Detection managed service Recommended

Monitor the detection service dashboard for:
• Risk & Vulnerabilities
• Alerts
• Events
• Unknown devices

PlantPAx recommends the use of threat detection services. Claroty CTD was 
tested on a PlantPAx Distributed Control System and no adverse impact was 
observed on the system.

Requirements for Resource Availability

Product Required to Meet IEC-
62443-3-3 SL 1 Details

Windows infrastructure Yes

Configure the operating system to prioritize control system functionality over 
antivirus checks and patching.
Network redundancy is highly recommended.
Configure virtualization software to manage service limitation.
Download software patches from trusted sources.

For more information, see:
• System Security Design Guidelines Reference Manual, SECURE-RM001

Managed switches Yes

Configure managed switches for both distribution and access functions.
Use QoS and ACLs to configure proper segmentation.

For more information, see:
• Chapter 4 Network Infrastructure
• Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, 

ENET-TD001

FactoryTalk AssetCentre software Yes

Configure and use the following:
• Asset inventory
• Control system backup
• Disaster recovery

For more information, see Configure System Security Features User Manual, 
SECURE-UM001.

UPS Yes
Provide your own UPS with separate battery unit and redundant power supplies.
Size the UPS so that is correctly supports the system and provides enough 
power to properly shut down servers and workstations.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/secure-um001_-en-p.pdf
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Virtualization The PlantPAx architecture uses virtual machines, VLANS, and zones to support partitioning 
data, applications, and services. Virtualization is preferred for all server and client operating 
systems. 

VLAN Recommendations

• Network Devices first 10 IP addresses start at .2
• Host IP addresses start at .12
• PRP zone devices (10.2...10.11) and hosts (10.12...10.63)

Zone VLAN IP Address Gateway Subnet Mask

PRP

Management 500 192.168 10.0/26 192.168.10.1 255.255.255 192
Controller 501 192.168 10.64/26 192.168.10.65 255.255.255 192
Operator 510 192.168 10.128/26 192.168.10.129 255.255.255 192
Engineering 511 192.168 10.192/36 192.168.10.193 255.255.255 192

DLR

Management 400 192.168 11.0/26 192.168.11.1 255.255.255 192
Controller 401 192.168 11.64/26 192.168.11.65 255.255.255 192
Operator 410 192.168 11.128/26 192.168.11.129 255.255.255 192
Engineering 411 192.168 11.192/36 192.168.11.193 255.255.255 192

Simplex

Management 300 192.168 12.0/26 192.168.12.1 255.255.255 192
Controller 301 192.168 12.64/26 192.168.12.65 255.255.255 192
Operator 310 192.168 12.128/26 192.168.12.129 255.255.255 192
Engineering 311 192.168 12.192/36 192.168.12.193 255.255.255 192

Server
Management 600 192.168 53.0/24 192.168 53.1 255.255.255 0
Application 601 192.168 52.0/24 192.168 52.1 255.255.255 0

OWS/EWS
OWS 610 192.168 50.0/24 192.168 50.1 255.255.255 0
EWS 611 192.168 51.0/24 192.168 51.1 255.255.255 0

IDMZ

Management 700 192.168 105.0/24 192.168 105.1 255.255.255 0
Wireless 702 192.168 104.0/24 192.168 104.1 255.255.255 0
IDMZ 703 192.168 100.0/24 192.168 100.1 255.255.255 0
IDMZ 704 192.168 101.0/24 192.168 101.1 255.255.255 0
IDMZ 705 192.168 102.0/24 192.168 102.1 255.255.255 0
IDMZ 706 192.168 103.0/24 192.168 103.1 255.255.255 0

CIP Security Zones

Management 200 192.168.13.0/27 192.168.13.1 255.255.255 224
Rapid Mix 201 192.168.13.96/27 192.168.13.97 255.255.255 224
OEM 202 192.168.13.128/27 192.168.13.129 255.255.255 224
Blend Fill 203 192.168.13.160/27 192.168.13.161 255.255.255 224
Clean Place 204 192.168.13.192/27 192.168.13.193 255.255.255 224
Safety 205 192.168.13.224/27 192.168.13.225 255.255.255 224
Operator 210 192.168.13.32/27 192.168.13.33 255.255.255 224
Engineering 211 192.168.13.64/27 192.168.13.65 255.255.255 224
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Remote Access Follow the best practices referred to in Stratix 4300 Remote Access Routers, Publication 1783-
um014. 

It’s required that the following setting be implemented:
• Log all connection operations

It’s recommended to require a comment when a device connection ends.

These settings can be enabled by:
1. Log in to the FactoryTalk Remote Access service (via FT Hub)
2. Navigate to Settings > Options > 
3. Select the settings and save

CIP Security CIP Security™ is a standard, open-source communication mechanism that helps to provide a 
secure data transport across an EtherNet/IP™ network. CIP Security lets CIP™-connected 
devices authenticate each other before transmitting and receiving data. 

CIP Security uses the following security properties to help devices protect themselves from 
malicious communication:

• Device Identity and Authentication
• Data Integrity and Authentication
• Data Confidentiality 

Rockwell Automation uses the following products to implement CIP Security:
• FactoryTalk® Policy Manager software (includes FactoryTalk System Services, version 

6.20 or later)
• FactoryTalk Linx software, version 6.11 or later (lets workstation software communicate 

securely using CIP Security)
• Studio 5000 Logix Designer® application, version 31.00.00 or later

This application is required to interface with CIP Security-enabled Logix controllers. 
The minimum application version varies by controller product family.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1783-um014_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1783-um014_-en-p.pdf
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For more information on CIP Security, for example, a list of CIP Security-capable products and 
publications that describe how to use the products, including limitations and considerations, 
see the following:

• https://www.rockwellautomation.com/en-us/capabilities/industrial-security/security-
products/cip-security.html

• CIP Security with Rockwell Automation Products Application Technique, publication 
SECURE-AT001

CIP Security Architecture

https://www.rockwellautomation.com/en-us/capabilities/industrial-security/security-products/cip-security.html
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at001_-en-p.pdf
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Notes:
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Firewall Configurations
Common Ports Table 9 shows the most common ports that must be considered during the firewall 

configuration.

Rockwell Automation TCP/
UDP Ports

Table 10 shows the TCP/UDP ports for Rockwell Automation® firmware and software products.

Table 9 - Common Firewall Port Descriptions

Port Type Usage
25 TCP SMTP mail
80 TCP Standard WWW port
123 UDP Network Time Protocol
135 TCP Remote process calls
137 UDP

File and printer sharing138 UDP
139 TCP
445 TCP Use in the Collective configuration and file and print sharing
1433 TCP Communication to SQL server
1434 UDP Browsing for SQL server
21060 UDP

Rockwell Automation® trace diagnostics
21061 UDP

Table 10 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments

23 TCP Telnet Trusted®
AADvance® before release 1.3 Diagnostic command-line interface (see also 55555)

25 TCP SMTP

1769-L35E, 1769-L32E,1756-ENBT,
1756-EN2T,1756-EWEB,1768-ENBT,
1768-EWEB,1788-ENBT,1763-L16x
1766-L32x,FactoryTalk® AssetCentre, FactoryTalk® 
Transaction Manager, FactoryTalk® Integrator

Outbound email only

67…68 UDP DHCP/BOOTP

1756-ENET,1756-ENBT,1756-EWEB,
1756-EN2T,1794-AENT,1734-AENT,
1769-L35E, 1769- L32E,1788-ENBT,
1761-NET-ENI,1785-LXXE,1785-ENET
,1791ES,1763-L16x,1766-L32x, PowerFlex® Drives, 
PowerMonitor™ 3000, PanelView™

Client only

69 UDP TFTP 5820-El For binary download, used in conjunction with BOOTP

80 TCP HTTP

1756-ENET,1756-ENBT,1756-EWEB,
1794-AENT,1734-AENT,1769-L35E,
1769-L32E,1788-ENBT,1761-NET- ENI
1785-LXXE,1785-ENET,1747-L55x,
1763-L16x,1766-L32x, PowerFlex Drives, PowerMonitor 
3000, PanelView, FactoryTalk® View SE, 
,FactoryTalk® ViewPoint

FactoryTalk ViewPoint can use any other custom 
assigned port

123 UDP NTP PowerMonitor 3000, AADvance Network Time Protocol
135 TCP RPC/Endpoint Mapper FactoryTalk, RSMACC™ DCOM endpoint mapper

161 UDP SNMP

1756-ENET,1756-ENBT,1794-AENT,
1734-AENT, 1769-L35E, 1769-L32E,
1788-ENBT, 1761-NET-ENI, 1785- LXXE,
1785-ENET,1747-L55x,1766- L32x,
5820-EI, PowerFlex Drives, PowerMonitor 3000, 
PanelView

300…400 UDP Proprietary PowerMonitor 3000 Master/slave configuration
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400…402 TCP RPC FactoryTalk Transaction Manager Transaction manager, compression server,
and configuration server

443 TCP HTTPS FactoryTalk ViewPoint When using web server with secure certificate

502 TCP ModbusTCP AADvance, Trusted® Master or slave (AADvance),
Slave only (Trusted)

1001…1009 UDP Proprietary 1426 PowerMonitor 5000 Waveform synchronized broadcast
Dynamic 
(1024…65535+) TCP DCOM FactoryTalk DCOM dynamic ports

1089
TCP/UDP

ff-annunc
1788-EN2FFR FOUNDATION Fieldbus1090 ff-fmx

1091 ff-sm

1132 TCP SNCP AADvance Safety Network Control Protocol, used by OPC, 
workbench debugger, and binding networks

1330 TCP rnaprpc FactoryTalk Object RPC
1331 TCP rnaserv FactoryTalk Service control
1332 TCP rnaserveping FactoryTalk Server health
1433 TCP N/A FactoryTalk® AssetCentre (server), SQL server communication (default port)

1434 UDP N/A FactoryTalk AssetCentre (server),
Recommended static destination port for MSSQL to 
minimize the number of ports open on a firewall
See the Knowledgebase Answer ID 287932 at http://
www.rockwellautomation.custhelp.com

1947 TCP/UDP N/A SafeNet Sentinel Local License Manager

Windows® Service installed by Sentinel USB HASP 
driver. This service isn’t required for USB dongle to 
function. 
See the Knowledgebase Answer ID 570831 at http://
www.rockwellautomation.custhelp.com

2000 TCP Modbus RTU AADvance (Slave only), Trusted (Master or slave, used 
for OPC and SOE)

RTU packaged in serial stream. Other ports can
be assigned

2010…2011 UDP Discover tool AADvance Used to configure systems. The tool sends broadcast 
to 2010 and systems reply to port 2011

2222 UDP EtherNet/IP™ 1756-ENBT,1794-AENT,1734-AENT,
1769-L35E, 1769-L32E,1788-ENBT

I/O communication that is used by products that only 
support I/O over EtherNet/IP

2222 TCP CSP
1785-Lxxe,1785-ENET,1771-DMC(x),
1747-L55x,5820-EI, PowerMonitor II,
RSLinx® Classic

This is the source port for connections

3060 TCP rnadirft FactoryTalk Directory server file transfer
3622 TCP/UDP ff-Ir-port 1788-EN2FFR FOUNDATION Fieldbus
4000 UDP Peer-to-peer Trusted Original simplex protocol
4120

TCP RPC RSBizWare™

Production server
4121 Server manager
4122 PlantMetrics™ server
4123 Task manager
4124 Scheduler server
4125 Scheduler CTP server

4446 TCP TCP/IP FactoryTalk® Diagnostics (CPR SR3) See the Knowledgebase Answer ID 68260 at http://
www.rockwellautomation.custhelp.com

5000 UDP Peer-to-peer Trusted, AADvance Enhanced (new) protocol

5241 TCP TCP/IP FactoryTalk Diagnostics (CPR9 SR4 and greater) See the Knowledgebase Answer ID 68260 at http://
www.rockwellautomation.custhelp.com

5450

TCP FactoryTalk® Historian Site Edition

PI network manager
5454

Analysis Framework v1.x
5455
5456 ACE 2 scheduler
5457 Asset Framework server
5458 PI notifications
5459 Asset Framework to OLEDB Enterprise
6000 TCP Workbench Trusted Online debugger

Table 10 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments

https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
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6543 TCP rnaalarming FactoryTalk Alarming server
7002…7004 TCP FactoryTalk AssetCentre (default) FactoryTalk AssetCentre services
7600

TCP FactoryTalk
Event multiplexor

7700 Event server
7710 Directory server
7720

TCP FactoryTalk® View SE

HMI server
7721 Server Framework
7722 HMI activation
7723 Historical Data Log reader
8080

TCP HTTP RSBizWare
Production server, reports

8081 Server manager
8083 TCP HTTP CTP Server

10001…10006 TCP Serial data AADvance
Transparent communication interface, where an 
Ethernet host can talk through AADvance to a serial 
port

27000…27009 TCP TCP/IP FactoryTalk® Activation Server,
FactoryTalk Activation Manager

Four more application required to run FLEXSVR.exe. 
and LMGRD.exe, see the Knowledgebase Answer ID 
35717 and 184922 at http://
www.rockwellautomation.custhelp.com

44818 TCP/UDP EtherNet/IP

1756-ENET,1756-ENBT,1756-EWEB,
1794-AENT,1734-AENT,1769-L35E,
1769-L32E,1788-ENBT,1761-NET- ENI,
1785-LXXE,1785-ENET,1747- L55x,
1763-L16x,1766-L32x, PowerMonitor3000, PanelView, 
RSLinx Classic, FactoryTalk Linx

Messaging, data transfer, upload/download, peer 
messaging, and so forth; used mainly by RSLinx

49281 TCP TCP/IP FactoryTalk® Live Data,
FactoryTalk View SE HMI tag server HMI tag server

55555 TCP Telnet AADvance from release 1.3 Diagnostic command-line interface

60093 TCP TCP/IP FactoryTalk Diagnostics (CPR9 SR2 and earlier) See the Knowledgebase Answer ID 68260 at http://
www.rockwellautomation.custhelp.com

Table 10 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments

https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
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Notes:
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PlantPAx Deployment Recommendations and 
Verification Tool
The PlantPAx® verification tool is a Microsoft® Excel® spreadsheet (.xlsx) that helps verify that 
functionality complies with PlantPAx deployment recommendations.

Use the spreadsheet (.xlsx) file as is. There are formulas that correspond to recommended 
PlantPAx settings. Any edits that you make can affect the validity of the results.

Each section in this appendix contains a checklist that corresponds to a tab in the verification 
tool. Each item (row) in a checklist corresponds to a row in the verification tool.

Design Recommendations 
Tab

The Design Recommendations tab lists best practices to follow when you design a PlantPAx 
system.

System ID

The PlantPAx System ID is a unique identifier that helps simplify the management of your 
application over its lifecycle. The System ID creates a record of the installed hardware and 
software in the system and provides a dashboard that shows the hardware lifecycle status, 
notifications of updates and patches, and compatibility information.

The System Integrator uses an Asset Inventory Agent in a FactoryTalk AssetCentre project to 
generate the System ID and .raai file. The System Integrator registers your System ID with 
Rockwell Automation and provides you directions on how to access your MyEquipment portal.

PROCES-RD101 contains the PlantPAx checklist spreadsheet. Download the 
spreadsheet from this public article and use the tab that is referenced in each 
step.

Checklist Description
Design Recommendations Tab System design considerations and best practices
System Infrastructure Tab System infrastructure elements that are shared across all servers and workstations
Server or Workstation Tab Loading and configuration of each individual server and workstation
System Architecture Tab Design and configuration of your system components
PASS Tab Design and configuration of the applications that PASS servers host

Application and load on a ControlLogix® 5580 or CompactLogix™ 5380 controller
Controller 5x70 Tab Application and load on a ControlLogix 5570 or CompactLogix 5370 controller

Design Recommendation Tab: Overall Considerations

Row Guidelines Description
4 PlantPAx Core Software bundle Catalog number of the PlantPAx Core Software bundle

5 Inventory agent
The System Integrator generated the .raai file via the FactoryTalk® AssetCentre inventory agent

The .raai file contains the System ID serial number There could be multiple .raai files, for example, one 
for each subnet accessible by the FactoryTalk AssetCentre server

6 MyEquipment portal The System Integrator registered to the system, and provided directions on how to access the 
MyEquipment portal

https://literature.rockwellautomation.com/idc/groups/literature/documents/rd/proces-rd101_-en-p.xlsx
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Controller Considerations

Library Considerations

Alarm Considerations

I/O Considerations

Design Recommendation Tab: Controller Considerations

Row Guidelines Description

7 Controller name
Keep the shortcut, ACD file name, and controller name similar (intuitive).
Follow a systematic naming structure to help identify each controller in all system components. 
Inconsistent naming can create confusion in a production environment.

8 Routine / Tag Names

Follow ISA standards for control strategy and instrument naming schemes.
Keep in mind devices that are already labeled in the field and the wire/cable numbers that are in place. 
Existing names can mean less flexibility for future field device names.
ISA tag naming is an industry standard which design firms often follow when developing P&IDs. Link 
tags in the controller to the P&IDs to help link the process (P&IDs) to the programming within the control 
system.

9 Controller Organizer

Organize control programs to contain logic based on required execution rates.
Organize code in a program within the desired task that aligns with the process area. If code for a given 
process area must execute at different rates, create multiple programs in different tasks that are 
related to the same process area. Program names should be the same in the different tasks but with an 
indication that is embedded within the program name that indicates the task. This helps identify which 
task the program resides in when the programs are organized in the Logical Organizer.

10 Logical Organizer

In the Logical Organizer, folder names should be the same as the primary graphic display names.
The Logical Organizer contains folders which contain the programs for specific process areas. Each 
folder contains the code that supports the HMI display for a single process area and is aligned with 
alarm groups. The alarm groups provide navigation to identify which HMI displays contain active alarms.

The folders in the Logical Organizer should match the graphical hierarchy (L1, L2 & L3) so that the alarm 
builder tool creates alarms in the appropriate alarm groups and populates the navigation bars correctly.

11…14 Controller Routines

Have one routine per device to help ensure that online edits only affect that specific device.
Name each routine the same as the device name to help identify routines and their devices in the 
Controller Organizer.
Each device (such as motor, valve, PID) should use a standard PlantPAx control strategy that is 
programmed in function block diagram.
Keep supervisory or device control logic external to the device control strategies. This reduces 
variability among strategies and minimizes the risk of replicating modified control strategies.

15 Controller Programs

Align programs with graphic displays (typically L3 displays) so that the routines in a program have the 
same primary HMI display.
• Alarm annunciation breadcrumbs highlight the associated navigation bar button.
• If you add a device to a display, the device is also added to the associated program and alarm group.

Design Recommendation Tab: Library Considerations

Row Guidelines Description
16 Process Library Objects Do not modify process library Add-On Instructions or graphic objects.

Design Recommendation Tab: Alarm Considerations

Row Guidelines Description
17 Standards Follow ISA 18.2 standards for alarm management

18 ALMA / ALMD Alarm Instructions
Avoid extensive use of ALMA and ALMD instructions. These instructions provide a high-resolution time 
stamp, but they also use considerable data server bandwidth. Minimize ALMA and ALMD use to only those 
alarms that require high-resolution time stamps.
Instead use tag-based alarms and FactoryTalk® Alarms and Events alarms.

Design Recommendation Tab: I/O Considerations

Row Guidelines Description

19 RPI
Ideally, the I/O RPI equals half of the task execution time (0.5 * associated task period).
The I/O update sampling frequency should be twice the frequency of the logic execution. More frequent 
sampling over uses I/O communication bandwidth. Less frequent I/O sampling can result in poor 
control.

20 Consistent I/O Methodology
Select an I/O connection method: I/O mapping, direct I/O connection, aliasing, or program parameters. 
Choose a method that works best for your installation and consistently apply this method throughout 
your application.
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HMI Considerations

User Security Considerations

System Infrastructure Tab The System Infrastructure checklist assumes:
• Your PlantPAx system is operable (for example, the HMI application is running and the 

latest operating system patches are installed).

Your system infrastructure has been configured such that:
• You’ve defined a range of IP addresses for the DHCP server in the domain, if applicable 

for your system.
• You have created groups and assigned users in the domain controller.

Design Recommendation Tab: HMI Considerations

Row Guidelines Description

21 Graphical Framework Use the Graphic Framework that comes with the process library. This framework helps achieve a 
consistent delivery of HMI displays.

22 Follow ISA 101 Style Guide The standards help achieve a consistent delivery of HMI displays. The standards also help draw 
attention to information that requires attention.

23 Naming Conventions The naming of graphic displays follows the Logical Organizer hierarchy. This alignment helps locate 
associated programming for future additions and changes.

24 Design for the Future Name applications and Areas with future development in mind.

Design Recommendation Tab: User Security Considerations

Row Guidelines Description

25 User / Group Configuration follows 
FactoryTalk Security SECURE-AT002 Design and implementation follows FactoryTalk Security Application Technique.

System Infrastructure Tab

Row Guidelines Description

4 Hardware
BIOS Power-Saving Options Disabled?
From the computer BIOS, specify whether the BIOS power-saving options are disabled. Power-saving 
options reduce computer resources for your system elements.

5 Virtualization Using Virtualization?
Specify whether your system uses virtualization.

6-13 Hypervisors
If you’re using virtualization, enter the percentage of CPU use and memory use for each computer. 
• CPU use recommended to be within 50% of resources
• Memory use recommended to be within 50% of resources
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14 Domain

All servers and workstations are in the same domain
Specify whether all servers and workstations are on a Windows® Domain.

On the domain controller, go to Server Manager > Tools > DNS and verify that all servers and 
workstations are listed in the DNS Manager dialog box.

In the Notes, document any clients that aren’t in the domain and why.

System Infrastructure Tab

Row Guidelines Description
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Network

To collect the network data, collect the network data manually from the webpages of each 
switch.

See Chapter 4, Network Infrastructure for details.

Information can also be collected using the Network Device Library if implemented in the 
system. See the Network Device Library section for more information.

Servers and Workstations

List the following for each server and workstation in the system (rows 20…93). The Server or 
Workstation tab is where you record data regarding each server and workstation:

• Computer name
• System role (select from dropdown)

Server or Workstation Tab The Server or Workstation Name checklist assumes:
• Your PlantPAx system is operable (for example, the HMI application is running and the 

latest operating system patches are installed).
• The Performance Monitor (PerfMon) utility is connected to the servers and workstations 

that are being verified

Operating System

Verify these operating system requirements.

System Infrastructure Tab: Network

Row Guidelines Description

15 Bandwidth Utilization %
Verify bandwidth < 50%.
• If using a Stratix® 5200 or 5800 switch, navigate to Administration -> Command Line Interface. Enter 

SHOW CONTROLLERS UTILIZATION in the CLI to access bandwidth information.
16 Packet Error Rate Verify that there are no packet errors.
17 Temperature OK Verify that all devices aren’t reporting high temperature readings.
18 CPU Utilization % Verify CPU use ≤ 50%. 
19 Memory Utilization % Verify memory use ≤ 50%.

IMPORTANT Make a copy of this worksheet for each computer (server or 
workstation) in your system.
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Server or Workstation Tab: Operating System

Row Guidelines Description

4 Windows Firewall Being Used

Specify whether the Windows firewall is enabled.
For each computer, go to Control Panel > Windows Firewall > Advanced Settings.

Inbound rules allow or block inbound network traffic. Verify that Rockwell Automation software is allowed so that 
data and information isn’t blocked between application servers.

5 Operating System Valid
Specify whether the server or workstation operating system that you’re using matches PlantPAx system 
recommendations.
See the PlantPAx Distributed Control System Selection Guide, PROCES-SG001.

6 Rockwell Software® Patches Applied
Specify whether you installed the latest software patches for the Rockwell Automation software that is in the 
PlantPAx system.
All servers and clients in the system must have the same FactoryTalk® patch updates to avoid unexpected 
results.

7 NIC Power-Saving Options Disabled

Specify whether you disabled power-saving for the Network Interface Card (NIC).\
For each computer, go to Control Panel > Network and Sharing Center > Properties > Power Management.

Make sure the ‘Allow the computer to turn off this device to save power’ is disabled (no check mark).

https://literature.rockwellautomation.com/idc/groups/literature/documents/sg/proces-sg001_-en-p.pdf
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8 Windows Power-saving Options Disabled

Specify whether you disabled power-saving for the Windows operating system.
For each computer, go to Control Panel > Power Options and verify the Change when computer sleeps field is set 
to Never.

9 Desktop Experience Enabled in RDS Servers
Windows Server 2016 and newer have Remote Desktop Server (RDS) functionality that is enabled by default.
Windows Server 2012 and prior, RDS is disabled by default and you must enable the functionality. For each 
computer, go to Server Manager > Local Server and review the Roles and Features listings. 

10 Adjust for Best Performance Is Selected

Specify whether Windows settings are enabled for best performance.
When Adjust for Best Performance is selected, enhanced features that aren’t used are turned off, which yields 
more memory and performance for the system.
For each computer, go to Control Panel >System > Advanced System Settings > Advanced tab > Settings and on 
the Visual Effects tab, make sure Adjust for best performance is enabled.

11 Data Execution Prevention Windows Only

Specify whether Data Execution Prevention is enabled for essential Windows programs and services.
For each computer, go to Control Panel > System > Advanced System Settings > Advanced tab > Settings and on 
the Data Execution Prevention tab, make sure ‘Turn on DEP ...’is enabled.

12 User Account Control Never Notify

Specify whether a user is never notified by the User Account Control.
For each computer, open the User Account Control settings and make sure Never Notify is enabled.

Server or Workstation Tab: Operating System

Row Guidelines Description
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13

Windows Automatic Update Is Disabled

This step is for computers that are not internally managed by a Windows System Update Server (WSUS).
Verify that Windows automatic update is disabled. Disabling this functionality helps prevent updates that haven’t 
been qualified by Rockwell Automation from being installed on the workstation or server.

For Windows 10/11, Windows Server 2016 and later operating systems:
1. Open the Run command (Win + R) and enter: services. msc
2. Select the Windows Update service from the Services list.
3. On the General tab and change the Startup Type to Disabled.
4. Restart the computer.

For Windows Server 2012 and prior:
1. For each computer, go to Control Panel > Windows Update and make sure that the update option is disabled.
2. Restart the computer.

14

Event Viewer Is Not Presenting Errors

Verify that the Event Viewer is not showing errors in the logs.
For each computer, go to Administrative Tools > Event Viewer and verify that each log does not contain errors.

15 NSLookup Resolved

Verify the mappings of IP addresses to host names

Server or Workstation Tab: Operating System

Row Guidelines Description
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Performance

The Windows Performance Monitor (PerfMon) utility provides a snapshot of the current 
performance of a computer. To generate a performance report, do the following for each 
server and workstation:

1. From the Performance Monitor utility, go to Data Collector Sets > System > System 
Diagnostics and select Start.

The system diagnostics procedure takes about 1 minute.
2. To view the report, go to Reports > System > System Diagnostics.

Basic System Checks

Use the performance report from the Performance Monitor utility to verify the basic system 
checks.

Server or Workstation Tab: Basic System Checks

Row Guidelines Description

17 Operating Systems Checks Verify that the attributes of the operating system conform to PlantPAx system recommendations.
Use of not-recommended operating systems can affect system performance.

18 Disk Checks Verify the status of the disks in the operating system.
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Resource Overview

Use the performance report from the Performance Monitor utility to verify the resources.

System Architecture Tab The System Architecture checklist assumes:
• Your PlantPAx system was based on sizing recommendations from a PlantPAx System 

Estimator project.
See Chapter 1, System Workflow.

• Your PlantPAx system is operable (for example, the HMI application is running and the 
latest operating system patches are installed).

• You have configured the following FactoryTalk software that you need for your 
application servers.

FactoryTalk View Application Design

To verify these attributes, use the FactoryTalk® Administration Console or the FactoryTalk® 
View Studio software.

19 Security Center Tests Verify system security-related information.
20 System Service Checks Verify the state of system services.
21 Hardware Device Driver Checks Verify the Windows management of supported devices in your PlantPAx system.

Server or Workstation Tab: Basic System Checks

Row Guidelines Description

Server or Workstation Tab: Resource Overview

Row Guidelines Description

22 CPU (%) Verify that the CPU load complies with PlantPAx system recommendations.
In a virtual system, the chip set on the host machine (server) can affect CPU capacity.

23 Network (%) Verify that the busiest network adapter is < 50%.
24 Disk (/sec) Verify the operations per second performed by the hard drive.
25 Memory (%) Verify the memory capacity of the server or workstation.

Alarm Server (if used)

Data Servers

HMI Server
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Server segregation helps optimize performance. To help prevent unpredictable search results, 
do not insert a server into the application root path.

Design the system with of future growth in mind. Future growth can affect area names and 
how you segregate server by controllers within an area.

To improve performance, place:
• Data servers, alarm servers (if used), and Historian interface connectors on the same 

image
• HMI and other application servers on separate images

IMPORTANT Each server must be in its own area. This creates a unique path 
for each server so that clients don't need to examine every 
server.

System Architecture Tab: FactoryTalk View Application Design

Row Guidelines Description

4 Number of HMI Servers

The system supports 10 HMI servers, whether they’re redundant or not (you can have 10 redundant 
pairs).
The number of servers and how they’re configured can impact the speed of system communication. 
Use the application tree in the FactoryTalk Administration Console and select the project to be 
analyzed.
• Reference, identify, and count all HMI servers in your system.
• If a server is secondary, do not add the secondary HMI server to the count.

5 Number of Alarms Servers

The system supports 10 Tag Alarm and Event servers, whether they’re redundant or not (you can have 10 
redundant pairs).
Use the application tree in the FactoryTalk Administration Console and select the project to be 
analyzed.
• Reference, identify, and count all Tag Alarm and Event servers in your system.

6 Number of Data Servers

The system supports 10 data servers, whether they’re redundant or not (you can have 10 redundant 
pairs). Both FactoryTalk Linx and OPC UA data servers count towards the limit.
Use the application tree in the FactoryTalk Administration Console and select the project to be 
analyzed.
• Reference, identify, and count all FactoryTalk Linx and OPC UA data servers in your system.

7 Each Server Is In Its Own Area

Each server must be in its own area. This creates a unique path for each server so that clients don't 
need to examine every server before they find the data they need.
Server segregation helps optimize performance. To help prevent unpredictable search results, do not 
insert a server into the application root path.

For more information see, Knowledgebase Technote FactoryTalk View SE Area Best Practices.

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/29663/loc/en_US#__highlight
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FactoryTalk View HMI Servers

Verify that the HMI servers on the PASS comply with system recommendations.
System Architecture Tab: FactoryTalk View HMI Servers (PASS)

Row Guidelines Description

8 Uses Data Logging

We recommend the use of FactoryTalk® Historian software rather than FactoryTalk View SE data logs to 
collect and analyze system data.
To check if data logs are used in a FactoryTalk View SE project, open a Data Log folder in the HMI server. 
Verify the data log model is empty.
Note: This guideline applies to standard Data Log Models only. DataLogPro is supported for PlantPAx.

9 Dedicated Servers

You can have only 1 HMI server per computer. 

In FactoryTalk® View Studio software, open Properties for each server and confirm the computer host 
name.
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FactoryTalk Alarm and Event Servers

Verify that the alarm servers on the PASS comply with system recommendations.

10 Redundancy Status

In the FactoryTalk Administration Console, select the HMI server > Server Status.

In the verification tool:
• If the status for one server is ‘Active’ and the other server is ‘Standby’, record Synched.
• If you have different results, choose ‘Not Synched’ and identify the servers that are ‘Not Synched’ in 

the Notes.

System Architecture Tab: FactoryTalk View HMI Servers (PASS)

Row Guidelines Description

System Architecture Tab: FactoryTalk Alarm and Event Servers (PASS)

Row Guidelines Description

11 Dedicated Servers
You can have only 1 alarm server per computer. 
In FactoryTalk View Studio software, open Properties for each server and confirm the computer host 
name.

12 Redundancy Status

Use the FactoryTalk Administration Console to select the alarm server > Server Status.
In the verification tool:
• If the status for one server is ‘Active’ and the other server is ‘Standby’, record Synched.
• If you have different results, choose ‘Not Synched’ and identify the servers that are ‘Not Synched’ in 

the Notes

13 Alarm & Event History

In the FactoryTalk Administration Console, open the Properties for the alarm server and check Enable 
History to log alarm history.
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FactoryTalk View Data Servers

Verify that the data servers on the PASS comply with system recommendations.
System Architecture Tab: FactoryTalk View Data Servers

Row Guidelines Description

14 Max Number of FTLinx Instances on any PASS
FactoryTalk Linx supports 2 data server instances on one computer.
In FactoryTalk View Studio software, open Properties for each server and confirm the computer host 
name.

15 Dedicated Server for OPC UA UPC UA data servers should be hosted on a dedicated computer. No additional Data, Alarm or HMI 
servers should be hosted on the same computer with an OPC UA data server.

16 Redundancy Status

Use the FactoryTalk Administration Console to select the data server > Server Status. For OPC UA, select 
Properties > Redundancy.
In the verification tool:
• If the status for one server is ‘Active’ and the other server is ‘Standby’, record Synched.
• If you have different results, choose ‘Not Synched’ and identify the servers that are ‘Not Synched’ in 

the Notes

17 Alarm & Event History

In the FactoryTalk Administration Console, open the Properties for the data server and check Enable 
History to log alarm history.
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FactoryTalk AssetCentre Configuration

As a rule, do not to exceed 100 assets over a 12-hour period per agent.

To verify the FactoryTalk AssetCentre configuration:
1. On the AssetCentre menu bar, select Help > About.

2. In the Components box, select FactoryTalk AssetCentre Server Features.

System Architecture Tab: FactoryTalk AssetCentre (AppServ-Asset Mgmt)

Row Guidelines Description

18 Number of Assets
Licensing determines the allowable number of assets. A base license includes 10 assets.
From the Details pane of the FactoryTalk AssetCentre dialog box, verify the number of total system 
assets.
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FactoryTalk Historian SE Configuration

Verify that the following FactoryTalk View Historian SE design attributes comply with system 
recommendations.

19 Number of Disaster Recovery (DR) Assets
Specify the number of controllers that are configured for Disaster Recovery (requires a Disaster 
Recovery license).
Select Disaster Recovery - Rockwell in the FactoryTalk AssetCentre dialog box.

20 Number of Agents

Agents are programs that communicate with the FactoryTalk AssetCentre server and perform server 
tasks, such as disaster recovery.
By using agents, work is distributed and shared among computers to help spread processing load. View 
the number of agents in the bottom-right corner of the FactoryTalk AssetCentre dialog box.

21 How Often DR Assets Configured to Upload

Determine the frequency that the assets are scheduled to upload.
Enter the number of days between asset uploads from the Schedules > Timing properties dialog box.

System Architecture Tab: FactoryTalk AssetCentre (AppServ-Asset Mgmt)

Row Guidelines Description

System Architecture Tab: FactoryTalk Historian SE (AppServ-Info)

Row Guidelines Description

22 Points In Use

Verify the number of points that are in use.
To view the number of points on the FactoryTalk Administration Console dialog box, go to System > 
Connections > Historical Data and select the Historian SE server.

23 Points Limit
The limit depends on the points in use and the license limit.
This value sets a benchmark that can be compared to future server results. The comparison can 
identify a potential issue with too many points per license.
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24 Fastest Scan Class

Verify the scan rate that is used in FactoryTalk Live Data to send controller information to the Historian 
server. This information can be viewed with Point Builder in PI System Management Tools or using the 
FactoryTalk Historian SE Excel Add-in tool.

From Excel, on the PI Builder tab, select PI Points > All Points and select all columns. 
The column that is labeled Location 4 is an integer that is used by many interfaces to specify the scan 
class of the PI Point.

The PI Interface Configuration Utility defines time period of each class number. For example, the FTLD1 
interface contains 10 scan classes in terms of seconds.

Typically, a scan class of 1 second is sufficient. Some tags can require a scan class of 0.5 seconds.
Exception reporting and compression reporting for tuning parameters are important for data collection 
and server loading.

25 Number of Interfaces Specify the number of FactoryTalk Live Data interfaces in your Historian configuration.

26 Buffering Enabled and Running

Buffering is recommended to maintain data collection in the event the connection to the server is lost.

System Architecture Tab: FactoryTalk Historian SE (AppServ-Info)

Row Guidelines Description
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PASS Tab The PASS tab records details about the HMI elements in your application.

To verify your FactoryTalk® View Site Edition (SE) HMI design elements, use the Rockwell 
Automation Graphic Audit Tool. The audit tool analyzes exported HMI displays. The PlantPAx 
Graphic Audit Tool can be found from the Product Compatibility and Download Center at 
rok.auto/pcdc under the PlantPAx Tools release, specifically for the PlantPAx Verification 
Checklist Tools download.

Before you run the audit tool, export the HMI application graphic files to an XML format. Then 
run the audit tool on the XML file.

27 Unit Fail Over Enabled and Running

On the Interface Configuration Utility, verify that failover is configured properly.

28 Collective Enabled and Running

Verify that a collective is properly configured in a redundant Historian systems

System Architecture Tab: FactoryTalk Historian SE (AppServ-Info)

Row Guidelines Description

IMPORTANT Make a copy of this worksheet for each PASS in your system.

Field Description Application
SE - Network
SE - Local
ME

Click SE - Network

Name The Name and Area Name are used only to generate Data 
Client XML files and are not used in the audit operation. See 
Graphic Audit Tool Help.rtf file in the zip file for more details.Area Name (for example, Brewing/HMI)

Create file of expressions and commands found
Create file of global objects found To create the respective files, check the boxes.

Data Client
Create files for Data Client tool
Total tags
Unique tags

To enable Create files for Data Client, check the box, and 
then select Unique tags.

Folder that contains graphic XML files to perform 
audit operations on

Click Browse (‘…’ ellipsis) to select the directory
path where you exported your graphic XML files.

Audit type  Choose PlantPAx from the dropdown menu. This choice 
uses rules that are specific to the PlantPAx system.

https://rok.auto/pcdc
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The process displays are listed in the Results pane.

These guidelines apply to HMI applications developed via FactoryTalk View SE software. Make 
sure:

• The FactoryTalk View SE system is correctly installed and configured (software version, 
operating system, computer requirements) according to the PlantPAx system 
characterized architecture.

• Design the FactoryTalk View SE system to accommodate future additions.
• Develop your HMI displays according to ISA 101 standards

Color-coded cells indicate 
threshold issues.
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FactoryTalk View SE System

Verify that the HMI server attributes comply with these recommendations.

FactoryTalk Alarms and Events Server

There are two possible types of alarms on the PASS:
• Server Tag-based alarms
• Logix Tag-based alarms

Server Tag-based Alarms

Server Tag-based alarms that are defined within the FactoryTalk Alarms and Events server 
(default for 4.6 or earlier PlantPAx system releases that are using the 4.1 or earlier Library of 
Process objects.)

The FactoryTalk Alarm and Event Setup dialog box provides the data.

PASS Tab: FactoryTalk View SE (HMI)

Row Guidelines Description
4 Number of Displays The total number of displays does not exceed the display license.

5-10
Total Tags on Server

Unique Tags
Expressions
Global Objects

Verify that there are no warnings or errors from the Graphic Audit Tool. Consider simplifying any 
displays with warnings or errors.

11-15

Display Settings
Display Type
Display Cache
Always Updating
Graphic Update Rate

For display settings, specify:
• Display Type = Replace
• Display Cache = No
• Always Updating + not checked

Verify that the update rate is within recommendation of 0.5 seconds. Any faster rate has a possible 
impact on the server and controller.
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Logix Tag-based Alarms

Logix Tag-based alarms are configured in the Logix Designer software and stored in controller 
memory. They are processed directly by the FactoryTalk Linx data server and do not require a 
Tag Alarms and Events server. This alarm type is used by version 5.0 and later of the Process 
Objects Library.

To determine the number of Logix tag-based alarms:
1. In Logix Designer, export the alarms for each of the controllers with a defined shortcut 

on the FactoryTalk Linx (Instance 01) data server.
2. Open the export file in Excel and filter on Use = True to total the number of in-use 

alarms. Record this value in the appropriate row in the Checklist spreadsheet. Repeat 
these steps for FactoryTalk Linx (Instance 02) if necessary.

3. Verify that the alarm server attributes comply with these recommendations.
PASS Tab: FactoryTalk Alarms and Events

Row Guidelines Description

16 Number of Server Tag-based Alarms (FactoryTalk 
Alarms and Events) The FactoryTalk Alarms and Events server supports 20,000 Server Tag-based alarms

17 Total Items (Server Tag-based alarms only) Informational field provides a total number of items on the Tag Update Rates of the 
FactoryTalk Alarm and Event Setup dialog box

18 Fastest Update Rate (Server Tag-based alarms only) Update rate recommendation is greater than or equal to 1 second. Default is 2 seconds to help 
reduce load on the system.

19
All tags associated with Server Tag-based alarms are 
from a data server that is hosted on the same PASS as 
the alarm server.

The alarm server references the data server that is hosted on the same computer. Move non-
compliant alarms to the appropriate alarm server associated with the data server.
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Generate the FactoryTalk View Report

The FactoryTalk View Report can automatically generate some of the required data for the 
PASS and Controller worksheets. Use the following steps to configure and generate the report.

1. For each controller, select the appropriate diagnostic Add-On Instruction. Diagnostic 
Add-On Instructions are available in the Library of Process Objects. This library can be 
downloaded from the Product Compatibility and Download Center at rok.auto/pcdc. 

Use the following guidelines to determine which instruction to use.
- If the controller is from the 5x70 family, use the L_CPU instruction.
- If the controller is from the 5x80 family, use either the L_CPU_5X80 instruction (4.1 

library and earlier) or the raP_Dvc_LgxCPU_5X80 (5.0 library and later).
2. For each controller, import and configure the appropriate Add-On Instruction. Verify 

that the instruction's tag is controller-scoped and named “L_CPU” for the L_CPU or 
L_CPU_5X80. If the raP_Dvc_LgxCPU_5X80 is used the tag name must be 
“raP_Dvc_LgxCPU”.

3. The instruction must have Data Collection enabled from the maintenance tab on the 
faceplate. 

See Rockwell Automation Library of Logix Diagnostic Objects, publication PROCES-
RM003 for more information on the L_CPU and L_CPU_5X80 Add-On Instructions.
See Rockwell Automation Library of Process Objects, publication PROCES-RM200 for 
more information on raP_Dvc_LgxCPU_5x80 Add-On Instruction.

4. In FactoryTalk View Studio, go to Global Objects file (RA-LIB) Report and select the Show 
Data Server and Controller Report Displays button.

5. Copy the Global Object button and paste on to desired display.

20 Number of Logix Tag-based Alarms (FactoryTalk Linx 
Instance 1) FactoryTalk Linx instance 1 supports 15,000 Logix Tag-based alarms

20 Number of Logix Tag-based Alarms (FactoryTalk Linx 
Instance 2) FactoryTalk Linx instance 2 supports 15,000 Logix Tag-based alarms

22 Total Alarms (Server Tag-based + Logix Tag-based; sum 
total of previous 3 rows) The total number of alarms does not exceed 30,000 per PASS 

PASS Tab: FactoryTalk Alarms and Events

Row Guidelines Description

IMPORTANT The provided global object, display files, and images in the checklist file must be installed in the HMI before 
printing the report. The display files include the following:
Images: icon_gray.png, icon_green.png, icon_yellow.png, icon_red.png
Global object: (RA-LIB) Report.ggfx
Displays: (RA-LIB) Report RSLinxE.gfx, (RA-LIB) Report Controller.gfx, (RA-LIB) Report Controller 5x80.gfx
The files needed to generate the report can be found in the Product Compatibility and Download Center at 
rok.auto/pcdc under the PlantPAx Tools release, specifically for the PlantPAx Verification Checklist Tools 
download.

https://rok.auto/pcdc
https://rok.auto/pcdc
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
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6. Select the button and open the Global Object Parameter Values.
7. Under Tag on the Global Objects Parameter Values dialog box, click Browse (ellipsis ‘…’) 

browse to select a controller shortcut.

8. Enter a shortcut path. Use the syntax {/Area/Server::[Shortcut]}. Repeat until all 
shortcuts from FactoryTalk Linx Instance 01 are added. Add a new button and repeat 
process for FactoryTalk Linx Instance 02 if necessary.
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9. Run a FactoryTalk View Client session and click the Show Data Server and Controller 
Report Displays button to generate a report.

Controller Verification.

Use the information in this 
section to complete the Checklist.
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FactoryTalk Linx Data Server

For each shortcut, verify:
PASS Tab: Data Server (FactoryTalk Linx Instance 1 and Instance 2)

Row Guidelines Description

23 & 37  Memory Usage

Select Yes or No to indicate if the Data Server is in use. If yes, then record the memory usage 
(MB) from the computer's task manager. PlantPAx recommends the memory usage of each 
instance of FactoryTalk Linx not exceed 3,000 MB.

24-50 Number of Polled Data Items The number of tags that are polled from the controller.

24-50 Average packets per Second
If your controller consistently exceeds the recommended maximum average packets per 
second, it’s possible your controller is overloaded. Consider reducing the number of HMI data 
points that are referenced by your HMI displays from that controller. You can also change the 
display update rate if you’re experiencing performance issues.

24-50 Average Packet Response Time

The average packet response time of messages to the controller.
If your average packet response time consistently exceeds 200 milliseconds, then it’s possible 
that your communication adapter has a potential bottleneck. Consider the following 
troubleshooting guidelines if your performance isn’t satisfactory:
• Examine your network architecture and network hardware. You could be exceeding your 

switch capacity or capabilities that can cause slow network performance.
• You could be using an outdated communication adapter in the path to your controller. Or, 

you could be exceeding the capabilities of the communication adapter.
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FactoryTalk Linx OPC UA Connector
PASS Tab: Data Server (OPC UA Connector)

Row Guidelines Description

51 Using OPC UA Connector The OPC UA connector should be hosted on a dedicated computer with no other servers (HMI, 
Alarm, or Data) present.

52 Number of OPC UA connections

The OPC UA server shouldn’t have more than 20 OPC UA connections.
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Controller 5x80 Tab The Controller tab records controller properties.

To gather information for the checklist, you can use the FactoryTalk View report, see Generate 
the FactoryTalk View Report. 

53 FactoryTalk Live Data Active Tags

The OPC UA server shouldn’t have more than 50,000 active tags.

54 FactoryTalk Live Data Active Tag Updates/sec

The OPC UA server shouldn’t have more than 50,000 tag updates per second.

55 Total OPC UA Alarms and Conditions

Determining the number of Alarms and Conditions for each OPC UA server that is configured in 
the connector. Each connection that is counted in Row 52 must be reviewed individually as 
specific configurations of OPC UA servers can vary. The sum total of all alarms and conditions 
across all connected OPC UA servers shouldn’t exceed 5000. Consider reducing the number of 
OPC UA alarms and conditions if there are more than 5000 total across all OPC UA servers.

PASS Tab: Data Server (OPC UA Connector)

Row Guidelines Description

Pass Tab: DataLogPro

Row Guidelines Description
56 Total DataLogPro tags The total number of tags configured in DataLogPro should not exceed 50,000.

IMPORTANT Make a copy of this worksheet for each 5x80 controller in your 
system.
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Select the button shown in the following display to view the Controller Report Display.

Controller Properties

Verify that the controller properties comply with these recommendations.

CPU Use

Verify that the CPU use complies with these recommendations.

Faults

Verify that the fault handling complies with these recommendations.

Capacity

Verify that the controller capacity complies with these recommendations. 

Controller 5x80 Tab: Properties

Row Guidelines Description
4 Shortcut Keep the shortcut, ACD file reference, and controller name similar (intuitive).
5 Firmware Verify the firmware revision.

6 Module The controller is indicated as available in the PSE.
The controllers in the PSE have been characterized for use within a PlantPAx system.

7 Redundancy Indicate whether you’re using a redundant controller (Yes/No).

Controller 5x80 Tab: CPU Use

Row Guidelines Description

8 Logix Engine At least 25% free for Redundant 5580 controllers. Non-redundant 5x80 controllers can utilize 
up to 100% of the Logix Engine.

9 Communications Core At least 40% free.
10 Packet Processing Engine At least 25% free.

Controller 5x80 Tab: Faults

Row Guidelines Description

11 Minor Faults Count
Number of minor faults that have occurred within the controller.
After clearing the minor faults, monitor for a period of time (at least several controller scans) 
before reverifying.

12 Task Overlap

Whether a task overlap occurs.
A task overlap must be resolved. Use the predefined task model in the process controller or 
simplify the program.
Lengthening the period or raising the relative priority of important tasks disables the 
predefined task model in a process controller.
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To verify controller capacity, open the controller application file in Logix Designer. Go to 
Controller Properties > Capacity tab.

Connections

Verify that the total number of connections is 75% or less of the controller maximum.

Time Synchronization

Verify that the controller is configured for time synchronization.

Task Structure

Verify that the controller program uses only periodic tasks.

Controller Alarms

Verify the number of controller alarms.

Controller 5x80 Tab: Capacity

Row Guidelines Description
13 & 14 Program Memory (blocks) Reserve at least 20%.
15 & 16 Nodes Reserve at least 20%.

Controller 5x80 Tab: Connections

Row Guidelines Description

17-25 Total I/O

Total number of connections includes:
• I/O
• Produced tags
• Consumed tags
• Messages
• Incoming
• Unconnected buffers
• Message cache

Controller 5x80 Tab: Time Synchronization

Row Guidelines Description
26 Controller is time synchronized Denotes if the controller is configured for time synchronization (Yes/No).

Controller 5x80 Tab: Task Structure

Row Guidelines Description

27 Only periodic task used Use only periodic tasks and remove any unused tasks
The process controller enforces 4 periodic tasks: Slow, Normal, Fast, and System.

Controller 5x80 Tab: Controller Alarms

Row Guidelines Description

28 Total number of Logix Tag-based alarms (both IN-USE 
and NOT)

The total number of Logix Tag-based alarms (both IN-USE and NOT) stored in a controller 
shouldn’t exceed 10,000. See Logix Tag-based Alarms on page 275 to determine the number of 
alarms on a controller.

29 Total number of Logix Tag-based alarms (IN-USE only)
The total number of Logix Tag-based alarms (IN-USE only) stored in a controller shouldn’t 
exceed 7,500. See Logix Tag-based Alarms on page 275 to determine the number of alarms on 
a controller.
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Controller 5x70 Tab The Controller tab records controller properties.

To gather information for the checklist, you can use the FactoryTalk View report, see Generate 
the FactoryTalk View Report. 

Select the button shown in the following display to view the Controller Report Display.

Controller Properties

Verify that the controller properties comply with these recommendations.

CPU Use

We recommend CPU load in a production environment to be 75% or less. Keep 25% CPU 
capacity as reserve to handle online edits, data server switchover, and so on.

Controller 5x80 Tab: OPC UA

Row Guidelines Description

30 Total OPC UA nodes/
sec

The total number of OPC UA nodes/sec should not exceed 50,000. OPC UA nodes/sec diagnostic data is available via the controller webpage.

IMPORTANT Make a copy of this worksheet for each 5x70 controller in your 
system.

Controller 5x70 Tab: Properties

Row Guidelines Description
4 Shortcut Keep the shortcut, ACD file reference, and controller name similar (intuitive).

5 Module The controller is indicated as available in the PSE.
The controllers in the PSE have been characterized for use within a PlantPAx system.

6 Firmware Verify the firmware revision.
7 Redundancy Denotes if you’re using a redundant controller (Yes/No).
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Verify that the CPU use complies with these recommendations.

Faults

Verify that the fault handling complies with these recommendations.

Memory Use

The PlantPAx system requires the free I/O memory to be a minimum of 25% for simplex 
controllers. We recommend greater than 50% free memory for redundant controllers.

Controller 5x70 Tab: CPU Use

Row Guidelines Description

8 Free At least 50% of free for redundant controllers
At least 25% for simplex controllers.

9 Total Used Total CPU utilization

10 Total Used: Periodic Tasks
The percentage of CPU use to run all application code in the controller.
Periodic tasks are the only predictable task type on performance and utilization. Keep the 
number of tasks to 3 or 4 and do not use to organize code into process areas.

11 Total Used: Communication The percentage of CPU use that is needed to respond to communication requests.
12 Total Used: Motion The percentage of CPU use that is needed to execute motion.
13 Total Used: Messages The percentage of CPU use that is needed to process messages.
14 Total Used: Safety The percentage of CPU use that is needed to execute safety tasks.
15 Total Used: Redundancy The percentage of CPU use that is needed to process redundancy.
16 Total Used: System The percentage of system resources

Controller 5x70 Tab: Faults

Row Guidelines Description

17 Minor Faults Count
Number of minor faults that have occurred within the controller.
After clearing the minor faults, monitor for a period of time (at least several controller scans) 
before reverifying.

18 Task Overlap
Whether a task overlap occurs.
A task overlap must be resolved. Make changes such as simplifying programs, lengthening the 
period, or raising the relative priority of important tasks.

Controller 5x70 Tab: Memory Use

Row Guidelines Description

19 & 20 I/O Memory (bytes)

Reserve:
• At least 50% for redundant controllers
• At least 25% for simplex controllers
If the amount exceeds the recommendations, reduce the number of I/O modules that are 
scanned by this controller, make system changes.

21 & 22 Data and Logic (bytes)

Reserve:
• At least 50% for redundant controllers
• At least 25% for simplex controllers 
If the amount exceeds the recommendations, upgrade controller for more memory or make 
changes to reduce load
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Connections

Verify that the total number of connections is 50% or less of the controller maximum.

Time Synchronization

Verify that the controller is configured for time synchronization.

Task Structure

Verify that the controller program uses only periodic tasks.

Controller 5x70 Tab: Connections

Row Guidelines Description

23-31 Total I/O

Total number of connections includes:
• I/O
• Produced tags
• Consumed tags
• Messages
• Incoming
• Unconnected buffers
• Message cache

Controller 5x70 Tab: Time Synchronization

Row Guidelines Description
32 Controller is time synchronized Denotes if the controller is configured for time synchronization (Yes/No).

Controller 5x70 Tab: Task Structure

Row Guidelines Description

33 Only periodic task used Use only periodic tasks and remove any unused tasks
Use only 2-3 periodic tasks (slow, normal & fast) for logic and remove any unused tasks
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HMI Communication Lost Figure 15 shows a basic workflow to correct lost communication. To target the root cause, 

follow this workflow:

Figure 15 - Resolve Lost Communication

If you can’t open a FactoryTalk® View SE client application on your OWS, go directly to the 
Client/Server Communication Evaluation section on page 292.

Server and Controller Communication Evaluation

Figure 16 shows how to diagnose a loss of communication between the (PASS) server and the 
controller. Make sure that the server has good quality communication with the controller and 
follow down the workflow to rule out any network issues. 

Click the link or go to the respective page for specific information on each topic. If the server 
checks out okay, then you have the option to go to the client computer for additional 
troubleshooting or to call Technical Support.

Communication
Lost

Server/Controller 
Comm Evaluation

See page 287

Call Technical 
Support

See page 292

Separate Procedures with Specific Workflows

Client/Server 
Comm Evaluation

See page 292
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Figure 16 - Resolve Server to Controller Communication 

Live Data Current Quality Good

This procedure examines whether the controller communication is available at the server 
level. If the current quality is ‘good’, then you can rule out that the server isn’t talking to the 
controller.

1. Go to FactoryTalk Tools > FactoryTalk Live Data Test Client and select FactoryTalk and 
Network as the Initial Connection.

The Initial Connection dialog box appears.

Server/Controller 
Comm Evaluation

Live Data
Quality Good? Yes

No

Yes

Yes

No

No

Was Server 
Status OK?

Was Network 
Status OK?

Call Technical Support
See page 292

Application Code Evaluation

See page 292

Worked Before 
Comm Loss?

Client/Server Comm 
See page 292

Yes

No

Servers Evaluation
See page 290

Network Evaluation
See page 290

Live Data Current Quality Good
See page 288
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2. Browse to the data server area and click OK.

3. The Create Group dialog box appears.
4. Use the default or type your own group name and click OK.

5. In the lower, left pane of the Add Item dialog box, browse to the controller, and select 
Online.

6. In the right pane, if no tags appear then proceed to Servers Evaluation on page 290. 
Otherwise, click any tag in the controller and add the item. 

The FactoryTalk® Live Data Test Client dialog box appears.

7. Check that the Current Quality is ‘Good’. 
The ‘Good’ status indicates that you have communication from the server to the 
controller. 
If the status is ‘Bad’, then proceed to Servers Evaluation.
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Servers Evaluation 

If using the FactoryTalk System Status Portal, open a web browser and enter https://
IPAddress/FTSystemStatus (where “IPAddress” is the IP Address of the FactoryTalk Directory 
server). Verify the status of the system servers in this web portal. If not using the System 
Status Portal, follow the procedure below:

This procedure verifies that at least one server has active status. Complete
these steps for the Data server and HMI server.

1. In the FactoryTalk® Administration Console or FactoryTalk View Studio, right-click the 
Data server and choose Server Status.

The Data server status dialog box appears.

2. Make sure that the status is ‘Active’ for at least one of the servers.
3. Repeat for the HMI server.

Was Modification Made?

If you found an issue and made a correction, go back and redo the Live Data procedure. 
Reverify that communication has been established between the server and controller.

Network Evaluation

Now you’re analyzing whether the shortcut to the controller is valid. An incorrect path affects 
the controller communication to the server.

In a redundant system, perform these steps for the Primary and 
Secondary servers.
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1. In the FactoryTalk Administration Console or FactoryTalk View Studio, open the 
Communications Setup.

2. Select the controller shortcut.
If the shortcut does not highlight the correct controller, then select the correct 
controller and save the shortcut. 

3. With the correct shortcut selected, expand the backplane.
If you can browse, then you have communication to the controller. Proceed to Was 
Modification Made? on page 292.
If you can’t browse, then try to ping the controller from the PASS.

4. To ping the controller, do the following:
a. Click Start and type CMD into the Search text box.

A command prompt opens.
b. Type ‘Ping xxx.yyy.zzz.aaa’, where the letters represent the IP address of the 

communication adapter.
5. If the adapter responds, a similar display appears as shown.

6. If your device does not respond, a ‘Request Timed Out’ 
message appears.
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If the ping is successful, proceed to the next diagnostic action.
7. Repeat steps 2…6 if you’re using a redundant Data server.

Was Modification Made?

If you found an issue and made a correction, go back and redo the Live Data procedure. 
Reverify that communication has been established between the server and controller.

Review Application Code Formatting

If the server and controller are communicating and the problem still exists, we recommend 
that you check the project application code. Project components could be incorrectly 
configured.

Verify proper Live Data syntax for the following project elements:
• FactoryTalk View SE or FactoryTalk View ME:

- Display parameter files
- Display values, expressions, and animations
- Global object parameters
- Command buttons and macros
- Data logger
- Event detector
- Derived tags

Contact Technical Support

Call a Rockwell Automation Technical Support representative if the problem still exists after 
checking the following:

• Server communication status
• Controller shortcut
• Application code syntax

Email technical support the most recent data that is compiled from the PlantPAx® checklists.

Client and Server Communication Evaluation

Figure 17 shows a workflow to resolve lost communication between a (PASS) server and a 
client. Work through the diagnostic activities until you identify an issue.

Click the link or go to the respective page for specific information on each topic. If the issue 
still exists, contact Technical Support with the details you have compiled to help with a 
resolution.

IMPORTANT If the size of the information packet can’t be sent via email, a 
technical support representative can help you post your 
information to the Rockwell Automation FTP site.
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Figure 17 - Resolve Server to Client Communication 

Ping Command Evaluation

To check if the client computer is communicating with the server, start by pinging the 
computer.

Complete these steps.
1. Click Start and type CMD into the Search text box.

A command prompt opens.
2. Type ‘Ping (and server name)’.
3. If the controller responds, a display appears similar to the following:

Client/Server
Comms Evaluation

Ping 
Successful?

Was 
Modification 

Made?

Call Technical Support
See page 292

Worked 
Before?

Yes

Yes

No

No

Ping Command Evaluation - See page 293

Name Resolution Evaluation - See page 294

Application Code 
Evaluation

See page 292
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4. If your device does not respond, a ‘Request Timed Out’ 
message appears.

If the ping is successful, check your application code for proper
syntax. See page 292.
Also, make sure that the firewall rules are not blocking the communication.

Name Resolution Evaluation

This procedure verifies the mappings of IP addresses to host names. The steps apply if you’re 
using a domain or a work group, with the latter explained last.

1. At the Command Prompt, type the NSLookup and server name and press Enter.
2. Type the name of the server that is being pinged.

If you receive the message ‘DNS Request Timed Out’, you typically do not have the 
Reverse Lookup Zone configured.
If the NSLookup ping provides the server name and IP address (as shown in the 
example), the server communication issue still exists.

If the NSLookup ping does not provide a server name and IP address, then proceed 
with the following instructions on page 294.

To verify that components do not have duplicate IP addresses, complete
these steps.

1. From a DNS server, click Tools on the main menu and choose DNS.
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The DNS Manager display appears.

2. Verify that each name has its own IP address to make sure that you’re pinging the 
correct server via the client.

The example DNS Manager display shows several ‘bad’ computer names with the 
same IP address.

3. If you’re using a workgroup, open the hosts folder in your Windows local hard disk drive.
4. Using Notepad, open the hosts file.

5. Verify that each name has its own IP address to make sure that you’re pinging the 
correct server via the client.

Was Modification Made?

If you found an issue and made a correction, go back and ping the client computer again.

Review Application Code Formatting

If the server and controller are communicating and the problem still exists, we recommend 
that you check the project application code. See page 292.
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Contact Technical Support

Call a Rockwell Automation technical support representative if the problem still exists. See 
page 292.

Troubleshooting Scenario: 
HMI Display Access is Slow

Figure 18 shows a workflow to resolve sluggish HMI displays. To target the root cause, work 
through the diagnostic activities until you identify an issue.

If the issue still exists, contact Technical Support with the details that you’ve compiled to help 
with a resolution.

Figure 18 - Resolve Slow HMI Display Callup 

Communication 
Performance

Application 
Under Limits?

Controller 
Passed?

Data Server 
Passed?

Network 
Passed?

Call Technical
Support

See page 292

Yes

Yes

Yes

Yes

System Architecture Checklist - See page 264

Controller Checklist - See page 281 or page 284

 See page 279

Network Checklist - See page 257 Application Code 
Evaluation

See page 292
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Action Description

Application Under Limits?
A good starting point is to verify that your system design is within the sizing recommendations for a 
PlantPAx system. Design attributes include the number of servers, number of assets, and so forth.
To verify design attributes, see the System Architecture Tab on page 264.

Controller Passed?
The next step is to check whether your controllers have the CPU and memory usage as prescribed by the 
PlantPAx guidelines. These percentages vary depending on whether your application uses simplex or 
redundant controllers.
For details, see the Controller 5x80 Tab on page 281 or Controller 5x70 Tab on page 284.

Data Server Passed?
If the application design and controller setup are properly configured, check the Data server. Verify that 
the server is communicating data from the controllers to the HMI server and operator workstation. 
For details, see the FactoryTalk Linx worksheet section on page 279.

Network Passed?
The health of the network is critical whether you’re using a virtual or traditional operating system. There’s 
a tool for analyzing network infrastructure.
For details, see the System Infrastructure Tab on page 257.

Review Application Code Formatting For details, see page 292.
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Notes:
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FactoryTalk Optix Considerations
More information on FactoryTalk® Optix™ can be found online at FactoryTalk Optix Help.

raP_5_30_Libraries User 
Guide

The raP_5_30_Libraries is a comprehensive package that is designed to provide users with the 
latest supported PlantPAx® faceplates for use in FactoryTalk Optix. This library ensures that 
developers or engineers have access to the officially supported faceplates and pre-configured 
widgets that enable FactoryTalk Optix project setup and upgrade in an easier way.

By centralizing all available PlantPAx faceplates into a single, ready-to-use library, 
raP_5_30_Libraries simplifies project setup, reduces configuration errors, and aligns with 
Rockwell Automation's latest standards for faceplate deployment in FactoryTalk Optix 
environments.

NetLogic Security Warning in FactoryTalk Optix

When you open a FactoryTalk Optix project and attempt to start RunTime for the first time, the 
system displays a "NetLogic security warning" pop-up. This warning appears because your 
project’s NetLogic C# code references certain .NET assemblies or third-party components 
that may impact your project’s security.

What is shown in the warning?
• A list of referenced .NET assemblies and third-party assemblies that are considered 

security-critical.
• Standard .NET assemblies: System.IO, System.Reflection (generally referenced).

System.IO and System.Reflection are required for basic file operations and reflection 
functionality, such as the NetLogic raSDK1_NL_NavUsingTag.cs provided by PlantPAx 
Process Library for navigation functionality. These standard .NET assemblies are listed 
in the warning for every project that is using PlantPAx Process Library.

• E-Signature related third-party assemblies (if your project contains E-Signature 
NetLogic).

In addition, the warning may mention four other assemblies (NPOI, NPOI.OOXML, 
NPOI,OpenXml4Net, NPOI.OpenXmlFormats). These assemblies are used by Audit_NetLogic 
related to E-Signature functionalities that are provided by PlantPAx Process Library.

(For more information about how to configure E-Signature, See FactoryTalk Optix E-Signature 
User Guide on page 331)

This warning is designed by FactoryTalk Optix to keep you informed about components that 
may affect your application’s security at runtime or when deploying. You may choose to trust 
the above-mentioned assemblies and prevent this warning from appearing again.

https://www.rockwellautomation.com/en-us/docs/factorytalk-optix/current/contents-ditamap.html
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Library Composition and Structure

The raP_5_30_Libraries directory comprises seven distinct folders: StyleSheets, Security, 
UISession, Audit, Translation, Structure, and Libraries.

The 'Libraries' folder contains five subfolders, each of which houses several HMI objects 
associated with various faceplates.
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The following table shows the hierarchy of the Library.
Hierarchy of raP_5_30_Libraries

Folder Subfolders Objects
Structure RockwellAutomationLibraries

Libraries

DeviceControl

raP_5_30_PAO_UI
raP_5_30_PD4SD_UI
raP_5_30_PDO_UI
raP_5_30_PLLS_UI
raP_5_30_PMTR_UI
raP_5_30_PNPOS_UI
raP_5_30_PVLV_UI
raP_5_30_PVLVMP_UI
raP_5_30_PVSD_UI

InputProcessing

raP_5_30_PAH_UI
raP_5_30_PAI_UI
raP_5_30_PAID_UI
raP_5_30_PAIM_UI
raP_5_30_PDI_UI
raP_5_30_raP_Dvc_EH_Flowmeter_UI
raP_5_30_raP_Dvc_EH_Heartbeat_UI
raP_5_30_raP_Dvc_EH_Sensor_UI

RegulatoryControl

raP_5_30_PDBC_UI
raP_5_30_PDOSE_UI
raP_5_30_PFO_UI
raP_5_30_PHLS_UI
raP_5_30_PPID_UI

LogixDiagnostics

raP_5_30_raP_Dvc_LgxChangeDet_UI
raP_5_30_raP_Dvc_LgxCPU_5x80_UI
raP_5_30_raP_Dvc_LgxRedun_UI
raP_5_30_raP_Dvc_LgxModuleSts_UI
raP_5_30_raP_Dvc_LgxTaskMon_UI

OrganizationAndSequencing

raP_5_30_raP_Opr_Area_UI
raP_5_30_raP_Opr_EMGen_UI
raP_5_30_raP_Opr_EPGen_UI
raP_5_30_raP_Opr_Prompt_UI
raP_5_30_raP_Opr_Unit_UI
raP_5_30_raP_Tec_ParRpt _UI

Security
Groups
UserTypes

StyleSheets StyleSheets

Translations
Translation_NetLogic
Translations

UISession
raC_Libraries
raP_ProjectSettings

Audit

Audit
SigningWorkflow HMI objects
SigningEventLogger
AuditLogger

Audit_NetLogic
dg_AuditLogging
dg_ESigLogging
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Configuring Your Project with the Library

Library Location

Once downloaded, place the raP_5_30_Libraries folder in your local FactoryTalk Optix project's 
Libraries directory. This is automated using the included CopytoFTOptixLibrary.cmd.

For example: C:\Users\<User>\Documents\Rockwell Automation\FactoryTalk Optix\Libraries

Create a New Project 1. Open FactoryTalk Optix Studio and create a default project.
2. Delete below default objects in the new project:
• ‘DefaultStyleSheet' in 'UI' folder,
• ‘Groups' and 'Roles' in 'Security' folder,
• ‘Translations' folder.

3. Click the Template Libraries  button from the top menu and open the configuration 
of Libraries window. Check 'Preserve paths on library elements' checkbox.
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Organize the Project Structure
1. Find the raP_5_30_Libraries in the list of the Libraries window.

2. From the 'Translation' library folder, drag the 'Translations' object to the project canvas 
and drag the 'Translation_NetLogic' object to the 'NetLogic' folder in project view.
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Note: To enable multilingual display in FactoryTalk Optix RunTime, you must 
manually add the desired languages under 'Localization->Locales' within the project 
canvas Properties. Otherwise, only English is available.

Process Library faceplates support up to eight languages:

3. From the 'StyleSheets' library folder, drag the 'Stylesheets' object into 'UI' folder in 
project view.
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4. From the 'Security' library folder, drag the 'UserTypes' and 'Groups' objects into 'Security' 
folder in project view.

5. From the 'UISession' library folder, drag the 'raC_Libraries' object into 'UI' folder in 
project view.

6. From the 'UISession' library folder, drag the 'raP_ProjectSettings' object into the 'Model' 
folder in project view and select ‘Import as instance’.
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7. Configure the project.
a. Open NativePresentationEngine and update the properties as follows:

• Virtual keyboard: 'Built-in'
• Style sheet: 'ISAStyleSheet16 (ISA Style Sheet 16)'
• Session: 'raC_Libraries'

b. Select 'raC_Libraries' and modify the 'ref_raP' option link to 'raP_ProjectSettings1'.

8. From the 'Audit' library folder, drag the 'Audit' object to the project canvas in the project 
view.



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 307

Appendix E          FactoryTalk Optix Considerations

9. From the 'Structure' library folder, drag the 'RockwellAutomationLibraries' object to the 
'UI' folder in project view.

10. From the 'Libraries' library folder, drag each faceplate object from the subfolders to the 
corresponding subfolders of 'UI\RockwellAutomationLibraries\ProcessLibrary_v5_30' in 
the new project. If 'Conflicting types detected' pop-up appears, select 'Replace all'.

Note: There is a specified order for dragging the faceplates for the subfolders that 
are listed below:
• In 'InputProcessing' library folder, drag 'raP_5_30_raP_Dvc_EH_Heartbeat_UI' to 

corresponding folder in the project view before 
'raP_5_30_raP_Dvc_EH_Flowmeter_UI' and 'raP_5_30_raP_Dvc_EH_Sensor_UI'. 
(EH_Heartbeat is used by the other EH objects, so it must be brought into the 
project before 'raP_5_30_raP_Dvc_EH_Flowmeter_UI' and 
'raP_5_30_raP_Dvc_EH_Sensor_UI'.)

• In 'OrganizationAndSequencing' library folder, drag 'raP_5_30_raP_Opr_Prompt' 
and 'raP_5_30_raP_Tec_ParRpt' to corresponding folder in the project view first. 
(Prompt and ParRpt are used by the other 'OrganizationAndSequencing' objects, 
so they must be brought in before Area, Unit, EMGen, and EPGen.)
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11. From the 'Audit' library folder, drag the 'Audit_NetLogic' object to 'NetLogic' folder in 
project view. A warning message (the warning is expected) occurs upon completion in 
FactoryTalk Optix Studio Output message box, stating ‘User .NET solution failed to build’.

12. Save and close the project. 
13. Copy the 'ESignature' folder and 'Help' folder from 

'C:\Users\<User>\Documents\Rockwell Automation\FactoryTalk 
Optix\Libraries\raP_5_30_Libraries\ProjectFiles\res' to '<Project 
path>\ProjectsFiles\res' folder.

Configure E-Signature
1. Double-click 'CopyESignatureNetLogicConfigToProject.cmd' in 

'<ProjectPath>\ProjectFiles\res\ESignature' and follow the prompts to complete the 
operation.

2. In '<ProjectPath>\ProjectsFiles\NetSolution', open the <ProjectName>.csproj file and 
modify the project name in the last line to match actual <ProjectName>. Once 
completed, save the changes and close the file.

3. Follow FactoryTalk Optix E-Signature User Guide on page 331 to configure E-Signature 
for each object.



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 309

Appendix E          FactoryTalk Optix Considerations

Configure E-Signature Logging
1. Open the new HMI project in FactoryTalk Optix Studio.
2. Under 'Audit -> SigningWorkflow' folder, create a Database (either an Embedded 

Database or an ODBC Database) for E-Signature logging. For illustration purposes, we 
proceed with creating an Embedded Database named ESigDB.

3. In Properties of SigningEventLogger, make sure that Database is set to ESigDB.

4. Under ‘UI’ folder, create a panel for DataGrid (for example, named ‘ESigSandbox’).
5. Drag the DataGrid dg_ESigLogging from the raP_5_30_Libraries to panel ‘ESigSandbox’. 

Ensure that Model is set to ESigDB. The columns on the grid can be customized based 
on the event fields that are defined in the SigningEventLogger.

Note: For more detailed information about E-Signature configuration, see 
FactoryTalk Optix E-Signature User Guide on page 331.
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Configure FactoryTalk Optix Audit Logging

If you need AuditLogging for your project, add an AuditLogging display to your HMI project. The 
following steps explain how to build the display using the AuditLogging elements in the 
PlantPAx Process Library.

1. Under 'Audit -> AuditLogging' folder in project view, create a Database (either an 
Embedded Database or an ODBC Database). For example, an Embedded Database that is 
named 'AuditLoggingDB' may be used.

2. Navigate to 'Audit -> AuditLogging -> AuditLogger' Properties view, configure:
• Set Database to ‘AuditLoggingDB’

3. Under ‘UI’ folder, create a panel for DataGrid (for example, named 'AuditLogSandbox').
4. From the 'Audit' library folder, drag the 'dg_AuditLogging' object to panel 

'AuditLogSandbox' in project view.
5. Select 'dg_AuditLogging' in project view, and link Model to 'AuditLoggingDB' in its 

Properties.
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FactoryTalk Optix Security Groups

Security groups are configured to ensure that users have the proper access to specific HMI 
functionality. 

Open your NewHMIProject, and expand 'Security' folder, PlantPAx Process Library provides 
default settings in Groups and User Types. 

The following steps explain how to configure Security Groups using the settings provided by 
PlantPAx Process Library.

1. Expand the Security folder and right-click the Users folder and select “New”. Create 
users based on pre-defined UserTypes.

2. Set the password for each user.
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3. (Optional) Users with the necessary assigned permissions, such as engineers and 
administrators, can edit a user's Permissions file to modify the default permission 
settings.
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4. Assign the users to groups.
a. Select Manage users and groups from the Dashboard.
b. Select an item in Groups, and select Assign groups to users or roles. Assign the 

selected group to corresponding users.

c. (Optional) Users with the necessary assigned permissions, such as engineers and 
administrators, can edit a user's Permissions file to modify the default permission 
settings.

In the pre-configured PlantPAx Security group, _Advanced permission includes the 
_Basic permission.
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The object 'AdvancedSecurity' in 'Security\UserTypes' folder determines which permissions 
are Advanced.

Item Description

_Basic
Users in this group are allowed basic HMI functionality for this area. This typically 
includes most Commands Source Control and Manual Operation functions. The 
AdvancedSecurity permission marked as False.

_Advanced
Users in this group are allowed advanced HMI functionality for this area. This typically 
includes maintenance and configuration functionality. The  AdvancedSecurity 
permission marked as True.
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Add Login Options and Graphic Symbols

Before starting RunTime for your project, add login options and graphic symbols to your HMI 
project. The following steps explain how to add these objects using the elements in the 
PlantPAx Process Library.

1. Click the Widgets library from the library list, drag the 'Login Form' object to the 'UI' 
folder in project view.

2. Configure the CommDrivers and import tags. Ensure to set ‘Enable extended properties’ 
to ‘True’ in the Properties of selected Station before importing tags into FactoryTalk 
Optix.

Note: For more information about how to configure CommDrivers in FactoryTalk 
Optix, see the ‘Import controller variables’ section on the FactoryTalk Optix Help 
page.

https://www.rockwellautomation.com/en-us/docs/factorytalk-optix/current/contents-ditamap.html
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3. Create a LoginForm instance on MainWindow and bind Security/Users to Users variable.

4. Create a Graphic Symbol instance on MainWindow and configure its Tag before running 
Emulator.
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Modify an Existing Project Update 'NetLogic' folder

1. Open an existing FactoryTalk Optix project. Click the Template Libraries  button 
from the top menu and open the configuration of Libraries window. Check 'Preserve 
paths on library elements' checkbox.

2. Find the raP_5_30_Libraries in the list of the Libraries window.

3. From the 'Translation' library folder, drag the 'Translation_NetLogic' object to 'NetLogic' 
folder in project view.
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Update Translations

Keep Existing Translations

The 'Translation_NetLogic' enables the export of existing translations from the project and the 
import of backup translations into the project via tab-delimited files.

For users who have existing custom translations in the project and wish to retain them:
1. Create a text file (named 'UserTranslantion.txt' for example). Modify the file name 

extensions to '.csv' (in this case it should be 'UserTranslation.csv').

2. Navigate to ‘NetLogic\Translation_NetLogic\ImportAndExportTranslations_Tab’ in the 
existing project.

3. In the Properties, browse the ‘CSVPath' to the path of 'UserTranslation.csv'. 

4. Right-click on the ‘ImportAndExportTranslations_Tab’ NetLogic and select 'Execute 
ExportTranslations’.

Upon completion, a message appears in Studio Output, stating ‘Translations 
successfully exported to "<your path>\UserTranslations.csv" 
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5. Copy and paste the file 'UserTranslations.csv' as a backup to a desired location.
6. Delete 'Translations' folder in existing project.

7. Drag the 'Translations' object from raP_5_30_Libraries to project canvas.

8. Back to the Properties of ‘ImportAndExportTranslations_Tab’ NetLogic. Select the new 
LocalizationDictionary1 as its LocalizationDictionary.
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9. Browse the ‘CSVPath' of ‘ImportAndExportTranslations_Tab’ to the path of 
'UserTranslations.csv', right-click it and select 'Execute ImportTranslations’.

10. If there are other locales in 'UserTranslations.csv' than LocalizationDictionary1, 'New 
locales added' window pops up. Click 'Yes' to keep them.

No Custom Translations

For users who don't have their own translations, use the following steps to update translations.
1. Delete 'Translations' folder in existing project.

Keys included in the CSV file will replace the corresponding ones in the 
LocalizationDictionary1 after being imported by the NetLogic, and the keys are not 
included in the CSV file will remain same as pre-defined in the 
LocalizationDictionary1. 
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2. From the 'Translation' library folder, drag the 'Translations' object to project canvas in 
existing project.

3. Add Locales in the project to enable localizations display for RunTime.

Process Library faceplates support up to eight languages:
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Update ‘Stylesheets’ Folder
1. Delete ‘StyleSheets’ folder under ‘UI’ folder in the existing project.

2. From the 'StyleSheets' library folder, drag the 'Stylesheets' object into 'UI' folder in 
project view.

Update Security Folder
1. In the existing project, right-click on 'Groups' folder under 'Security' folder, select 

'New->Group' and rename the new group with 'HMI_Performer'.
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UI Session Binding
1. From the 'UISession' library folder, drag the 'raC_Libraries' object into 'UI' folder of the 

existing project.

2. From the 'UISession' library folder, drag the 'raP_ProjectSettings' object into 'Model' 
folder in project view and select ‘Import as instance’. A ‘raP_ProjectSettings1’ object is 
created under ‘Model’ folder.

3. Open NativePresentationEngine and update the properties as follows:
• Style sheet: 'ISAStyleSheet16 (ISA Style Sheet 16)'
• Session: 'raC_Libraries'
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4. Select 'raC_Libraries' and modify the 'ref_raP' option link to 'raP_ProjectSettings1'.

Update Process Library HMI Objects
1. From the 'Structure' library folder, drag the 'RockwellAutomationLibraries' object to 'UI' 

folder in the existing project. If 'Conflicting types detected' window pops up, select 
'Replace all' to proceed.
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The existing items in ‘RockwellAutomationLibraries’ in existing project will be 
updated. And any new objects from the Library will be added in a new created folder 
‘RockwellAutomationLibraries1’.

2. From the 'Libraries' library folder, drag each faceplate object from the subfolders to 
'UI\RockwellAutomationLibraries1\ProcessLibrary_v5_30' in the existing project. If 
'Conflicting types detected' pop-up appears, select 'Replace all'.

IMPORTANT There is a specified order for dragging the faceplates for the 
subfolders.

• In the 'InputProcessing' library folder, drag 'raP_5_30_raP_Dvc_EH_Heartbeat_UI' to the 
corresponding folder in the project view before 'raP_5_30_raP_Dvc_EH_Flowmeter_UI' and 
'raP_5_30_raP_Dvc_EH_Sensor_UI'. (EH_Heartbeat is only used by the other EH objects, so it 
must be brought into the project before 'raP_5_30_raP_Dvc_EH_Flowmeter_UI' and 
'raP_5_30_raP_Dvc_EH_Sensor_UI'.)

• In 'OrganizationAndSequencing' library folder, drag 'raP_5_30_raP_Opr_Prompt' and 
'raP_5_30_raP_Tec_ParRpt' to the corresponding folder in the project view first. (Prompt and 
ParRpt are used by the other 'OrganizationAndSequencing' objects, so they must be brought 
in before Area, Unit, EMGen, and EPGen.)
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Update ‘Audit’ Folder
1. From the 'Audit' library folder, drag the 'Audit' object to project canvas in existing 

project. If 'Conflicting types detected' pop-up appears, select 'Replace all' to proceed.

Items in 'Audit' folder of the existing project is updated, and a new folder 'Audit1' is 
created automatically.

2. Delete ‘Audit1’ folder.

Configure E-Signature
1. Delete the 'Audit_NetLogic' folder under 'NetLogic' folder in the existing project.
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2. From the 'Audit' library folder, drag the 'Audit_NetLogic' object to 'NetLogic' folder in 
project view. 

3. Save and close the project.
4. Copy 'ESignature' folder and 'Help' folder from ‘C:\Users\<User>\Documents\Rockwell 

Automation\FactoryTalk Optix\Libraries\raP_5_30_Libraries\ProjectFiles\res’ to 
‘<Project path>\ProjectsFiles\res’ folder.

5. Select ‘Replace the files in the destination’ to update all files under these two folders.
6. Double-click 'CopyESignatureNetLogicConfigToProject.cmd' in 

‘<ProjectPath>\ProjectsFiles\res\ESignature’ and follow the prompts to complete the 
operation.

7. In ‘<ProjectPath>\ProjectsFiles\NetSolution’, open the <ProjectName>.csproj file and 
modify the project name in the last line to match actual <ProjectName>. Once 
completed, save the changes and close the file.

8. Reopen this project in FactoryTalk Optix.
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9. Configure E-Signature Logging:
a. Drag the Data grid dg_ESigLogging from the raP_5_30_Libraries to panel 

‘ConfirmationLogSandbox’ in the existing project. A ‘dg_ESigLogging1’ object is 
created.

b. Link 'Model' in 'dg_ESigLogging1' Properties to the database of E-Signature 'ESigDB'.

c. Delete 'dg_ESigLogging'.
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Configure AuditLogging

If you need AuditLogging for your project, add an AuditLogging display to your HMI project. The 
following steps explain how to build the display using the AuditLogging elements in the 
PlantPAx Process Library.

1. From the 'Audit' library folder, drag the 'dg_AuditLogging' object to panel 
'AuditLogSandbox' in project view.

2. Select 'dg_AuditLogging' in project view, and link Model to 'AuditLoggingDB' in its 
Properties.

3. Delete 'dg_AuditLogging'.
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4. Delete 'raP_ProjectSettings' in 'Model' folder.
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FactoryTalk Optix E-Signature User Guide
FactoryTalk Optix 
E-Signature

PlantPAx® Process Library offers a suite of components for bulk configuration of FactoryTalk® 
Optix™ E-Signature, allowing users to efficiently manage E-Signature at the tag level.

Features

The E-Signature components provide the following features to users:
• Tag DataType based predefined Template.
• Export FactoryTalk Optix tag list to Excel® configuration file based on Template.
• One-step import Tags’ Confirmation configurations into FactoryTalk Optix.
• One-step import Tags’ AuditSigning Signature properties into FactoryTalk Optix from 

customized configuration file.
• Pop-up dialogs (including Confirm, Sign, DoubleSign) that can be triggered by named 

workflow.
• Data grid for recording E-Signature logs.

Components

The components include E-Signature_Template.xlsx, Audit_NetLogic, SigningWorkflow HMI 
objects and E-Signature Event Logging objects.

E-Signature_Template.xlsx

E-Signagure_Template.xlsx is a predefined configuration file that is provided by the Process 
Library to define tag-level electronic signature workflows, such as ESigWorkflowType, 
SignApproverGroup and Caption. 

See E-Signature Template File on page 339 for detailed introduction of E-Signature Template.
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Audit_NetLogic

Audit_NetLogic enables users to bulk import E-Signature configurations from the E-Signature 
Template into FactoryTalk Optix. 

PlantPAx Process Library provides two versions of NetLogic under DesignTime path: 
‘<ProjectName> > NetLogic > Audit_NetLogic’, which includes a Lite Version and an Advanced 
Version. 

• The Lite Version NetLogics (AuditSigningConfiguration) only supports the importation of 
pre-defined Confirmation configurations. For instructions on how to use it, 
See Confirmation Configuration on page 338.

Note: For the pre-defined TagMembers with Confirmation configurations, See Pre-defined 
TagMembers with Confirmation Workflow on page 354.
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• The Advanced Version NetLogics (GenerateImportFile and ImportConfigFile) supports 
the importation of custom Confirmation, Sign and Double-Sign configurations. Users 
can redefine the ESigWorkflowType of each TagMember in E-Signature Template before 
importing. For instructions on how to use them, See E-Signature Configuration on 
page 338.

Both suites of the NetLogics support configuration for multiple RAEtherNet_IPDrivers 
and RAEtherNet_IPStations.
After being imported by any version of Audit_NetLogic, the E-Signature 
configurations appear under an automatically added "AuditSigning Signature" 
variable in the Properties of the relevant TagMember. The values match those 
defined by the E-Signature Template.
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SigningWorkflow HMI Objects 

SigningWorkflow HMI objects are interface panels that are provided by the Process Library 
that can be displayed during FactoryTalk Optix RunTime when a user operates and changes 
the value of a TagMember with "AuditSigning Signature" properties. Which panel to pop up at 
RunTime depends on the Workflow Type (Confirm, Sign, or DoubleSign) defined in E-Signature 
Template. 

See E-Signature Workflow Pop-up Dialog on page 344 for more information about the 
relationships among E-Signature Template, tag AuditSigning Signature properties, and 
SigningWorkflow HMI objects.

These Objects are located under the DesignTime path: 
<ProjectName> > Audit > SigningWorkflow

• Confirm workflow panel: 

• Sign workflow panel: 

• Double-Sign workflow panel:



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 335

Appendix F          FactoryTalk Optix E-Signature User Guide

• Workflow panel when ValueMappingContent is not empty:

E-Signature Event Logging Objects

E-Signature event logging objects are used to record and monitor audit signing workflows and 
E-Signature events.

PlantPAx Process Library provides predefined FactoryTalk Optix E-Signature event logging 
objects, including an event logger (SigningEventLogger) and a logging DataGrid 
(dg_ESigLogging), stored in DesignTime path '<ProjectName> -> Audit' folder. 

To store these events using the SigningEventLogger, you must manually create a database 
within FactoryTalk Optix. The SigningEventLogger logs key information of its pre-defined 
event fields. During RunTime, you can view the logged information in DataGrid 
(dg_ESigLogging). 

The predefined event fields include Severity, EventType, LocalTime, SourceName, Action, 
WorkflowType, SignResult, ClientUserId, ClientUserNote, SecondClientUserId, 
SecondClientUserNote, SourceNode.

See E-Signature Event Logging Configuration on page 351 for instructions on utilizing the E-
Signature event logging objects.
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Environment Setup Use the following guidelines to configure the project environment before starting the E-
Signature configuration:    

Prerequisites

Follow raP_5_30_Libraries User Guide on page 299 to set up FactoryTalk Optix project and 
ensure the files files that are mentioned in the subsequent sections are prepared in their 
designated location.

Import Tags into FactoryTalk Optix
1. Launch the FactoryTalk Optix project.
2. Configure the 'Enable extended properties' setting to 'True' for the RAEtherNet_IPStation 

that will be utilized within the project.

3. Import tags into the RAEtherNet_IPStation as required.

Copy .csproj and DLL Files to Designated Directory

This step is only required before running the Advanced Version NetLogics in your project.
1. Double-click the Windows® Command Script 

'CopyESignatureNetLogicConfigToProject.cmd' that is in the 
'<ProjectPath>\ProjectFiles\res\ESignature' directory.



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 337

Appendix F          FactoryTalk Optix E-Signature User Guide

2. Follow the prompt to complete the process.

3. Navigate to the ‘<ProjectPath>\ProjectFiles\NetSolution’ folder and open the newly 
copied .csproj file.

4. Modify the project name in the last line of the <ProjectName>.csproj file to match 
actual <ProjectName>. Once completed, save the changes and close the file.
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5. Reopen the FactoryTalk Optix project and check the Studio Output messages to confirm 
that the .Net solution has been built successfully.

E-Signature Configuration PlantPAx Process Library provides two suites of solutions:
• The steps of Confirmation Configuration apply if you only need Confirmation workflow 

type.
• The steps of E-Signature Configuration apply if you would like to customize the

E-Signature workflow type (Confirm, Sign, or DoubleSign).

Confirmation Configuration

The Lite Version Audit_NetLogic (AuditSigingConfiguration) is used here, with a built-in, 
predefined E-Signature Template. For the list of the TagMembers with Confirmation workflow 
predefined by the template, Pre-defined TagMembers with Confirmation Workflow on 
page 354.

1. Navigate to the NetLogic in DesignTime path: ‘<ProjectName> > NetLogic > 
Audit_NetLogic > Audit_NetLogic_Lite > AuditSigningConfiguration’.

2. Right click NetLogic and select ‘Execute CreateAuditSigning' method.

The AuditSigning Configuration is added to all pre-defined tags by NetLogic.

In FactoryTalk Optix Studio Output, the information message shows 'AuditSigning 
configuration imported.' when completed:
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E-Signature Configuration

The Advanced Version of NetLogics are used in this section. You can customize the 
EsigWorkflowType in the E-Signature Template and export the existing tag list from 
FactoryTalk Optix by using GenerateImportFile NetLogic based on the custom E-Signature 
Template. Then import the generated E-Signature Configuration file to FactoryTalk Optix to 
complete the E-Signature configuration.

Export Tag Based on Template

E-Signature Template File

The E-Signature Template file is provided by the PlantPAx library and is in the 
'<ProjectPath>\ProjectFile\res\ESignature' folder. The format is shown in the following 
example:

Modifying the information in the template is not recommended other than the values in the 
column EsigWorkflowType. The following table provides a detailed explanation of each column 
in the template.

Column(1)

(1) Do NOT modify column names in the template.

Format Mandatory Example

DataType(2) Match 'Data Type' in Logix 
Designer Y P_VARIABLE_SPEED_DRIVE

TagMember Match tag 'Name' suffix in 
Logix Designer Y OSet_OutDatalink

EsigWorkflowType
• Confirm
• Sign
• DoubleSign

N
• If empty, the line is 

skipped when imported 
into FactoryTalk Optix.

Default: Sign

Caption Predefined strings
N
• If empty, a default 

caption is shown during 
RunTime.

Default: Request confirm 
operation for changing 
{<TagName>}(3) from 
<OldValue> to <NewValue>

Statement Predefined strings N —

SignApproverGroup(4)

Match the existing group 
names under FactoryTalk 
Optix DesignTime path 
'<ProjectName>>Security
>Groups'.

Y for 'Sign' and 
'DoubleSign' Workflow 
Type

• Default for 'Sign': 
HMI_Performer(5)

• Default for 'DoubleSign': 
HMI_Performer(5)/
HMI_Approver(6)

ValueMappingContent(7) Predefined strings N

(Content differs by TagMember)
MSet_Bypass:

• Value = 1: Enable Bypass
• Value = 0: Disable Bypass

ValueMappingType(7) • MultipleValues
• BitValues

• N
• Y if 

ValueMappingContent 
is not empty.

• MultipleValues
• BitValues
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Export Procedure
1. Select ‘<ProjectName> > NetLogic > Audit_NetLogic > Audit_NetLogic_Advanced > 

GenerateImportFile’.
2. In properties, update parameter 'TemplateFilePath' to E-Signature_Template.xlsx full 

path. 
For example: 
D:\ProcessLibrary\MyNewProject\ProjectFiles\res\ESignature\E-
Signature_Template.xlsx

3. Right click the NetLogic 'GenerateImportFile' and select ‘Execute InitDB' method.

4. The E-Signature Configuration file is exported to path: ‘ProjectFiles\res\ESignature\E-
Signature_<timestamps>.xlsx’ by default.

(2) For Template predefined DataType, See Template Pre-Defined DataType on page 353
(3) To insert a tag value in the caption content, follow the format '{<Tag>}' or '{<ExtendedProperties>}'. For all supported 

Extended Properties, See Extended Properties Dictionary on page 356
(4) Used to identify groups and members within each group that can sign.
(5) The HMI_Performer group must include all authorized users/operators intended to be the first signature for the 'Sign' and 

'DoubleSign' workflow.
(6) The HMI_Approver group must include all authorized users who are intended to be the second signature/counter signatory 

for the 'DoubleSign' workflow.
(7) <ValueMappingContent> and <ValueMppingType> is only displayed during FactoryTalk Optix RunTime when 

<ValueMappingContent> is not empty, See Workflow panel when ValueMappingContent is not empty: on page 335

IMPORTANT Updating Caption, Statement, or ValueMappingContent in the E-
Signature template may cause the existing translation configuration to 
fail. For instructions on updating these strings See How to Customize 
Caption/Statement/ValueMappingContent by Template on page 358
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Import E-Signature Configuration File

E-Signature Configuration File 

The E-Signature Configuration file is the one generated in Export Procedure, including the 
following information:

Summary Tab

\

Detail Tab

Import Procedure
1. From FactoryTalk Optix, select '<ProjectName> > NetLogic > Audit_NetLogic > 

Audit_NetLogic_Advanced > ImportConfigFile'.
2. From properties dialog, input full path of the Configuration file.

IMPORTANT Do not modify any cells except for entries in the 'E-Signature Import' 
column, where only 'Y' or 'N' values are permitted. Only DataType entries 
marked as 'Y' and associated with a valid TagMember in the Detail Tab is 
imported when the ImportConfigFile NetLogic is executed.

IMPORTANT Any cell in the 'EsigWorkflowType' column that is empty is highlighted. 
Rows with an empty 'EsigWorkflowType' cell will not be imported into 
the FactoryTalk Optix project.
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3. Select ‘True’ or ‘False’ for CleanALLESigConfig:

• True: The NetLogic will first clean all existing AuditSigning information in FactoryTalk 
Optix before importing.

• False: The NetLogic will only import and replace the AuditSigning information in 
FactoryTalk Optix for the TagMembers selected in the Import File. Existing AuditSigning 
information where the TagMember is not selected to import in the Import File is not 
cleaned.

4. Right-Click on NetLogic 'ImportConfigFile' and select ‘Execute CreateAuditSigning' 
method.

5. In the FactoryTalk Optix Studio output, the info message shows ‘AuditSigning 
configuration imported.' when completed.

Trouble Shooting 

When any exception occurs while executing NetLogic, there is an output message in the 
FactoryTalk Optix Studio Output to indicate the error with the Category ‘AuditSigning 
Configuration’. For example:

It is recommended that you back up the current FactoryTalk Optix project before 
next step.
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The following table lists common error messages and the corresponding reasons for the error:

NetLogic Output Message Reasons

Export
(GenerateImportFile)

Export failed. No tags found. No tag under CommDrivers in the 
FactoryTalk Optix project.

Could not find file 
"ICSharpCode.SharpZipLib.dll" under 
'<ProjectPath>/ProjectFiles/
NetSolution/bin' folder.

You didn't copy the dll file before 
executing the NetLogic. See Copy 
.csproj and DLL Files to Designated 
Directory on page 336

File in use: <user-input path>. The template file is open.
Template file not found: <user-input 
path>.

Incorrect template file path selected 
for GenerateImportFile NetLogic.

Incorrect template format, only 
support .xlsx and .xls file type.

Incorrect template file type selected 
for GenerateImportFile NetLogic. It 
supports all .xlsx files and .xls from 
Excel version 97.

Incorrect template format.
Template includes incorrect content 
(for example, incorrect column name 
or missing required column).

Import
(ImportConfigFile)

Could not find file 
"ICSharpCode.SharpZipLib.dll" under 
'<ProjectPath>/ProjectFiles/
NetSolution/bin' folder.

You didn't copy the dll file before 
executing the NetLogic. See Copy 
.csproj and DLL Files to Designated 
Directory on page 336

File not found: <user-input path>. Incorrect import file path selected 
for ImportConfigFile NetLogic.

File in use: <user-input path>. The import file is open.

Incorrect import file format, only 
support .xlsx and .xls file type.

Incorrect import file type selected 
for ImportConfigFile NetLogic. It 
supports all .xlsx files and .xls from 
Excel version 97.

Incorrect import file format.
Import file includes incorrect 
content (for example, incorrect 
column name or missing required 
column).

No AuditSigning created.

Missing mandatory information in 
import file (for example, 
StationName, DataType, E-signature 
Import, TagMember, 
EsigWorkflowType).

Import failed. No matching '<user-
input Driver>' DriverName found.

Non-existed cell value under 
DriverName column in Summary 
Sheet of import file. 

Import failed. No matching '<Tag 
path>' found.

Invalid cell value under 
StationName/TagName column in 
Summary Sheet of import file. 

Import failed. No matching 
<ColumnName> found 'xxx'.

Invalid value 'xxx' under 
<ColumnName> column in Detail 
Sheet of Import file.

<ColumnName> import failed. No 
matching tags found '<Tag>'.

Invalid '<Tag>' included in the cell 
value of <ColumnName> column on 
Detail Sheet of Import file.
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E-Signature Workflow Pop-
up Dialog

After importing the E-Signature Configurations into FactoryTalk Optix, the parameters will 
appear under the “AuditSigning Signature” variable of the configured TagMember. When you 
start RunTime and interact with the corresponding TagMember, an E-Signature Workflow 
dialog with the configured content automatically pops up.

The mapping between the content in the E-Signature Template and what appears in 
FactoryTalk Optix DesignTime and the RunTime pop-up dialogs are as follows.

Confirm Workflow
1. DataType mapping

2. TagMember mapping

3. EsigWorkflowType
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4. Caption:
• DesignTime

• RunTime

Sign Workflow
1. DataType mapping
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2. TagMember mapping

3. EsigWorkflowType

4. Caption
• DesignTime
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• RunTime (a default caption shows when it’s empty in DesignTime)

5. Statement:
• DesignTime

• RunTime
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6. SignApproverGroup

7. ValueMappingType

8. ValueMappingContent:
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• DesignTime

• RunTime (ValueMappingContent panel is only shown when ValueMappingContent is not 
empty)

See Extended Properties Dictionary on page 356 for the format of Extended Properties.
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Double-Sign Workflow
1. DataType Mapping - See Sign Workflow.
2. TagMember Mapping - See Sign Workflow.
3. ESigWorkflowType 

4. Caption:
• DesignTime - See Sign Workflow.
• RunTime (a default caption shows when it’s empty in DesignTime)

5. Statement - See Sign Workflow.
6. SignApproverGroup - See Sign Workflow.
7. ValueMappingType - See Sign Workflow.
8. ValueMappingContent - See Sign Workflow.
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Exception Messages

When incorrect signing information is input in the Sign or Double-Sign workflow dialog and the 
‘Confirm’ button is clicked, another pop-up dialog appears indicating an error and the 
corresponding reason for the error, for example: 

The following table lists common messages and corresponding reasons may occur:

E-Signature Event Logging 
Configuration

Complete the following steps to configure the E-Signature Logs to be viewed in RunTime using 
a FactoryTalk Optix DataGrid.

1. Under ‘Audit > SigningWorkflow’ folder, create a Database (either an Embedded 
Database or an ODBC Database) for E-Signature logging. For example, an Embedded 
Database that is named ‘ESigDB’ may be used.

2. In the Properties of the SigningEventLogger component, set the Database to the 
database name created in the previous step ('ESigDB' in the example).

3. Under the 'UI' folder, create a panel for DataGrid. (named 'ESigSandbox' in the following 
example)

Error Message Reason
First (Second) user is not authorized The first (second) user is not in the approver list.
Sign in failed for first (second) user Password for first (second) user is incorrect.
Second user must be different from first user The first and second users selected are the same user.
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4. Drag the DataGrid dg_ESigLogging from the raP_5_30_Libraries to panel ‘ESigSandbox’. 
Ensure that Model is set to ESigDB. The columns on the grid can be customized based 
on the event fields that are defined in the SigningEventLogger.

5.  After running the project, monitor the E-Signature event logs on the DataGrid.

For more information about how to configure Event logger in FactoryTalk Optix, see the Event 
logger section in the FactoryTalk Optix Help manual, which is installed with FactoryTalk Optix. 
The help manual is located in the folder: 

C:/ProgramFiles/RockwellAutomation/FactoryTalkOptix/Studio1.6.0.626/Help/en/
Index.html
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Additional Information Template Pre-Defined DataType
NO. DataType
1 P_ANALOG_HART
2 P_ANALOG_INPUT
3 P_ANALOG_INPUT_DUAL
4 P_ANALOG_INPUT_MULTI
5 P_ANALOG_OUTPUT
6 P_DISCRETE_4STATE
7 P_DEADBAND
8 P_DISCRETE_INPUT
9 P_DISCRETE_OUTPUT
10 P_DOSING
11 P_INTERLOCK
12 P_LEAD_LAG_STANDBY
13 P_LEAD_LAG_STANDBY_MOTOR
14 P_MOTOR_DISCRETE
15 P_DISCRETE_N_POSITION
16 P_PERMISSIVE
17 P_PID
18 P_RUN_TIME
19 P_VALVE_DISCRETE
20 P_DISCRETE_MIX_PROOF
21 P_VALVE_STATISTICS
22 P_VARIABLE_SPEED_DRIVE
23 raP_Dvc_EH_Flowmeter
24 raP_Dvc_EH_Heartbeat
25 raP_Dvc_LgxChangeDet
26 raP_Dvc_LgxCPU_5x80
27 raP_Dvc_LgxModuleSts
28 raP_Dvc_LgxRedun
29 raP_Dvc_LgxTaskMon
30 raP_Opr_Area
31 raP_Opr_EMGen
32 raP_Opr_EPGen
33 raP_Opr_ExtddAlm
34 raP_Opr_Prompt
35 raP_Opr_Prompt_Core
36 raP_Opr_Unit
37 raP_Tec_ParRpt
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Pre-defined TagMembers with Confirmation Workflow
DataType TagMember Caption
P_ANALOG_HART MCmd_Virtual Place the device in virtual operation
P_ANALOG_INPUT MCmd_Virtual Place the device in virtual operation
P_ANALOG_INPUT MCmd_SubstPV Replace the PV with a substitute value for the device
P_ANALOG_INPUT @Alarms/Alm_**/OperShelve Shelve alarm
P_ANALOG_INPUT_DUAL @Alarms/Alm_**/OperShelve Shelve alarm
P_ANALOG_INPUT_MULTI @Alarms/Alm_**/OperShelve Shelve alarm
P_ANALOG_OUTPUT MCmd_Virtual Place the device in virtual operation
P_ANALOG_OUTPUT MCmd_OoS Take the device Out of Service
P_ANALOG_OUTPUT MCmd_Bypass Bypass interlocks for the device
P_ANALOG_OUTPUT @Alarms/Alm_**/OperShelve Shelve alarm
P_DISCRETE_4STATE MCmd_Virtual Place the device in virtual operation
P_DISCRETE_4STATE MCmd_OoS Take the device Out of Service
P_DISCRETE_4STATE MCmd_Bypass Bypass interlocks and permissives for the device
P_DISCRETE_4STATE @Alarms/Alm_**/OperShelve Shelve alarm
P_DEADBAND MCmd_OoS Take the device Out of Service
P_DEADBAND @Alarms/Alm_**/OperShelve Shelve alarm
P_DISCRETE_INPUT MCmd_Virtual Place the device in virtual operation
P_DISCRETE_INPUT MCmd_SubstPV Replace the PV with a substitute value for the device
P_DISCRETE_INPUT @Alarms/Alm_**/OperShelve Shelve alarm
P_DISCRETE_OUTPUT MCmd_Virtual Place the device in virtual operation
P_DISCRETE_OUTPUT MCmd_OoS Take the device Out of Service
P_DISCRETE_OUTPUT MCmd_Bypass Bypass interlocks and permissives for the device
P_DISCRETE_OUTPUT @Alarms/Alm_**/OperShelve Shelve alarm
P_DOSING MCmd_Virtual Place the device in virtual operation
P_DOSING MCmd_OoS Take the device Out of Service
P_DOSING @Alarms/Alm_**/OperShelve Shelve alarm
P_LEAD_LAG_STANDBY MCmd_OoS Take the device Out of Service
P_LEAD_LAG_STANDBY MCmd_Bypass Bypass interlocks and permissives for the device
P_LEAD_LAG_STANDBY @Alarms/Alm_**/OperShelve Shelve alarm
P_MOTOR_DISCRETE MCmd_Virtual Place the device in virtual operation
P_MOTOR_DISCRETE MCmd_OoS Take the device Out of Service
P_MOTOR_DISCRETE MCmd_Bypass Bypass interlocks and permissives for the device
P_MOTOR_DISCRETE @Alarms/Alm_**/OperShelve Shelve alarm
P_DISCRETE_N_POSITION MCmd_Virtual Place the device in virtual operation
P_DISCRETE_N_POSITION MCmd_OoS Take the device Out of Service
P_DISCRETE_N_POSITION MCmd_Bypass Bypass interlocks and permissives for the device
P_DISCRETE_N_POSITION @Alarms/Alm_**/OperShelve Shelve alarm
P_PID MCmd_OoS Take the device Out of Service
P_PID MCmd_Bypass Bypass interlocks for the device
P_PID @Alarms/Alm_**/OperShelve Shelve alarm
P_VALVE_DISCRETE MCmd_Virtual Place the device in virtual operation
P_VALVE_DISCRETE MCmd_OoS Take the device Out of Service
P_VALVE_DISCRETE MCmd_Bypass Bypass interlocks and permissives for the device
P_VALVE_DISCRETE @Alarms/Alm_**/OperShelve Shelve alarm
P_DISCRETE_MIX_PROOF MCmd_Virtual Place the device in virtual operation
P_DISCRETE_MIX_PROOF MCmd_OoS Take the device Out of Service
P_DISCRETE_MIX_PROOF MCmd_Bypass Bypass interlocks for the device
P_DISCRETE_MIX_PROOF @Alarms/Alm_**/OperShelve Shelve alarm
P_VARIABLE_SPEED_DRIVE MCmd_Virtual Place the device in virtual operation
P_VARIABLE_SPEED_DRIVE MCmd_OoS Take the device Out of Service
P_VARIABLE_SPEED_DRIVE MCmd_Bypass Bypass interlocks and permissives for the device
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P_VARIABLE_SPEED_DRIVE @Alarms/Alm_**/OperShelve Shelve alarm
raP_Dvc_LgxChangeDet @Alarms/Alm_**/OperShelve Shelve alarm

raP_Dvc_LgxCPU_5x80 MCmd_Enable
Enabling data collection affects communication and 
processor performance. Be sure to disable data 
collection when you are finished monitoring the 
controller.

raP_Dvc_LgxModuleSts MCmd_Virtual Place the device in virtual operation
raP_Dvc_LgxModuleSts MCmd_Bypass Bypass connection checking for the device
raP_Dvc_LgxModuleSts @Alarms/Alm_**/OperShelve Shelve alarm
raP_Dvc_LgxRedun MCmd_Switchover Initiate switchover for controller
raP_Dvc_LgxRedun @Alarms/Alm_**/OperShelve Shelve alarm
raP_Dvc_LgxTaskMon @Alarms/Alm_**/OperShelve Shelve alarm
raP_Opr_Area MCmd_Virtual Place the device in virtual operation
raP_Opr_Area MCmd_OoS Take the device Out of Service
raP_Opr_Area @Alarms/Alm_**/OperShelve Shelve alarm
raP_Opr_EMGen MCmd_StateForce Force State
raP_Opr_EMGen MCmd_OoS Take the device Out of Service
raP_Opr_EMGen MCmd_Bypass Bypass interlocks and permissives for the device
raP_Opr_EMGen @Alarms/Alm_**/OperShelve Shelve alarm
raP_Opr_EPGen OCmd_Abort Abort Phase
raP_Opr_EPGen MCmd_StateForce Force State
raP_Opr_EPGen MCmd_OoS Take the device Out of Service
raP_Opr_EPGen MCmd_Bypass Bypass interlocks and permissives for the device
raP_Opr_EPGen @Alarms/Alm_**/OperShelve Shelve alarm
raP_Opr_ExtddAlm @Alarms/Alm_**/OperShelve Shelve alarm
raP_Opr_Prompt @Alarms/Alm_**/OperShelve Shelve alarm
raP_Opr_Unit MCmd_Virtual Place the device in virtual operation
raP_Opr_Unit MCmd_OoS Take the device Out of Service
raP_Opr_Unit MCmd_Bypass Bypass interlocks and permissives for the device
raP_Opr_Unit @Alarms/Alm_**/OperShelve Shelve alarm

DataType TagMember Caption
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Extended Properties Dictionary

The extended properties that are used in the E-Signature Template are from Logix Designer. 
The format is different with the ones in FactoryTalk Optix dynamic link browser path. 

The following table is a mapping of commonly used extended properties:

Extended Properties FactoryTalk Optix dynamic link browser path
@Description /Description
@Label /Label
@Area /Area
@Navigation /Navigation
@State0 /FalseState
@State1 /TrueState
@EngineeringUnit /EngineeringUnits/DisplayName
@Max /EURange/High
@Min /EURange/Low
@Library /Library
@Instruction /Instruction
@URL /URL
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Tag Format for Alarms

There are 13 default Alarms TagMembers for each DataType in the template. The TagMembers 
all have same format.

'@Alarms/Alm_**/<ChildTag>'. 

During importing into FactoryTalk Optix, the '**' will be instantiated to all the actual Alarms 
TagMembers per each DataType. 

The following is an example how the TagMember be instantiated:

The format '@Alarms/Alm_**/<ChildTag>' can only import all the Alarm TagMembers for the 
DataType at one time. If user would like to choose parts of the tags to import, then the '**' 
must be instantiated manually in the template before importing. See the following example:
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How to Customize Caption/Statement/ValueMappingContent by 
Template

To display custom contents correctly during RunTime, you must use the following steps when 
customizing Caption, Statement, or ValueMapping in the E-Signature template:

1. Update a predefined Caption/Statement/ValueMappingContent in the template (for 
example, a caption of P_DEADBAND), then save and close the file.

2. Follow steps in E-Signature Configuration to export and import the E-Signature 
configuration of P_DEADBAND.

3. In Project View, double-click ‘LocalizationDictionary1’ under the ‘Translation’ folder and 
select ‘View Translation References’. Then search for the updated Caption (‘Test to 
change the Caption’).

4. Select the ‘Synchronized’ checkbox for the key.



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 359

Appendix F          FactoryTalk Optix E-Signature User Guide

Observation of changed tag:

5. You can add translations manually in the Translation Table to enable Multilanguage:
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6. Start RunTime. When an operation is made to the tag, the E-Signature pop-up appears. 
And now the custom caption and translations can be displayed correctly.
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Security Policies
System Policies

Product Policies

System Policies Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator

Common — — — — — — —
Configure Security Deny Deny Deny Deny Deny Allow Allow
Create Children Deny Deny Deny Deny Deny Allow Allow
Delete Deny Deny Deny Deny Deny Allow Allow
Execute Deny Deny Deny Deny Deny Allow Allow
List Children Deny Deny Deny Deny Deny Allow Allow
Read Deny Deny Deny Deny Deny Allow Allow
Write Deny Deny Deny Deny Deny Allow Allow
User Rights Assignment — — — — — — —
.User Rights Assignment Properties — — — — — — —
..Backup and Restore — — — — — — —
Backup and restore directory contents Deny Deny Deny Deny Deny Allow Allow
..Directory Server Computer — — — — — — —
Change Directory Server Deny Deny Deny Deny Deny Allow Allow
..Manage Servers — — — — — — —
Manual server switchover Deny Deny Deny Deny Deny Allow Allow
..Security Authority Identifier — — — — — — —
Modify Security Authority Identifier Deny Deny Deny Deny Deny Allow Allow

Product Policies Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator

RSLogix 5000® — — — — — — —
Feature Security — — — — — — —
Project: New Deny Deny Allow Allow Allow Allow Allow
Print: Modify Options Deny Deny Allow Allow Allow Allow Allow
Controller: Secure Deny Deny Allow Allow Allow Allow Allow
Toolbar: Configure Deny Deny Allow Allow Allow Allow Allow
Firmware: Update Deny Deny Allow Allow Allow Allow Allow
Workstation: Modify Options Deny Deny Allow Allow Allow Allow Allow
Studio 5000 Architect® — — — — — — —
Feature Security — — — — — — —
Create Deny Deny Allow Allow Allow Allow Allow
Open Deny Deny Allow Allow Allow Allow Allow
Save Deny Deny Allow Allow Allow Allow Allow
Batch — — — — — — —
. Batch Campaign — — — — — — —
. . Commands — — — — — — —
Abort Batch Allow Allow Allow Allow Allow Allow Allow
Abort Campaign Allow Allow Allow Allow Allow Allow Allow
Add New Batch Allow Allow Allow Allow Allow Allow Allow
Add New Campaign Allow Allow Allow Allow Allow Allow Allow
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All Properties Allow Allow Allow Allow Allow Allow Allow
Append Batch to Campaign Allow Allow Allow Allow Allow Allow Allow
ConfigServers Allow Allow Allow Allow Allow Allow Allow
Delete Batch Allow Allow Allow Allow Allow Allow Allow
Delete Campaign Allow Allow Allow Allow Allow Allow Allow
Disable Triggers Allow Allow Allow Allow Allow Allow Allow
Enable Triggers Allow Allow Allow Allow Allow Allow Allow
Hold Batch Allow Allow Allow Allow Allow Allow Allow
Hold Campaign Allow Allow Allow Allow Allow Allow Allow
Move Batch Allow Allow Allow Allow Allow Allow Allow
Move Campaign Allow Allow Allow Allow Allow Allow Allow
Pause Batch Allow Allow Allow Allow Allow Allow Allow
Pause Campaign Allow Allow Allow Allow Allow Allow Allow
Restart Batch Allow Allow Allow Allow Allow Allow Allow
Restart Campaign Allow Allow Allow Allow Allow Allow Allow
Start Batch Allow Allow Allow Allow Allow Allow Allow
Start Campaign Allow Allow Allow Allow Allow Allow Allow
Stop Batch Allow Allow Allow Allow Allow Allow Allow
Stop Campaign Allow Allow Allow Allow Allow Allow Allow
. BatchView and ActiveX — — — — — — —
. . View — — — — — — —
Alarm Summary Allow Allow Allow Allow Allow Allow Allow
Arbitration Allow Allow Allow Allow Allow Allow Allow
Batch List Allow Allow Allow Allow Allow Allow Allow
Configuration Allow Allow Allow Allow Allow Allow Allow
Event Journals Allow Allow Allow Allow Allow Allow Allow
Exit Allow Allow Allow Allow Allow Allow Allow
Help Allow Allow Allow Allow Allow Allow Allow
Phase Control Allow Allow Allow Allow Allow Allow Allow
Phase Summary Allow Allow Allow Allow Allow Allow Allow
Procedure as SFC Allow Allow Allow Allow Allow Allow Allow
Procedure as Table Allow Allow Allow Allow Allow Allow Allow
Prompts Allow Allow Allow Allow Allow Allow Allow
Signatures Allow Allow Allow Allow Allow Allow Allow
. . Phase Commands — — — — — — —
Abort Allow Allow Allow Allow Allow Allow Allow
Ack Allow Allow Allow Allow Allow Allow Allow
Acquire Allow Allow Allow Allow Allow Allow Allow
Clear Fail Allow Allow Allow Allow Allow Allow Allow
Disconnect Allow Allow Allow Allow Allow Allow Allow
Hold Allow Allow Allow Allow Allow Allow Allow
Pause Allow Allow Allow Allow Allow Allow Allow
Phase Auto Mode Allow Allow Allow Allow Allow Allow Allow
Phase Semi-Auto Mode Allow Allow Allow Allow Allow Allow Allow
Release Allow Allow Allow Allow Allow Allow Allow
Reset Allow Allow Allow Allow Allow Allow Allow
Restart Allow Allow Allow Allow Allow Allow Allow
Resume Allow Allow Allow Allow Allow Allow Allow
Start Allow Allow Allow Allow Allow Allow Allow
Stop Allow Allow Allow Allow Allow Allow Allow
. . Commands — — — — — — —
Abort Allow Allow Allow Allow Allow Allow Allow

Product Policies Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator
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Ack Allow Allow Allow Allow Allow Allow Allow
Acquire Allow Allow Allow Allow Allow Allow Allow
Add Batch Allow Allow Allow Allow Allow Allow Allow
Auto Allow Allow Allow Allow Allow Allow Allow
Bind Allow Allow Allow Allow Allow Allow Allow
Bind Ack Allow Allow Allow Allow Allow Allow Allow
Clear Fail Allow Allow Allow Allow Allow Allow Allow
Comment Allow Allow Allow Allow Allow Allow Allow
Disconnect Allow Allow Allow Allow Allow Allow Allow
Force Transition Allow Allow Allow Allow Allow Allow Allow
Hold Allow Allow Allow Allow Allow Allow Allow
Manual Allow Allow Allow Allow Allow Allow Allow
MatSvrControl Allow Allow Allow Allow Allow Allow Allow
Override Allow Allow Allow Allow Allow Allow Allow
Override Clear Allow Allow Allow Allow Allow Allow Allow
ParamChange Allow Allow Allow Allow Allow Allow Allow
ReactivateStep Allow Allow Allow Allow Allow Allow Allow
Release Allow Allow Allow Allow Allow Allow Allow
Remove Allow Allow Allow Allow Allow Allow Allow
Reorder Allow Allow Allow Allow Allow Allow Allow
Restart Allow Allow Allow Allow Allow Allow Allow
Resume Allow Allow Allow Allow Allow Allow Allow
Semi-Auto Allow Allow Allow Allow Allow Allow Allow
Start Allow Allow Allow Allow Allow Allow Allow
Step Allow Allow Allow Allow Allow Allow Allow
Stop Allow Allow Allow Allow Allow Allow Allow
Timer-Compete Allow Allow Allow Allow Allow Allow Allow
Timer-Reset Allow Allow Allow Allow Allow Allow Allow
. Equipment Editor — — — — — — —
. . Feature Security — — — — — — —
Configure Runtime Area Model 
Deployment Allow Allow Allow Allow Allow Allow Allow

. Recipe Editor — — — — — — —

. . Access Modes — — — — — — —
Full Edit Allow Allow Allow Allow Allow Allow Allow
View Only Allow Allow Allow Allow Allow Allow Allow
Asset Centre — — — — — — —
Address Book Policies — — — — — — —
View Address Book Deny Deny Allow Allow Allow Allow Allow
Edit Address Book Deny Deny Allow Allow Allow Allow Allow
Archive Policies — — — — — — —
Override Archive Check In Deny Deny Allow Allow Allow Allow Allow
Configure Database Limitations Deny Deny Allow Allow Allow Allow Allow
Configure Asset Inventory Settings Deny Deny Allow Allow Allow Allow Allow
Configure Archive Options Settings Deny Deny Allow Allow Allow Allow Allow
Override Archive Undo Check Out Deny Deny Allow Allow Allow Allow Allow
Override Removal Local Copies Deny Deny Allow Allow Allow Allow Allow
Configure Personal Archive File 
Associations Deny Deny Allow Allow Allow Allow Allow

Configure System Archive File 
Associations Deny Deny Allow Allow Allow Allow Allow

Configure Personal Archive Working 
Folders Deny Deny Allow Allow Allow Allow Allow

Product Policies Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator
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Configure System Archive Working 
Folders Deny Deny Allow Allow Allow Allow Allow

Run Archive Database Cleanup Wizard Deny Deny Allow Allow Allow Allow Allow
Allow Empty Comment at Check In Deny Deny Allow Allow Allow Allow Allow
Clear the Get Writable Copy check box 
by default Deny Deny Allow Allow Allow Allow Allow

Store Latest Version Only Deny Deny Allow Allow Allow Allow Allow
Set Maximum Versions Deny Deny Allow Allow Allow Allow Allow
Assetts Lifecycle Policies — — — — — — —
Configure Assets Lifecycle Sync Deny Deny Allow Allow Allow Allow Allow
Calibration Management Policies — — — — — — —
Display Calibration Management Data Deny Deny Allow Allow Allow Allow Allow
Perform Calibration Management Deny Deny Allow Allow Allow Allow Allow
Administer Calibration Users Deny Deny Allow Allow Allow Allow Allow
Database Maintenance Policies — — — — — — —
Configure Database Maintenance 
Polices Deny Deny Allow Allow Allow Allow Allow

General Policies — — — — — — —
Switch to Design mode Deny Deny Allow Allow Allow Allow Allow
Log Policies — — — — — — —
View Event Log Deny Deny Allow Allow Allow Allow Allow
View Audit Log Deny Deny Allow Allow Allow Allow Allow
View Diagnostics and Health Log Deny Deny Allow Allow Allow Allow Allow
Change Diagnostics and Health Log 
Message Deny Deny Allow Allow Allow Allow Allow

View Diagnostics and Health Log Status Deny Deny Allow Allow Allow Allow Allow
Run Log Database Cleanup Wizard Deny Deny Allow Allow Allow Allow Allow
Process Device Configuration Policies — — — — — — —
Enable or Disable DTMs Deny Deny Allow Allow Allow Allow Allow
Edit DTM Network — — — — — — —
Run PDC Field Edition Deny Deny Allow Allow Allow Allow Allow
Schedule Policies — — — — — — —
Create a new schedule Deny Deny Allow Allow Allow Allow Allow
Edit a schedule Deny Deny Allow Allow Allow Allow Allow
Delete a schedule Deny Deny Allow Allow Allow Allow Allow
View a schedule Deny Deny Allow Allow Allow Allow Allow
Command a schedule Deny Deny Allow Allow Allow Allow Allow
Searching — — — — — — —
Create a Search Deny Deny Allow Allow Allow Allow Allow
ControlFLASH™ — — — — — — —
Feature Security — — — — — — —
Firmware: Update Deny Deny Allow Allow Allow Allow Allow
Firmware: Delete Deny Deny Allow Allow Allow Allow Allow
PCDC: Connect Deny Deny Allow Allow Allow Allow Allow
FactoryTalk View SE — — — — — — —
Feature Security — — — — — — —
Configure FTView SE Website Deny Deny Deny Deny Deny Allow Allow
RSLinx Classic — — — — — — —
Feature Security — — — — — — —
Clear DDE/OPC Event Log Deny Deny Deny Deny Deny Allow Allow
Configure CIP™ Options Deny Deny Deny Deny Deny Allow Allow
Configure Client Applications Deny Deny Deny Deny Deny Allow Allow
Configure ControlLogix® Gateway Deny Deny Deny Deny Deny Allow Allow

Product Policies Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator
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Computers and Groups

Network and Devices

Configure DDE/OPC Topic Deny Deny Deny Deny Deny Allow Allow
Configure Drivers and Shortcuts Deny Deny Deny Deny Deny Allow Allow
Configure Gateway Deny Deny Deny Deny Deny Allow Allow
Configure Network Properties Deny Deny Deny Deny Deny Allow Allow
Edit DDE/OPC Project Deny Deny Deny Deny Deny Allow Allow
Edit Options Deny Deny Deny Deny Deny Allow Allow
Reset Station Diagnostic Counters Deny Deny Deny Deny Deny Allow Allow
Shutdown Deny Deny Deny Deny Deny Allow Allow
View NT Event Log Deny Deny Deny Deny Deny Allow Allow
Access Data Monitor Deny Deny Deny Deny Deny Allow Allow
RSNetWorx™ — — — — — — —
Feature Security — — — — — — —
Access Configurations Deny Deny Allow Allow Allow Allow Allow
Modify Configurations Deny Deny Allow Allow Allow Allow Allow
Go Online Deny Deny Allow Allow Allow Allow Allow

Product Policies Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator

Computers and Groups Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator

Common — — — — — — —
Configure Security Deny Deny Deny Deny Deny Allow Allow
Create Children Deny Deny Deny Deny Deny Allow Allow
Delete Deny Deny Deny Deny Deny Allow Allow
Execute Deny Deny Deny Deny Deny Allow Allow
List Children Deny Deny Deny Deny Deny Allow Allow
Read Deny Deny Deny Deny Deny Allow Allow
Write Deny Deny Deny Deny Deny Allow Allow
FactoryTalk Linx — — — — — — —
Network Browse Deny Deny Allow Allow Allow Allow Allow
FactoryTalk Transaction Manager — — — — — — —
Start, Stop, and Assemble Configurations Deny Deny Allow Allow Allow Allow Allow

Network and Devices Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator

Common — — — — — — —
Configure Security Deny Deny Deny Deny Deny Allow Allow
Create Children Deny Deny Deny Deny Deny Allow Allow
Delete Deny Deny Deny Deny Deny Allow Allow
Execute Deny Deny Deny Deny Deny Allow Allow
List Children Deny Deny Deny Deny Deny Allow Allow
Read Deny Deny Deny Deny Deny Allow Allow
Write Deny Deny Deny Deny Deny Allow Allow
RSLogix5000 — — — — — — —
Add-On Instruction: Create Deny Deny Allow Allow Allow Allow Allow
Add-On Instruction: Delete Deny Deny Allow Allow Allow Allow Allow
Add-On Instruction: Export Deny Deny Allow Allow Allow Allow Allow
Add-On Instruction: Export Unencoded Deny Deny Allow Allow Allow Allow Allow
Add-On Instruction: Modify Deny Deny Allow Allow Allow Allow Allow
Add-On Instruction: View Logic Deny Deny Allow Allow Allow Allow Allow
Alarm Definition: Create Deny Deny Allow Allow Allow Allow Allow
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Alarm Definition: Delete Deny Deny Allow Allow Allow Allow Allow
Alarm Definition: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Alarm Definition: Modify Required Use Deny Deny Allow Allow Allow Allow Allow
Alarm: Clear Alarm Log Deny Deny Allow Allow Allow Allow Allow
Alarm: Configure Direct Commands Deny Deny Allow Allow Allow Allow Allow
Alarm: Create Deny Deny Allow Allow Allow Allow Allow
Alarm: Delete Deny Deny Allow Allow Allow Allow Allow
Alarm: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Alarm: Modify Use Deny Deny Allow Allow Allow Allow Allow
Component: Modify Permission Set Deny Deny Allow Allow Allow Allow Allow
Controller: Clear Fault Deny Deny Allow Allow Allow Allow Allow
Controller: Lock/Unlock Deny Deny Allow Allow Allow Allow Allow
Controller: Modify Mode Deny Deny Allow Allow Allow Allow Allow
Controller: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Controller: Modify Revision Deny Deny Allow Allow Allow Allow Allow
Controller: Modify Type Deny Deny Allow Allow Allow Allow Allow
Controller: Unsecure Deny Deny Allow Allow Allow Allow Allow
Data Log: Clear Log Data Value Deny Deny Allow Allow Allow Allow Allow
Data Log: Create Deny Deny Allow Allow Allow Allow Allow
Data Log: Delete Deny Deny Allow Allow Allow Allow Allow
Data Log: Enable/Disable Deny Deny Allow Allow Allow Allow Allow
Data Log: Modify Deny Deny Allow Allow Allow Allow Allow
Data Log: Read Log Data Value Deny Deny Allow Allow Allow Allow Allow
Firmware: Update Deny Deny Allow Allow Allow Allow Allow
Language: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Language: Switch Language Deny Deny Allow Allow Allow Allow Allow
Module: Create Deny Deny Allow Allow Allow Allow Allow
Module: Delete Deny Deny Allow Allow Allow Allow Allow
Module: Maintenance High Deny Deny Allow Allow Allow Allow Allow
Module: Maintenance Low Deny Deny Allow Allow Allow Allow Allow
Module: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Module: View Properties Deny Deny Allow Allow Allow Allow Allow
Motion: Command Axis Deny Deny Allow Allow Allow Allow Allow
Motion: Modify Configuration Deny Deny Allow Allow Allow Allow Allow
Nonvolatile Memory: Load Deny Deny Allow Allow Allow Allow Allow
Nonvolatile Memory: Store Deny Deny Allow Allow Allow Allow Allow
Phase: Create Deny Deny Allow Allow Allow Allow Allow
Phase: Delete Deny Deny Allow Allow Allow Allow Allow
Phase: Manual Control Deny Deny Allow Allow Allow Allow Allow
Phase: Modify Properties Deny Deny Allow Allow Allow Allow Allow
PLC/SLC: Modify Tag Mappings Deny Deny Allow Allow Allow Allow Allow
Plug-In: Display Deny Deny Allow Allow Allow Allow Allow
Print: Report Deny Deny Allow Allow Allow Allow Allow
Program: Create Deny Deny Allow Allow Allow Allow Allow
Program: Delete Deny Deny Allow Allow Allow Allow Allow
Program: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Project: Compact Deny Deny Allow Allow Allow Allow Allow
Project: Download Deny Deny Allow Allow Allow Allow Allow
Project: Export Deny Deny Allow Allow Allow Allow Allow
Project: Go Online Deny Deny Allow Allow Allow Allow Allow
Project: Modify Path Deny Deny Allow Allow Allow Allow Allow
Project: Open Deny Deny Allow Allow Allow Allow Allow

Network and Devices Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator
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Project: Save Deny Deny Allow Allow Allow Allow Allow
Project: Save As Deny Deny Allow Allow Allow Allow Allow
Project: Upload Deny Deny Allow Allow Allow Allow Allow
Routine: Create Deny Deny Allow Allow Allow Allow Allow
Routine: Delete Deny Deny Allow Allow Allow Allow Allow
Routine: Export Deny Deny Allow Allow Allow Allow Allow
Routine: Manual Control Deny Deny Allow Allow Allow Allow Allow
Routine: Modify Logic Deny Deny Allow Allow Allow Allow Allow
Routine: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Routine: View Logic Deny Deny Allow Allow Allow Allow Allow
Safety: Generate/Delete Signature Deny Deny Allow Allow Allow Allow Allow
Safety: Lock/Unlock Deny Deny Allow Allow Allow Allow Allow
Safety: Modify Component Deny Deny Allow Allow Allow Allow Allow
Safety: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Safety: Modify Tag Mappings Deny Deny Allow Allow Allow Allow Allow
Sequence: Create Deny Deny Allow Allow Allow Allow Allow
Sequence: Delete Deny Deny Allow Allow Allow Allow Allow
Sequence: Manual Control Deny Deny Allow Allow Allow Allow Allow
Sequence: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Tag: Create Deny Deny Allow Allow Allow Allow Allow
Tag: Delete Deny Deny Allow Allow Allow Allow Allow
Tag: Force Deny Deny Allow Allow Allow Allow Allow
Tag: Modify Constant Property Deny Deny Allow Allow Allow Allow Allow
Tag: Modify Constant Tag Value Deny Deny Allow Allow Allow Allow Allow
Tag: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Tag: Modify Values Deny Deny Allow Allow Allow Allow Allow
Task: Create Deny Deny Allow Allow Allow Allow Allow
Task: Delete Deny Deny Allow Allow Allow Allow Allow
Task: Modify Properties Deny Deny Allow Allow Allow Allow Allow
Trend: Create Deny Deny Allow Allow Allow Allow Allow
Trend: Delete Deny Deny Allow Allow Allow Allow Allow
Trend:Modify Properties Deny Deny Allow Allow Allow Allow Allow
Trend: Run Deny Deny Allow Allow Allow Allow Allow
User Defined Type: Create Deny Deny Allow Allow Allow Allow Allow
User Defined Type: Delete Deny Deny Allow Allow Allow Allow Allow
User Defined Type: Modify Deny Deny Allow Allow Allow Allow Allow
Sequence Manager — — — — — — —
Event Server: Archiving Service 
Commands Deny Deny Allow Allow Allow Allow Allow

Event Server: Client Service Commands Deny Deny Allow Allow Allow Allow Allow
Event Server: Configure Archiving Service 
Settings Deny Deny Allow Allow Allow Allow Allow

Event Server: Configure Client Service 
Settings Deny Deny Allow Allow Allow Allow Allow

Parameter: Change Parameter Deny Allow Allow Allow Allow Allow Allow
Parameter: Enable or Disable Expression Deny Allow Allow Allow Allow Allow Allow
Parameter: Force Paramater Evaluation Deny Allow Allow Allow Allow Allow Allow
Sequence: Abort Allow Allow Allow Allow Allow Allow Allow
Sequence: Change Active Steps Allow Allow Allow Allow Allow Allow Allow
Sequence: Change Mode Allow Allow Allow Allow Allow Allow Allow
Sequence: Change Ownership Allow Allow Allow Allow Allow Allow Allow
Sequence: Clear Failures Allow Allow Allow Allow Allow Allow Allow
Sequence: Hold Allow Allow Allow Allow Allow Allow Allow

Network and Devices Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator
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Users and Groups

Connections

Sequence: Initialize Parameters Allow Allow Allow Allow Allow Allow Allow
Sequence: Pause and Resume Allow Allow Allow Allow Allow Allow Allow
Sequence: Reset Allow Allow Allow Allow Allow Allow Allow
Sequence: Restart Allow Allow Allow Allow Allow Allow Allow
Sequence: Set ID Allow Allow Allow Allow Allow Allow Allow
Sequence: Start Allow Allow Allow Allow Allow Allow Allow
Sequence: Stop Allow Allow Allow Allow Allow Allow Allow
Step: Abort Allow Allow Allow Allow Allow Allow Allow
Step: Clear Failures Allow Allow Allow Allow Allow Allow Allow
Step: Hold Allow Allow Allow Allow Allow Allow Allow
Step: Pause and Resume Allow Allow Allow Allow Allow Allow Allow
Step: Reset Allow Allow Allow Allow Allow Allow Allow
Step: Restart Allow Allow Allow Allow Allow Allow Allow
Step: Start Allow Allow Allow Allow Allow Allow Allow
Step: Stop Allow Allow Allow Allow Allow Allow Allow
Transition: Force Expression to Evaluate 
True Allow Allow Allow Allow Allow Allow Allow

Network and Devices Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator

Users and Groups Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator

Common — — — — — — —
Configure Security Deny Deny Deny Deny Deny Allow Allow
Create Children Deny Deny Deny Deny Deny Allow Allow
Delete Deny Deny Deny Deny Deny Allow Allow
Execute Deny Deny Deny Deny Deny Allow Allow
List Children Deny Deny Deny Deny Deny Allow Allow
Read Deny Deny Deny Deny Deny Allow Allow
Write Deny Deny Deny Deny Deny Allow Allow

Connections Operators Operator 
Supervisor Maintenance Maintenance 

Supervisor Manager Engineer Administrator

Common — — — — — — —
Configure Security Deny Deny Deny Deny Deny Allow Allow
Create Children Deny Deny Deny Deny Deny Allow Allow
Delete Deny Deny Deny Deny Deny Allow Allow
Execute Deny Deny Deny Deny Deny Allow Allow
List Children Deny Deny Deny Deny Deny Allow Allow
Read Deny Deny Deny Deny Deny Allow Allow
Write Deny Deny Deny Deny Deny Allow Allow



Rockwell Automation Publication PROCES-UM100I-EN-P - December 2025 369

PlantPAx Distributed Control System Configuration and Implementation User Manual



Publication PROCES-UM100I-EN-P - December 2025
PROCES-UM100H-EN-P - November 2025 Copyright © 2025 Rockwell Automation, Inc. All rights reserved. Printed in the U.S.A.

Rockwell Automation Support
Use these resources to access support information.

Documentation Feedback
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the 
form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

Rockwell Automation maintains current product environmental compliance information on its website at rok.auto/pec.

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, Knowledgebase, and product 
notification updates. rok.auto/support

Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport

Technical Documentation Center Quickly access and download technical specifications, installation instructions, and user 
manuals. rok.auto/techdocs

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature
Product Compatibility and Download Center 
(PCDC)

Download firmware, associated files (such as AOP, EDS, and DTM), and access product 
release notes. rok.auto/pcdc

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

Rockwell Otomasyon Ticaret A.Ş. Kar Plaza İş Merkezi E Blok Kat:6 34752, İçerenköy, İstanbul, Tel: +90 (216) 5698400 EEE Yönetmeliğine Uygundur

Allen-Bradley, expanding human possibility, AADvance, ArmorStart, CompactLogix, ControlLogix, FactoryTalk, FactoryTalk eProcedure, FLEX 5000, FLEXHA 5000, GuardLogix, Integrated 
Architecture, iTRAK, Kinetix, Logix 5000, MagneMotion, Optix, Pavilion8, PhaseManager, PlantPAx, PowerFlex, PowerMonitor, Rockwell Automation, Rockwell Software, RSBizWare, RSLinx, RSMACC, 
SequenceManager, SMC, Stratix, Studio 5000, Studio 5000 Logix Designer, TechConnect, ThinManager,and Trusted are trademarks of Rockwell Automation, Inc.
Cisco, Cisco IOS, and Catalyst are trademarks of Cisco Systems, Inc.
CIP, CIP Security, CIP Sync, ControlNet, DeviceNet, and EtherNet/IP are trademarks of the ODVA.
Microsoft, Excel, and Windows are trademarks of the Microsoft Corporation.
Trademarks not belonging to Rockwell Automation are property of their respective companies.

https://rok.auto/support
https://rok.auto/phonesupport
https://rok.auto/techdocs
https://rok.auto/literature
https://rok.auto/pcdc
https://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
https://rok.auto/docfeedback
https://rok.auto/pec
https://www.instagram.com/rokautomation/
https://www.linkedin.com/company/rockwell-automation
https://twitter.com/ROKAutomation
https://www.facebook.com/ROKAutomation/
https://www.rockwellautomation.com/

	PlantPAx Distributed Control System Configuration and Implementation
	1 - System Workflow
	Size Your System
	Select the Process Automation System Server
	Consolidated Process Automation System Server (PASS-C)
	Process Automation System Server (PASS)

	Next Steps
	Guidelines for Servers and Workstations
	Endpoint Protection

	PlantPAx System ID
	System Verification

	2 - Domain or Workgroup
	Prerequisites
	Primary Domain Controller
	Create the Primary Domain Controller
	Install Active Directory Services, DHCP, and DNS Roles
	Promote the Primary Domain Controller

	Additional Domain Controller
	Create an Additional Domain Controller
	Install Active Directory Services, DHCP, and DNS Roles
	Promote the Additional Domain Controller

	Configure Domain Controllers
	Server Manager Tools Menu
	Create a Reverse DNS Lookup Zone
	Map the Host Name to the IP Address
	Add DHCP Features
	Configure Failover

	Create Roles, Areas, and Users
	Add Groups for Role-Based Security
	Add Groups for Area Based Security
	Assign Users

	Configure Group Policy Management
	Configure the Windows NTP Client
	Configure Windows Time Service
	Enforcing the Domain Controller Policy

	Configure Group Policies
	Configure the Password Strength Policy
	Configure the Account Lockout Policy
	Configure the Kerberos Policy
	Configure the Interactive Logon Policy

	PlantPAx Users Policy Object
	Create the PlantPAx Users Policy Object
	Configure the USB Drive Policy
	Configure the Portable Device Enumeration Policy
	Configure the Software Access Policy

	Windows Workgroup
	Assign Static IP Addresses
	Map Computer IP Addresses
	Test Communication by Host Name
	Create Local Users
	Create Local Security Policies
	FactoryTalk DeskLock Utility (Optional)


	3 - Process Automation System Server
	Prerequisites
	FactoryTalk Components
	System SQL Server Deployment
	Configure the PASS
	Specify FactoryTalk Directory Location
	Configure the FactoryTalk Directory
	Run Firewall Configuration Utility
	Configure FactoryTalk Activation Servers

	Configure Servers on the PASS
	Create a New HMI Project
	Define Areas
	Add an HMI Server
	Add a FactoryTalk ViewPoint Server
	Add the Alarms and Events Database
	Add a Data Server (FactoryTalk Linx)
	Add a Data Server (OPC UA)
	Add an Alarm and Events Server
	Add a Resource and Status Server
	Configure DataLogPro

	Redundant Server Considerations
	Configure Runtime Security
	Role-Based Security
	Area-Based Security
	Adding Users to Groups
	Line of Sight Based Security

	Remote Desktop Services
	Use Default Terminal Client
	Audit Security Actions


	4 - Network Infrastructure
	Network Configuration Preparation
	Recommended VLANs
	Command-line Interface (CLI)

	Redundant PRP Topology
	Additional Resources for PRP Topology

	Switch Configuration in a Redundant PRP Topology
	Resilient DLR Topology
	Additional Resources for DLR Topology

	Switch Configuration in a Resilient DLR Topology
	Simplex - Star Topology
	Additional Resources for Simplex Star Topology

	Switch Configuration in a Simplex Topology
	Perimeter Network Considerations
	Time Synchronization
	Considerations

	Configure UTC Time Source
	Configure Internet Time Synchronization
	NTP to PTP Clock Conversion

	Configure PTP Time Synchronization for Ethernet Bridges
	Configure PTP Time Synchronization for Controllers

	Network Device Library

	5 - Process Controller Features
	Prerequisites
	PlantPAx Process Objects
	Import Add-On Instructions

	Configure Controller Properties
	PlantPAx Task Model
	Create the Logical Organizer
	Add Modules and Devices to the Controller Organizer

	Controller-to-Controller Communication
	Configure Produced and Consumed Tags
	PlantPAx Guidelines for Produced and Consumed Tags

	PlantPAx Guidelines for Message Instructions
	OPC UA
	Integrate Field Devices
	HART Integration
	PROFIBUS PA Integration
	FOUNDATION Fieldbus Integration
	Electrical Protection Devices Integration (IEC 61850)

	Alarm Types
	Guidelines for Logix Tag-based Alarms
	Embedded Tag-based Alarms in PlantPAx Instructions
	Guidelines for Server Tag-based Alarms (FactoryTalk Alarms and Events)
	Guidelines for Logix Instruction-based Alarms
	Monitor Alarms
	Use the Process System Estimator to Plan Alarms

	Security Considerations
	Create HMI Displays
	Graphic Framework Displays
	Optimize Runtime Performance
	Optimize HMI Redundancy


	6 - Use ACM to Create an Application
	Prerequisites
	Develop a Project Plan
	Determine Which Libraries to Use

	Develop an Example Application
	Create the Example Project
	Create a New Project
	Add System References
	Add a Controller
	Configure the Controller Object
	Add Devices
	Add Hardware Bus Object
	Add Control Strategies

	Add Alarm Groups
	Generate Controller and Graphics Files
	Download ACD File to the Controller
	Add Graphics to HMI
	Bulk Configuration


	7 - Modifying an Existing PlantPAx System
	Prerequisites
	Studio 5000 Logix Designer and FactoryTalk View SE Software
	Logix Designer Application Templates
	FactoryTalk View SE templates

	Edit a Project via the PlantPAx Configuration Tool for Tags, Alarms, and Historian
	Edit Tag Data
	Edit Alarms
	Launch AE Alarm Configuration Tools

	Edit Historian Points
	Edit HMI Displays

	8 - Asset Management
	Prerequisites
	FactoryTalk AssetCentre
	Inventory Plant Assets
	Scan the System for Assets

	Manually Add Individual Assets
	Configure Audit Logs
	Security Audit Logs

	Schedule System Backups
	Create a Backup Schedule
	Configure Disaster Recovery

	Maintenance Strategy Recommendations
	Controller Project File
	FactoryTalk Directory
	PASS Servers
	Network Switches

	Server Back up and System Restore
	Historian Configuration and Data
	Batch Configuration and Data
	FactoryTalk AssetCentre Data
	SQL Server Data
	Backup Verification
	System Restore

	Retention Policy Considerations
	System Storage Rates


	9 - Historical Data
	Prerequisites
	Required PlantPAx Elements

	Historical Data
	Configure Servers for a Collective
	Create Firewall Rule for Historian Servers
	Set Initial Security Settings
	Create Connections Between Historian Servers

	Create the Historian Collective
	Client to Server Connections
	Connect another Computer to Historian Server

	Historian to FactoryTalk Directory Connection
	Create a Data Collection Interface
	Create a Synchronization Path for Redundant Node Interfaces

	Configure Redundant Node Interfaces
	Configure a FactoryTalk Live Data Primary Interface
	Configure a FactoryTalk Live Data Secondary Interface
	Confirm Unit Failover Diagnostics

	Configure PI Performance Monitor
	Create Domain User for PIPerfMon Service
	Configure the PIPerfMon Interface
	Create PIPerfMon Diagnostic Health Points
	Test the PIPerfMon Interface
	Enable the PIPerfMon Interface on other Computers

	Configure PI Buffering
	Create Domain User for PI Buffer Service
	Create Security Mappings
	Configure the Buffering Interface
	Configure the PI Buffer Service Logon

	Configure Historian Data Collection
	Create Digital States
	Import Digital Sets and States
	Create Individual Historian Points
	Monitor Historical Data
	Define Digital Historical Points

	Historian Asset Framework
	Configure the Connections to the Servers
	Import Asset Framework Templates
	Configure Asset Framework Elements
	Search Event Frames
	Finding Faults for Analysis

	Tools for Creating Historian Tags
	Application Code Manager
	PI Builder Add-in for Microsoft Excel
	Configure Asset Framework Databases with the PlantPAx Configuration Tool
	Verify Asset Framework Library and Elements


	10 - Batch Management
	Select the Batch Solution
	Logix Batch and SequenceManager Requirements
	SequenceManager Requirements
	FactoryTalk Batch Requirements

	Logix Batch and Sequence Manager
	LBSM Details

	SequenceManager Controls
	SequenceManager Details

	Factory Talk Batch Application
	FactoryTalk Batch Details

	FactoryTalk Batch Server with Redundant Controllers
	Hold Propagation
	State Composite Evaluation
	Types of Failures


	11 - Automatic Diagnostics
	Configure Automatic Diagnostics
	Automatic Diagnostics on FactoryTalk View SE
	Subscribe To
	View Automatic Diagnostic Messages
	Automatic Diagnostics History
	Online Updates of Device Additional Diagnostics


	A - PlantPAx Security Certification
	PlantPAx Security Architecture
	Trusted Zones
	Certificate Authority

	System Security Feature Checklists
	Virtualization
	VLAN Recommendations
	Remote Access
	CIP Security

	B - Firewall Configurations
	Common Ports
	Rockwell Automation TCP/ UDP Ports

	C - PlantPAx Deployment Recommendations and Verification Tool
	Design Recommendations Tab
	System ID
	Controller Considerations
	Library Considerations
	Alarm Considerations
	I/O Considerations
	HMI Considerations
	User Security Considerations

	System Infrastructure Tab
	Network
	Servers and Workstations

	Server or Workstation Tab
	Operating System
	Performance
	Basic System Checks
	Resource Overview

	System Architecture Tab
	FactoryTalk View Application Design
	FactoryTalk View HMI Servers
	FactoryTalk Alarm and Event Servers
	FactoryTalk View Data Servers
	FactoryTalk AssetCentre Configuration
	FactoryTalk Historian SE Configuration

	PASS Tab
	FactoryTalk View SE System
	FactoryTalk Alarms and Events Server
	Generate the FactoryTalk View Report
	FactoryTalk Linx Data Server
	FactoryTalk Linx OPC UA Connector

	Controller 5x80 Tab
	Controller Properties
	CPU Use
	Faults
	Capacity
	Connections
	Time Synchronization
	Task Structure
	Controller Alarms

	Controller 5x70 Tab
	Controller Properties
	CPU Use
	Faults
	Memory Use
	Connections
	Time Synchronization
	Task Structure


	D - PlantPAx Troubleshooting Scenarios
	HMI Communication Lost
	Server and Controller Communication Evaluation
	Client and Server Communication Evaluation

	Troubleshooting Scenario: HMI Display Access is Slow

	E - FactoryTalk Optix Considerations
	raP_5_30_Libraries User Guide
	NetLogic Security Warning in FactoryTalk Optix
	Library Composition and Structure
	Configuring Your Project with the Library

	Create a New Project
	Organize the Project Structure
	Configure E-Signature
	Configure E-Signature Logging
	Configure FactoryTalk Optix Audit Logging
	FactoryTalk Optix Security Groups
	Add Login Options and Graphic Symbols

	Modify an Existing Project
	Update 'NetLogic' folder
	Update Translations
	No Custom Translations
	Update ‘Stylesheets’ Folder
	Update Security Folder
	UI Session Binding
	Update Process Library HMI Objects
	Update ‘Audit’ Folder
	Configure E-Signature
	Configure AuditLogging


	F - FactoryTalk Optix E-Signature User Guide
	FactoryTalk Optix E-Signature
	Features
	Components

	Environment Setup
	Prerequisites
	Import Tags into FactoryTalk Optix
	Copy .csproj and DLL Files to Designated Directory

	E-Signature Configuration
	Confirmation Configuration
	E-Signature Configuration
	Import E-Signature Configuration File
	Trouble Shooting

	E-Signature Workflow Pop- up Dialog
	Confirm Workflow
	Sign Workflow
	Double-Sign Workflow
	Exception Messages

	E-Signature Event Logging Configuration
	Additional Information
	Template Pre-Defined DataType
	Pre-defined TagMembers with Confirmation Workflow
	Extended Properties Dictionary
	Tag Format for Alarms
	How to Customize Caption/Statement/ValueMappingContent by Template


	G - Security Policies
	System Policies
	Product Policies
	Computers and Groups
	Network and Devices
	Users and Groups
	Connections


	Back Cover

